
 

 

 

 

 

 

 

 

 

 

 

 

 

Version 3.0  

 

 

 

User Guide  

 

 



 CAE Fidesys — User Guide (version 3.0) 

1 

 

Сontents  

Introduction ........................................................................................................................................................... 8 

About the software ...........................................................................................................................................8 

Getting Started ......................................................................................................................................................9 

System requirements ....................................................................................................................................... 9 

Hardware requirements ................................................................................................................................ 9 

Operating system .......................................................................................................................................... 9 

Installation ...................................................................................................................................................... 10 

Microsoft Windows ...................................................................................................................................... 10 

Linux ............................................................................................................................................................ 11 

Activation and trial period ............................................................................................................................... 12 

Trial period ................................................................................................................................................... 12 

Activation ..................................................................................................................................................... 13 

Information on the purchased license ............................................................................................................. 13 

Uninstalling the software ................................................................................................................................ 13 

The program overview. ........................................................................................................................................ 14 

Package structure ........................................................................................................................................... 14 

Running the software ...................................................................................................................................... 14 

Main Window .................................................................................................................................................. 14 

Software history ................................................................................................................................................... 16 

Version 3.0 ................................................................................................................................................... 16 

Version 2.2 ................................................................................................................................................... 16 

Version 2.1 ................................................................................................................................................... 17 

Version 2.0 ................................................................................................................................................... 17 

Version 1.7.1 ................................................................................................................................................. 17 

Version 1.7.0 ................................................................................................................................................. 18 

Version 1.6 R2 .............................................................................................................................................. 19 

Version 1.6 ................................................................................................................................................... 19 

Version 1.5 R2 .............................................................................................................................................. 20 

Version 1.5 ................................................................................................................................................... 21 

Version 1.4 ................................................................................................................................................... 21 

Version 1.3 .................................................................................................................................................... 21 

Version 1.2 ................................................................................................................................................... 21 

Version 1.1 .................................................................................................................................................... 22 

Geometry ........................................................................................................................................................ 23 

Geometry import ......................................................................................................................................... 23 

Geometry creating ....................................................................................................................................... 24 



 CAE Fidesys — User Guide (version 3.0) 

2 

 

Meshing .......................................................................................................................................................... 24 

Volume meshing .......................................................................................................................................... 25 

Surface mesh generation ............................................................................................................................. 25 

Parallel Meshing.........................................................................................................................................26 

Sculpt ...........................................................................................................................................................26 

Sculpt Adaptive Meshing .............................................................................................................................29 

Sculpt Boundary Layers................................................................................................................................29 

Sculpt Mesh Improvement ........................................................................................................................... 31 

Element types .............................................................................................................................................. 39 

Set the Material ........................................................................................................................................... 39 

Setting tabular dependencies for materials .................................................................................................. 41 

Import/Export Material................................................................................................................................. 41 

Setting the yielding model .............................................................................................................................. 42 

Von Mises yield criterion .............................................................................................................................. 43 

Drucker-Prager yield criterion ......................................................................................................................44 

Polylinear hardening ....................................................................................................................................46 

Element types .............................................................................................................................................. 47 

Blocks operations ......................................................................................................................................... 47 

Setting shell properties ................................................................................................................................... 50 

Setting beam properties ................................................................................................................................. 51 

 Specifying Sphere element properties ........................................................................................................... 52 

Set spring properties ....................................................................................................................................... 52 

 Types of boundary conditions ..................................................................................................................... 53 

Setting initial conditions ................................................................................................................................. 53 

Types of initial conditions ............................................................................................................................. 54 

Time/coordinate dependency ...................................................................................................................... 54 

Setting contact interaction ............................................................................................................................. 57 

Contact region ............................................................................................................................................. 57 

Autoselection of contact .............................................................................................................................. 58 

Contact algorithm ........................................................................................................................................60 

Elements Type .............................................................................................................................................60 

Contact status .............................................................................................................................................. 61 

Starting calculation .........................................................................................................................................62 

Analysis types ..............................................................................................................................................62 

Types of analysis ............................................................................................................................................. 63 

Multistep solution ........................................................................................................................................... 63 

Setting steps for boundary conditions .......................................................................................................... 63 

Setting steps for blocks (volumes) ................................................................................................................ 65 



 CAE Fidesys — User Guide (version 3.0) 

3 

 

Spectral element method ............................................................................................................................... 67 

SEM brief description and advantages ......................................................................................................... 67 

SEM Usage .................................................................................................................................................. 69 

Parallel calculations on several computers using MPI technology ................................................................... 70 

MPI brief description and advantages .......................................................................................................... 70 

MPI implementation  in CAE Fidesys ............................................................................................................ 70 

MPI installation ............................................................................................................................................ 70 

MPI local usage ............................................................................................................................................ 70 

MPI usage on several nodes ......................................................................................................................... 71 

Requirements for the correct operation ....................................................................................................... 71 

MPI setting on several nodes ........................................................................................................................ 71 

Registration before the first usage ............................................................................................................... 72 

Overview of the calculation results ............................................................................................................... 73 

Calculation example using MPI ..................................................................................................................... 73 

Heterogeneous materials effective property calculation ................................................................................. 73 

Geometry of the model for effective property calculation ............................................................................ 74 

Starting calculation ...................................................................................................................................... 75 

Element types .............................................................................................................................................. 75 

Effective property calculation and its results ................................................................................................ 75 

SEG-Y format .................................................................................................................................................. 81 

The spectral method for solving linear dynamic problems using the response spectrum (response spectrum, 
reaction spectrum) ..........................................................................................................................................84 

Modal Analysis .............................................................................................................................................84 

Response Spectrum Setting .........................................................................................................................84 

Results Visualization and Postprocessing ........................................................................................................86 

About Fidesys Viewer software ....................................................................................................................86 

Main Window ...............................................................................................................................................86 

Basics of the program ..................................................................................................................................86 

Overview of the strained model.................................................................................................................. 87 

Step-by-Step User Guide ..................................................................................................................................... 93 

Static analysis (3D) .......................................................................................................................................... 93 

Geometry creation .......................................................................................................................................94 

Meshing ...................................................................................................................................................... 96 

Setting boundary conditions ....................................................................................................................... 99 

Setting material and element type ............................................................................................................. 102 

Starting calculation .................................................................................................................................... 104 

Results analysis .......................................................................................................................................... 104 

Using Console Interface ............................................................................................................................. 106 



 CAE Fidesys — User Guide (version 3.0) 

4 

 

Static load (gravity force) .............................................................................................................................. 108 

Geometry creation ..................................................................................................................................... 109 

Meshing ..................................................................................................................................................... 111 

Setting boundary conditions ...................................................................................................................... 112 

Setting material and element type ............................................................................................................. 113 

Starting calculation .................................................................................................................................... 115 

Results analysis .......................................................................................................................................... 115 

Using Console Interface ............................................................................................................................. 117 

Static load (beam model, reaction forces) ..................................................................................................... 117 

Geometry creation ..................................................................................................................................... 118 

Meshing ..................................................................................................................................................... 119 

Setting boundary conditions ...................................................................................................................... 120 

Setting material and element type ............................................................................................................. 121 

Setting beam cross section profile ............................................................................................................. 124 

Starting calculation .................................................................................................................................... 124 

Results analysis .......................................................................................................................................... 125 

Using Console Interface ............................................................................................................................. 126 

Static load (shell) .......................................................................................................................................... 128 

Geometry creation ..................................................................................................................................... 128 

Meshing ..................................................................................................................................................... 129 

Setting boundary conditions ...................................................................................................................... 130 

Setting material and element type ............................................................................................................. 131 

Starting calculation .................................................................................................................................... 134 

Results analysis .......................................................................................................................................... 135 

Using Console Interface ............................................................................................................................. 138 

Hydrostatic pressure on cylinder (setting boundary conditions according to coordinates) ............................ 139 

Geometry creation ..................................................................................................................................... 139 

Meshing ..................................................................................................................................................... 144 

Setting material and element type ............................................................................................................. 145 

Setting boundary conditions ...................................................................................................................... 148 

Starting calculation .................................................................................................................................... 150 

Results analysis .......................................................................................................................................... 151 

Using Console Interface ............................................................................................................................. 153 

Buckling (shell model) ................................................................................................................................... 154 

Geometry creation ..................................................................................................................................... 154 

Meshing ..................................................................................................................................................... 157 

Setting boundary conditions ...................................................................................................................... 158 

Setting material and element type ............................................................................................................. 159 



 CAE Fidesys — User Guide (version 3.0) 

5 

 

Setting shell thickness ................................................................................................................................ 162 

Starting calculation .................................................................................................................................... 162 

Results analysis .......................................................................................................................................... 163 

Using Console Interface ............................................................................................................................. 168 

Modal analysis (3D) ....................................................................................................................................... 169 

Geometry creation ..................................................................................................................................... 169 

Meshing ..................................................................................................................................................... 170 

Setting boundary conditions ...................................................................................................................... 171 

Setting material and element type ............................................................................................................. 172 

Starting calculation .................................................................................................................................... 174 

Results analysis .......................................................................................................................................... 175 

Using Console Interface ............................................................................................................................. 177 

Modal analysis (shell model) ......................................................................................................................... 178 

Geometry creation ..................................................................................................................................... 178 

Meshing ..................................................................................................................................................... 179 

Setting boundary conditions ...................................................................................................................... 180 

Setting material and element type ............................................................................................................. 181 

Setting shell thickness ................................................................................................................................ 183 

Starting calculation .................................................................................................................................... 184 

Results analysis .......................................................................................................................................... 184 

Using Console Interface ............................................................................................................................. 186 

Setting heat transfer (3D, working with two blocks)...................................................................................... 187 

Geometry creation ..................................................................................................................................... 187 

Meshing ..................................................................................................................................................... 190 

Setting material and element type ............................................................................................................. 191 

Setting boundary conditions ...................................................................................................................... 194 

Starting calculation .................................................................................................................................... 196 

Results analysis .......................................................................................................................................... 196 

Using Console Interface ............................................................................................................................. 198 

Dynamic load: nonsteady heat transfer (3D, implicit scheme) ....................................................................... 199 

Geometry creation ..................................................................................................................................... 199 

Meshing ..................................................................................................................................................... 200 

Setting material and element type ............................................................................................................. 201 

Setting boundary conditions ...................................................................................................................... 202 

Setting time dependency of boundary conditions ...................................................................................... 203 

Starting calculation .................................................................................................................................... 204 

Results analysis .......................................................................................................................................... 204 

Using Console Interface ............................................................................................................................. 209 



 CAE Fidesys — User Guide (version 3.0) 

6 

 

Harmonic analysis (beam model) .................................................................................................................. 210 

 Geometry creating .................................................................................................................................... 210 

 Meshing .................................................................................................................................................... 213 

Specifying the material and type of element .............................................................................................. 213 

Beam section setting .................................................................................................................................. 215 

Setting boundary conditions ...................................................................................................................... 215 

Run calculation ........................................................................................................................................... 218 

Results analysis .......................................................................................................................................... 219 

Using the console interface ........................................................................................................................ 222 

Bounded Contact Simulation ........................................................................................................................ 223 

Geometry creation ..................................................................................................................................... 224 

Meshing ..................................................................................................................................................... 224 

Specifying the material and type of element .............................................................................................. 227 

Setting boundary conditions ...................................................................................................................... 229 

Run calculation ........................................................................................................................................... 231 

Results analysis .......................................................................................................................................... 232 

Using the console interface ........................................................................................................................ 233 

Change of pressure in well ............................................................................................................................ 234 

Geometry creating ..................................................................................................................................... 234 

Meshing ..................................................................................................................................................... 237 

Specifying the material and type of element .............................................................................................. 242 

Setting boundary conditions ...................................................................................................................... 245 

Run the calculation ..................................................................................................................................... 249 

Results analysis .......................................................................................................................................... 250 

Estimate the safety margin ........................................................................................................................ 252 

Using the console interface ........................................................................................................................ 253 

The loading history of the elastic-plastic plate .............................................................................................. 255 

Geometry creating ..................................................................................................................................... 255 

Meshing ..................................................................................................................................................... 256 

Specifying the material and element type .................................................................................................. 258 

Setting boundary conditions ...................................................................................................................... 259 

Set the dependence of the BC on the time and / or coordinates ................................................................. 260 

Run calculation ........................................................................................................................................... 261 

Results analysis .......................................................................................................................................... 262 

Using the console interface ........................................................................................................................ 263 

Sequential addition of volumes in the calculation process ............................................................................ 264 

Geometry creating ..................................................................................................................................... 265 

Meshing ..................................................................................................................................................... 267 



 CAE Fidesys — User Guide (version 3.0) 

7 

 

Specifying the material and type of element .............................................................................................. 267 

Setting boundary conditions ......................................................................................................................269 

Run calculation ........................................................................................................................................... 270 

Result Analysis ........................................................................................................................................... 272 

Using the console interface ........................................................................................................................ 273 

Sequential deletion of volumes in the calculation process............................................................................. 273 

 Geometry creating .................................................................................................................................... 274 

Meshing ..................................................................................................................................................... 277 

Set the Material ......................................................................................................................................... 279 

Setting boundary conditions ...................................................................................................................... 280 

Set the material and element type ............................................................................................................. 281 

Run calculation ........................................................................................................................................... 283 

Result Analysis ........................................................................................................................................... 284 

Using the console interface ........................................................................................................................ 286 

Seismic wave propagation (SEG-Y results) .................................................................................................... 287 

Geometry creating ..................................................................................................................................... 287 

Meshing ..................................................................................................................................................... 291 

Specifying the material and type of item .................................................................................................... 291 

Setting boundary conditions ...................................................................................................................... 293 

Set the BC dependency on time and / or coordinates ................................................................................. 294 

Receivers .................................................................................................................................................... 295 

Run calculation ........................................................................................................................................... 295 

Results analysis .......................................................................................................................................... 297 

Using the console interface ........................................................................................................................299 

Спектральный анализ балки при помощи спектра реакции ..................................................................... 300 

Построение модели ................................................................................................................................. 300 

Построение сетки ..................................................................................................................................... 301 

Задание материала и типа элемента ....................................................................................................... 303 

Задание сечения балок ............................................................................................................................ 305 

Задание массы инерционного элемента ................................................................................................. 305 

Задание граничных условий .................................................................................................................... 306 

Запуск расчета .......................................................................................................................................... 306 

Анализ результатов.................................................................................................................................. 307 

Вывод результатов ................................................................................................................................... 308 

Использование консольного интерфейса ............................................................................................... 310 

Contacts ............................................................................................................................................................. 312 

 



 CAE Fidesys — User Guide (version 3.0) 

8 

 

 

Introduction 

About the software 

CAE Fidesys  is a software package for strength analysis. The package comprises the following types of analysis: 

 Static loading 

 dynamic (transient) loading 

  buckling  

 analysis of natural frequencies 

  harmonic analysis; 

 calculation of effective material properties. 

The package also includes a program Fidesys Viewer for visualization and analysis of the obtained results: 

 Visualization of scalar and vector fields 

 SEG-Y files visualization 

 building graphs and charts 

 building frequency dependencies  

 time dependency analysis. 
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Getting Started 

System requirements 

CAE Fidesys has low system requirements for the package. It can be run on an ordinary personal computer. If the 
computer has one or more multi-core processors, calculations are automatically parallelized on all cores. Starting 
with version 1.5, calculation parallelization to several nodes connected to a local network or a cluster is available 
in the 64-bit version of the program package.  

CAE Fidesys  software package has following minimal requirements for software and hardware: 

Hardware requirements 
 CPU: Dual-core 1,7 GHz minimum 

 RAM: 4GB minimum 

 Free hard drive space: 5 GB 

 Video card NVIDIA GeForce GTX 460 or faster 

 Screen resolution: 1024х768 or higher 

Operating system 

Following operating systems are supported. (for the 64-bit versions) 

 Windows 7 Service Pack 1; 

 Windows 8;  

 Windows 8.1;  

 Windows Server 2008 R2 SP1;  

 Windows Server 2008 Service Pack 2;  

 Windows Server 2012;  

 Windows Server 2012 R2;  

 Windows 10 ;  

 Ubuntu 18.04 

 CentOS 6;  

 CentOS 7;  

 Debian 9;  

 RedHat 6;  

 RedHat 7;  

 Open SUSE Leap 15 

 Alt Linux 7 

 Alt Linux 8 
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Installation  

Microsoft Windows 

A user with administrator rights installs the software. Close all the CAE Fidesys windows before installation if 
there’s another version of CAE Fidesys installed. 

1. Download the CAE Fidesys installer from the site http://www.cae-fidesys.com/ru/download/login and run 
it for the architecture you are interested in (Windows x64 or Windows x32), or run the installation from 
the DVD-ROM.  

If any other version of CAE Fidesys is already installed on a computer, after starting the installation program you will be 
asked to delete it or to cancel the installation. 

2. Click Next in a pop-up window.  

 

3. Read the license agreement. If you do not agree with any of its paragraphs, interrupt the installer by 
clicking Cancel. If you totally agree with its terms, click Agree to proceed the installation. 

 

 

4. Select a folder for installation and click Next. 

http://www.cae-fidesys.com/ru/download/login


 CAE Fidesys — User Guide (version 3.0) 

11 

 

 

5. In the Start menu enter the name of the folder to create a shortcut for running the program. If you do not 
want to create a folder in the Start menu, choose Do not create shortcuts. Click Install. 

 

 

6. The process of installation may take some time. Click Ready after installing. 

Linux 

Only 64-bit Linux distribution kits are currently supported. 

1. Download the CAE Fidesys file for Linux x64 from http://www.cae-fidesys.com/ru/download/login. 

2. Right-click on the downloaded file and select Properties item from the contextual menu. 

3. In the opened window, go to  Permissions tab and tick Allow executing file as program. Click Close.  

http://www.cae-fidesys.com/ru/download/login
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4. Run the installer by double-clicking the installer file. When the dialog box appears, click Run in Terminal: 

 

Activation and trial period  

When you first run the preprocessor, the Fidesys Licensing window appears with a proposal to purchase a license 
or to activate a trial period.  

Trial period  

30-day trial period is automatically activated during installation. The trial period starts at the moment when 
application installation is completed. The trial period is for familiarization with the product and is not for any 
commercial calculations (related directly or indirectly to getting a profit out of them). The trial period can not be 
activated on a virtual machine, and the trial version is not designed to work through remote desktop. 

To activate a trial period, click the button Trial period in the start window.  

As long as the program runs in trial mode, the Fidesys Licensing window appears each time you launch it. Click 
Try to continue working in a trial mode. 
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Activation  

To activate the product: 

1. Click Activate in the Fidesys Licensing window.  

2. Select I do not have a V2C file and click Generate C2V. The system opens the Save file window. Save the 
C2V file and send it to the organization where the product was purchased. 

3. In response, you get a file containing an activation key with V2C extension. After receiving the V2C file, 
select I have V2C file and click Apply V2C. An Open File dialog window appears on the screen. Indicate in 
it the path to the received file.  

 

4. Your product is activated. 

The system will accomplish the activation automatically when using a dongle. 

Information on the purchased license 

Select Help → About in the Main Menu, and you see a window with the following information: 

  Full software version number; 

 License type and its expiration date; 

 The list of features available in the purchased license. 

Uninstalling the software 

A user with administrator rights uninstalls the software. 

Close all the running copies of the application before uninstalling the software: both preprocessor (Fidesys) and 
postprocessor (Fidesys Viewer). 

To remove the software, open Windows Control Panel and select Programs and Features (Add or Remove 
Programs in the earlier versions of Windows). Select CAE Fidesys #.#.#.# xNN in the list of installed programs, 
where #.#.#.# are four numbers standing for the number of the version and xNN is the architecture (x64). Right-
click it and choose Delete/Change. Confirm your choice by clicking Delete in the opened window. 

Removing the software does not involve removing its activation data. 
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The program overview. 

Package structure 

CAE Fidesys comprises three main components: 

 Fidesys — preprocessing and analysis (computational kernels). 

 FidesysCalc – calculations; 

 Fidesys Viewer — postprocessing and visualization of results. 

Running the software 

You can run the program in either of the following ways: 

 Use the Start menu (if you chose creating shortcuts in it when installing): choose Fidesys in the folder 
where you installed the program. 

 Use any file manager for Windows from the list where the program was installed 
(C:\Program Files\Fidesys\Fidesys 3.0 by default): run the file fidesys.exe (it is in the folder 
preprocessor\bin). 

Several copies of the program can be run on the same PC at a time. 

If you work on the licensed version, after running the program you see its Main window. If you use the trial 
period, a Fidesys Licensing window appears in which you should either click Activate in order to purchase a 
license or click Try to continue working in trial mode and go to the Main window. 

Main Window  

CAE Fidesys  has an intuitive graphic interface providing communication between the user and the software, and 
it allows the user to perform the full cycle of calculations step-by-step. 

 

 

 

 

Workbench (1) displays the model and visual effects. 



 CAE Fidesys — User Guide (version 3.0) 

15 

 

Main Menu (2) includes standard operations for working with files and projects, managing the visualization 
modes, panel display settings, help, and other functionality available in the drop-down lists of the menu. 

Power Tools (3) comprise the Model Tree, as well as the tools for geometry and mesh analysis. 

Command Panel (4) contains most of commands for working with the program. Panel display buttons are 
logically located, and it allows the user to perform the full cycle of calculations step-by-step. 

Toolbar (5) comprises the buttons for calling the most frequently used commands while working with the 
program. 

Properties Page (6) displays the properties of the selected object in the Workbench or in the Model Tree. 

Console (7) helps you to input the CAE Fidesys commands and to display the messages to the user. 
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Software history  

Version 3.0 

Released:  may  2020 

 
Functional additions:  

 Generator of unstructured hexahedral meshes and meshes with a hex dominant option. 

 New methods to assess the quality of the mesh. 

 A new tool for finding mesh intersections. 

 Ability to build geometry from nodesets. 

 Saving the quality data when exporting a mesh. 

 Creating prism elements based on triangular elements. 

 Mesh-building features now include the Sculpt auto hex algorithm. 

 Defining the yelding model using the stress / strain curve. 

 Implemented a response spectrum method for solving linear dynamic problems using the reaction 
spectrum  

Functional improvements: 

 Improved algorithm for constructing a triangular and tetrahedral mesh. 

New types of boundary conditions  

 Coupling Constraint (rigig body movement).  

 Boundary conduction: Heat Source, Volume Heat Source, Fluid Flux. 

Additions and improvements in the preprocessor 

 Added ability to edit material from the Model Tree.  

 Upgraded solid modeling engine. 

Additions and improvements in the postprocessor 

 Added filter Modal Combination.   

Version 2.2 

Released: October 2019 

Functional additions: 

 Ability to calculate complex CAD-models with offsets / overlaps between bodies for all types of analysis, including 
dynamic with direct integration. 

 Ability to change the material properties in blocks for multistep loading. 
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Functional improvements: 

 Accuracy of displaying results for 3D view is improved for beam elements. 

 Accuracy and  speed of dynamic analysis by using direct integration. 

New types of boundary conditions 

• Direction on restraint for setting boundary conditions along the normal or tangent. 

• Periodic boundary conditions for modeling cyclosymmetry and periodic structures. 

• Boundary condition Radiation for thermal conductivity and thermoelasticity problems. 

Additions and improvements in the preprocessor 

• Added toolbar with options for displaying the model along the coordinate axes. 

• The Start / Stop / Pause calculation control buttons added on the toolbar. 

Additions and improvements in the postprocessor 

• Improved the Coordinate system filter. 

Version 2.1 
Released: June 2019 

 Increased the speed of working with geometric models consisting of a large number of elements, the loading and 
preprocessing time for such models in particular. 

 Added automatic recording of dynamic calculations results (displacements, velocity, pressure, principal stresses) in 
SEG-Y files  for beam and shell elements. 

Version 2.0 

Released: February 2019 

Added calculation of multi-step loading 

 Setting of active boundary conditions for each loading step (adding / removing BC in steps) available 

 Setting of the boundary conditions for each loading step in the form of a table dependence (change of BC on the 
steps) available; 

 Setting of active blocks in the model for each loading step (adding / deleting blocks in steps) available. 

 

Recording and reading a file in SEG-Y format 

 Added automatic recording of dynamic calculations results (displacements, velocity, pressure, principal stresses) in 
SEG-Y files  for required receiver lines; 

 The ability to open and analyze SEG-Y files added to FidesysViewer. 

 

Additions and improvements in the preprocessor 

 Added support for formula and table dependencies for material constants in import and export of materials; 

 Added drawing graphs for table dependencies; 

 Enabled the ability to create models in the preprocessor without reference to the type of license key. For example, 
you can create a model for non-linear calculation, having only a key for the Standard version and then calculate on 
the workstation where the key for the Professional version is available. 

Version 1.7.1 

Released: September 2018 

New types of boundary conditions 
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 bonded contact (the ability to solve large assemblies on nonconformal mesh of different order); 

 radiation; 

 heat source; 

 volume heat source; 

 pore pressure; 

 fluid flow; 

 source of fluid; 

 volume source of fluid. 

New types of analysis 

 pore fluid transfer; 

 calculation of effective coefficients of thermal expansion. 

Added ability to set initial conditions 

 initial displacement; 

 initial speed; 

 initial angular velocity; 

 initial temperature; 

 initial pore pressure. 

New material properties 

 multilinear hardening (Mises); 

 prestress; 

 piezoelasticity. 

Additions and improvements in the preprocessor 

 a new smart method for setting materials. 

Additions and improvements in the postprocessor 

 improved software interface. 

Version 1.7.0 

Released: August 2017 

New element types 

 springs; 

 sphere element; 

 beam elements of the second order (with intermediate nodes). 

New types of boundary conditions 

 distributed force; 

 rigid coupling; 

 gravity; 

 angular velocity; 

 non-reflective boundary conditions and initial conditions in dynamic analysis. 

 

New types of analysis 
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 harmonic analysis; 

 method of superposition of modal forms, including the setting of damping parameters, for solving dynamic 
problems. 

Features added: 

• Ability to set dependencies of material parameters on coordinates / temperature. 

• Ability to calculate the effective masses and coefficients of participation of own forms of the structure. 

• New section profiles for beam elements. 

• Improved the generator of unstructured settlement mesh operation, including the case of hybrid mesh. 

• Added support for CATIA v5, v6 formats. 

Improvements: 

• Improved the generator of unstructured settlement mesh operation, including the case of hybrid mesh. 

 

Additions and improvements in the preprocessor 

 Improved stability. 

 

Additions and improvements in the processor (calculation  module) 

 Elastoplastic deformation according to the Drucker-Prager model; 

 Harmonic analysis; 

 Ability to simulate couplings. 

 

Additions and improvements in the postprocessor (3D-visualization module) 

 Improved operation of the software interface based on Python Shell. 

Version 1.6 R2 

Released: April, 2015  

Updates and improvements in the preprocessor  

 Possibility to automatically process the calculation results of composites effective properties; 

 Operations stability  increased. 

Updates and improvements in the processor  

 Elastoplastic deformation by the Drucker-Prager model; 

 Calculation of the effective properties of composite materials; 

 HPC and Dynamics modules available in Standard and Professional. 

Updates and improvements in the postprocessor (3D-vizualization module)  

 Improved the programming interface operation based on Python Shell. 

Version 1.6 

Released: February, 2015 

Features added: 

 support for importing geometry in the following CAD-formats: 
– SolidWorks; 
– Parasolid; 
– Pro/Engineer. 
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 support for APREPRO (An Algebraic Preprocessor for Parameterizing Finite Element Analyses)  
 Added new profiles of beam cross section: 

– Channel (C-shape); 
– Corner (L-shape); 
– Taurus (T-shape); 
– Z-shape; 
– Hollow rectangle. 

 Possibility to set boundary conditions using tabular and formular dependency on the coordinates and 
temperature for static analysis; 

 New generator of adaptive tetrahedral meshes; 
 Improved the panel of nonlinear solver settings; 
 Ability to calculate contact interaction in the 3d case for volumetric models and in the 2d case for flat 

models Contact surface binding in 3D and the contact curves binding in 2D; 
 Ability to calculate natural frequencies taking into account the preliminary stress state.; 
 Automatic adaptive calculation of the loading steps size; 
 Output of intermediate results and calculation log (textual information on the status of the calculation by 

stages) for nonlinear problems; 
 Ability to calculate thermoelastic problems using shell elements of the second order: TRISHELL6, 

SHELL8, SHELL9; 
 Support for multiprocessor calculations based on MPI technology for the following calculations: 

– Spectral element method; 
– Plasticity for small and finite deformations; 
– Dynamic analysis for the explicit and implicit time schemes. 

 Modified the incorporation of plastic deformation using finite element method and spectral element 
method taking into account: 

– Finite deformations; 
– Thermoelasticity. 

 CAE Fidesys  licensing system. 
 

Improvements: 

 Improved dynamic analysis perfomance; 
 Improved the performance of spectral element method on hybrid meshes in buckling problems; 
 Increased the solution tolerance of static problem with shear loading using 4-node plane and 8-node 

volumetric elements; 
 Fidesys Viewer 1.6: added focusing of model elements in the current position of the mouse pointer; 
 Fidesys Viewer 1.6:improved strength analysis filter operation; 
 Fidesys Viewer 1.6: improved the “Agreed resultants” filter operation for shell structures; 
 Improved the compatibility with Windows 8 and Windows 8.1; 
 Improved The Progress Bar operation; 

Version 1.5 R2 
Released: July, 2014 

Features added: 

 Ability to set the analytic spatial coordinates dependence of the boundary conditions; 

 Possibility to produce graphs of the spatial coordinates and time dependency of the boundary 
conditions; 

 The generation of console commands for setting up and running the calculation of the graphical interface 
widgets; 

 Import/export of materials from the graphical interface; 

 New version of Fidesys Viewer with a number of improvements. 
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Version 1.5 
Released: June, 2014  

Features added: 

 Static analysis for elastoplastic material models; 

 Orthotropic materials; 

 Physically nonlinear hyperelastic materials: Mooney-Rivlin and Murnaghan; 

 Calculations by spectral element method for hybrid meshes; 

 Possibility of parallel calculations on one or more computers using the MPI technology (linear statics, 
modal analysis, buckling); 

 Calculation of the margin of safety in accordance with various strength theories; 

 8-node shell elements SHELL8; 

 Console commands to set analysis parameters and to run the calculation; 

 Ability to set  time dependence individually for each boundary condition in dynamic problems; 

 Windows XP compatibility issues fixed. 

Version 1.4 
Released: December, 2013 

Features added: 

 Buckling problems; 

 Thermal conductivity and thermoelastic problems; 

 Curvilinear finite elements; 

 Geometrically nonlinear problems; 

 The spectral element method for linear and nonlinear two-and three-dimensional static problems and 
modal analysis; 

 Support for hybrid meshes; 

Version 1.3 
Released: July, 2013 

Features added: 

 Beam elements; 

 Shell elements; 

 Geometry creation of high-speed processes by the spectral element method; 

 Static and dynamic nonlinear problems; 

 High-order finite elements; 

Version 1.2 
Released: February, 2013 

Features added: 

 Computational performance improved; 
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 Plane-stress and plane-strain problems; 

 The translation into cylindrical and spherical systems added in the postprocessor; 

 The calculation of tensors invariants is added in the postprocessor; 

 The visualization of the calculation results as contour lines is added in the postprocessor. 

Version 1.1 
Released: November, 2012 

 Parameter setting and calculation launch from the Main Menu of the preprocessor; 

 Dynamic transient problems; 

 Modal analysis; 

 Hexahedral meshes support; 

 The operation with projects and the calculation control system; 

 The postprocessor’s localization support; 

 The postprocessor performance improved. 
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Using the Program 

Performing calculations with the use of CAE Fidesys  implies the following steps: 

 Setting the geometry; 

 Meshing; 

 Setting boundary conditions; 

 Setting the material; 

 Starting calculation; 

 Visualizing and analyzing results. 

All of the steps except for the last one are accomplished in preprocessor; the last step is accomplished in 
postprocessor. 

Geometry 

CAE Fidesys  allows to generate volume geometry on your own due to the built-in functionality, as well as to 
import 3D models created in different CAD-systems. 

Geometry import 

For geometry import choose File → Import in the Main menu. CAE Fidesys  supports the import of the following 
formats: 

 ACIS (*.sat, *.sab); 

 IGES (*.igs, *.iges); 

 STEP (*.stp, *.step); 

 Warefront Object (*.obj); 

 Stanford Polygon (*.ply); 

 Assimp; 

 GAMBIT Real Geometry (*.dbs); 

 Catia (*.CATPart, *.CATProduct, *.ncgm); 

 Parasolid (*.x_t, *x_b); 

 SolidWorks (*.sldprt, *.sldasm); 

 ProE (*.ptr, *.asm); 

 Abaqus (*.inp); 

 STL Files (*.stl); 

 Fluent (*.msh); 

 GAMBIT Neutral (*.neu); 

 Ideas (*.unv); 

 Nastran (*.bdf); 

 Patran (*.pat, *.neu, *.out); 

 Cubit files (*.cub); 

 Trelis (*.trelis); 

 CATIA v4 (*.model); 

 Fidesys Case (*.fc). 
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Geometry creating 

For geometry generation CAE Fidesys  provides the user with large numbers of volume geometric primitives 
(parallelepiped, cylinder, prism, cone, pyramid, sphere, torus). It also allows uniting the surfaces in closed volume 
bodies. For complex geometry generation you can use Boolean operations (Intersect, Subtract, Unite volumes) 
and different transformations of the object (Rotate, Move, Scale, Reflect). All of the described functionality is 
available on Command Panel in Geometry section. 

 

   

 

Meshing  

CAE Fidesys  supports the following types of the finite elements for meshes: 

 volume: SOLID (tetrahedrons, hexahedra, pyramids, prisms); 

 plane: PLANE (triangles, quadrangles); 

 shell: SHELL (triangles, quadrangles); 

 beam: BEAM; 

 springs: SPRING; 

 point masses: LUMPMASS. 

The order of all elements, except for springs and point masses, can vary from 1st to 9th. The order of the element 
above the second means using the method of spectral elements. 
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Volume meshing 

Select volume mesh generation section on Command Panel (Mode — 
Mesh, Entity — Volume). 

1. Specify the degree of mesh refinement (Action — Intervals) for each 
volume: 

 Select the volumes (specify their ID). You can enumerate several 
volumes using space after each of them. All of the volumes can 
be set by the command all; 

 Select the way of mesh generation (Auto, Approximate size, 
Geometry-adaptive, Interval or Sizing function) ; 

 Click Apply Size. 

 

2. Specify the type of the elements for each volume: 

 Select the entities for mesh generation (specify their ID). You can 
enumerate several volumes using space after each of them. All of 
the volumes can be set by the command all; 

 Select meshing scheme (tetrahedral (Tetmesh) or hexahedral 
elements (Automatically calculate); 

 For tetrahedral mesh generation select the level of optimization (Extreme, Strong, Heavy, Standard, 
Medium, Light, or None) and set the checkboxes in front of the corresponding points, if you need to 
minimize the over-constrained and/or sliver tets. 

 Click Apply Size; 

 Click Mesh. 

For complex geometry it is recommended to set the scheme of surface mesh generation first (triangular or 
quadrangular elements). 

 

Surface mesh generation 

To generate a surface mesh, follow these steps. 

1. Select surface mesh generation section on Command Panel (Mode — 
Mesh, Entity — Surface). 

 

2. Specify the degree of mesh reducing (Action - Intervals – 
Approximate size) of each surface: 

• select volumes (specify their ID). Multiple volumes can be listed through 
a space; all volumes can be specified using the command all; 

• indicate the Approximate size; 

• Click Apply Size. 

To generate an irregular mesh (e.g. make it finer in the vicinity of stress 
concentrators), you can add nodes on the boundaries near geometry 
features, as well as split curves, surfaces and volumes in the vicinity of the 
features. 

Using the functionality available on Command Panel you can: 
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 Check the mesh quality (including checking the mesh quality of individual elements: volumes, surfaces, 
curves); 

 Modify the generated mesh (Refine, Smooth, Delete); 

 Renumber the elements and delete the generated mesh. 

Parallel Meshing 

Fidesys has been designed as a serial application, using a single CPU to generate its meshes. In some cases, 
where memory or time constraints are critical, parallel meshing may be necessary. Fidesys currently provides a 
separate application designed to run in parallel either on a desktop or on massively parallel cluster machines. In 
these cases, Fidesys can be used as a pre-processor to manipulate geometry and set up for meshing, however 
the actual meshing procedure is performed as a separate process or on another machine. 

Sculpt 

Sculpt is a separate parallel application designed to generate all-hex meshes on complex geometries with little or 
no user interaction. Fidesys provides a front end command line and GUI for the Sculpt application. The command 
will build the appropriate input files based on the current geometry and can also automatically invoke Sculpt to 
generate the mesh and bring the mesh back to Fidesys. 

Sculpt parameters are divided into 4 areas: Size, Mesh, Smoothing, and Parallel. 

 

The method for generating an all-hex mesh employed by Sculpt is often referred to in the literature as an overlay-
grid or mesh-first method. This differs significantly from the algorithms employed by Sweeping and Mapping, 
which are classified as geometry-first methods. Mapping and Sweeping start with the geometry, carefully fitting 
logical groupings of hexes to conform to a recognized topology. In contrast, the Sculpt method begins with a 
base Cartesian grid encompassing the geometry which is used as the basis for the mesh. Geometric features are 
carved or sculpted from the Cartesian grid and boundaries smoothed to create the final hex mesh. The obvious 
benefit of the Sculpt (mesh-first) method over Mapping and Sweeping (geometry-first) methods is there is no 
need to decompose the geometry into mappable or sweebable components, a process that can often be very 
time consuming, tedious and sometimes impossible. Input to Sculpt can be any geometry regardless of features 
and complexity. 

The basic Sculpt procedure is illustrated in figure 1. Beginning with a Cartesian grid as the base mesh, shown in 
figure 1(a), a geometric description is imposed. Nodes from the base grid that are near the boundaries are 
projected to the geometry, locally distorting the nearby hex cells (figure 1(b)). A pillow layer of hexes is then 
inserted at the surfaces by duplicating the interface nodes on either side of the boundaries and inserting hexes 
(figures 1(c) and (d)). While constraining node locations to remain on the interfaces, smoothing procedures can 
now be employed to improve mesh quality of nearby hexes (figure 1(e)). 

 



 CAE Fidesys — User Guide (version 3.0) 

27 

 

 

 

Figure 1. The procedure for generating a hex mesh using the Sculpt overlay grid method 

Sculpt is limited to capturing geometric features with the available resolution of the selected base mesh. 
Because of this, care should be taken in selecting an appropriate cell size. In addition, no attempt is made by the 
Sculpt procedure to capture sharp exterior features. Figure 2 shows an example of a sculpt mesh of a CAD model. 
Note that exterior corner features are rounded, however the effect of sharp feature capture becomes less 
pronounced as resolution increases as demonstrated in figures 3(a) and (b). 

 

Figure 2. Hex mesh generated using the Sculpt overlay grid procedure 
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Figure 3. Examples of the same model meshed at two different resolutions showing a cutaway view of the 
mesh. 

Another aspect of model preparation for computational simulation involves geometry cleanup and 
simplification. In most cases, geometry-first methods, such as Sweeping, require an accurate non-manifold 
boundary representation before mesh generation can begin. Small, sometimes unseen gaps, overlaps and 
misalignments can result in sliver elements or mesh failure. Tedious manual geometry simplification and 
manipulation is often required before meshing can commence. Sculpt, however employs a solution that avoids 
much of the geometry inaccuracy issues inherent in CAD design models. Using a faceted representation of the 
solid model, a voxel-based volume fraction representation is generated. Figure 4 illustrates the procedure where 
a CAD model serving as input (figure 4(a)) is processed by a procedure that will generate volume fraction scalar 
data for each cell of an overlay Cartesian grid (figure 4(b)). One value per material per cell is computed that 
represents the volume fraction of material filling the cell. A secondary geometry representation is then extracted 
using an interface tracking technique from which the final hex mesh is generated (figure 4(c)). While similar to its 
initial facet-based representation, the new secondary geometry description developed from the volume fraction 
data results in a simplified model that tends to wash over small features and inaccuracies that are smaller than 
the resolution of the base cell size. 
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Figure 4. A representation of the procedure used to generate a hex mesh with Sculpt using Volume Fractions. 

While acknowledging some loss in model fidelity in this new volume-fraction based geometric model, the 
advantage and time-savings to the analyst of being able to ignore troublesome geometry issues is enormous. At 
the same time it may be important to understand what the additional discrete approximations will make to 
solution accuracy and employ relevant engineering judgement in the use of this technology. 

 

Sculpt Adaptive Meshing 

Options for specifying adaptivity and refinement in Sculpt 

Sculpt uses an initial overlay Cartesian grid that serves as the basis for the all-hex mesh. The default mesh size 
will roughly follow the constant size cells of the overlay grid. The adaptivity option allows the user to 
automatically split cells of the Cartesian grid based on geometric criteria, resulting in smaller cells in regions with 
finer details. The adapted grid is then used as the basis for the Sculpt procedure. 

   

Fig. 5 Adaptive mesh begins with constant size coarse Cartesian grid. Cells are recursively split based on 
geometry criteria and transitions added between levels. Projections and smoothing are performed to improve 

element quality. 

Three options are used for controlling the adaptivity in sculpt: adapt_type, adapt_levels and adapt_threshold. 
The adapt_type option controls the method and geometric criteria used for deciding which cells to split in the 
grid, while the adapt_levels option controls the maximum number of times any one cell can be split. Depending 
upon the adapt_type selected, the adapt_threshold is used as the specific geometric threshold value at which the 
decision is made to split any given cell. 

Sculpt Boundary Layers 

Sculpt options for defining boundary layers in the mesh. 
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Boundary layers are thin hex layers that can be defined at surfaces, extending either inward or outward from a 
material. The user may specify the number and thickness of the hex layers as well as the material ID of the layers. 
Layer thicknesses should normally be "thin" with respect to the size of the cells. Layers will not intersect, so 
should be defined on surfaces where nearby layers will not overlap. Boundary layers are specified based upon a 
material ID, where hex layers will be placed at surfaces where the material interfaces with other materials, or at 
free surfaces. 

 

Example of boundary layers. 

 

Boundary layers defined at the surfaces of a material. 
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Example schema for boundary layers. 

Sculpt Mesh Improvement 

Sculpt options for modifying the mesh to improve mesh quality. 

Automatic smoothing provides an effective method for improving element quality. However there may be some 
cases that cannot be improved with smoothing alone. The options included in this section will apply changes to 
the underlying hex mesh or to the volume fraction data to increase the opportunity for smoothing to produce a 
good quality mesh. 

 Pillow 
For models that have more than one material that share an interface, unless the geometry is precisely aligned 
with the global axis, it is usually a good idea to turn on pillowing. Pillowing automatically inserts an additional 
layer of hexes at interface boundaries to improve mesh quality. Without pillowing you may notice inverted or 
poor quality elements at curve interfaces where 2 or more materials meet. 

The pillow option will generate an additional layer of hexes at surfaces as a means to improve element quality 
near curve interfaces. This is intended to eliminate the problem of 3 or more nodes from a single hex face lying 
on the same curve. Use one or more of the following options to set up pillowing: 

 pillow_surfaces: Pillow around all surfaces 

 pillow_curves: Pillow bad quality at curves 

 pillow_boundaries: Pillow at domain boundaries 

 pillow_curve_layers: Number of element layers to buffer curves 

 pillow_smooth_off: Turn OFF smoothing following pillow operations 

See help on the above options for more information 

 Pillow All Surfaces 
Pillow option to insert a layer of hexes surrounding each internal surface in the mesh. Where two volumes share a 
common interface is defined as a surface. All hexes that have at least one of its faces on a surface are defined as 
the "shrink set" of hexes. A separate shrink set is defined for each unique surface. Hexes in the set are shrunk 
away from their hex neighbors not in the shrink set. A layer of hexes is then inserted surrounding all hexes in 
each set. This enforces the condition where no more than one hex edge will lie on any single curve thus allowing 
more freedom for the smoother to improve element quality. 
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Fig. 6 Example of surface pillowing, before and after smoothing 

Surface pillowing is off by default. If both pillow_curves and pillow_surfaces options are used, curve 
pillowing will be performed before surface pillowing. See the pillow option for more information on setting 
additional options for pillowing. 

 Pillow Bad Quality at Curves 

Pillow option to selectively pillow hexes at curves. Only hexes that have faces with 3 or more nodes on a 
curve will be pillowed. Additional buffer layers of hexes beyond the poor quads at the curves will be included in 
the pillow region. The number of buffer layers beyond the curve can be controlled with the pillow_curve_layers, 
where the default will be 3 layers. 
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Fig. 7 Example of curve pillowing with four pillow_curve_layers, before and after smoothing 

Curve pillowing is off by default. If both pillow_curves and pillow_surfaces options are used, curve pillowing will 
be performed before surface pillowing. See the pillow option for more information on setting additional options 
for pillowing. 

 Pillow at Domain Boundaries 

Pillow option to insert pillow layers at domain boundaries of the initial Cartesian grid definition. One layer of 
hexes is inserted on each of the six faces of the Cartesian Domain. This option is useful where the void option is 
used to generate a mesh in the full Cartesian grid and where the adapt option has been used. Without this 
option, it is likely that hexes with two faces on the same domain boundary will occur if the adaptation extends to 
the boundary. Turning on the pillow_boundaries option should correct for these cases. 
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Fig. 8 Example of pillowing at boundaries on a microstructure RVE. (b) before smoothing (c) after smoothing 

Boundary pillowing is off by default. The pillow_boundaries option may be used in the same input 
as pillow_surfaces or pillow_curves. The pillow_boundaries option must also be used with 
the mesh_void option to ensure hexes will exist at the Cartesian domain boundary. See the pillow option for 
more information on setting additional options for pillowing. 

 Number of Element Layers to Buffer Curves 

Used for setting the number of buffer hex layers when the pillow_curves option is used. When pillow_curves is 
used a shrink set is formed from hexes that would otherwise have two or more edges on the same curve. This 
value will control the extent to which neighboring hexes will be included in the shrink set. The 
default pillow_curve_layers is 3. Setting this value lower will localize the modifications to the hex mesh, whereas, 
more layers will extend the region that is affected in correcting the poor quality at curves. 

 Defeature 

Option to automatically detect and remove small features. Primarily used for defeaturing microstructure 
data, however can be used with any input format. The following options are available: 

 off (0): No defeaturing performed (default) 

 filter (1): Filters the Cartesian grid data so that groupings of cells of a common material with less 
than min_vol_cells will be reassigned to the predominant neighboring material. If 
the min_vol_cells argument is not specified, the minimum number of cells in a volume will be set to 5. 
This has the effect of removing small volumes that would otherwise be generated. This option will also 
remove protrusions, where a cell surrounded on 4 or 5 sides by another material ID will be reassigned to 
the predominant neighboring material. This option is available with multiple processors. 

See also the defeature_iters and defeature_bbox options for additional control of the defeature = 
filter option. The compare_volume option can also be used to validate that changes made to material volumes 
are within acceptable limits. 
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Fig. 8 Example grid cells before and after defeaturing has been applied 

 

Fig. 9 Final mesh after using defeaturing. 

 collapse (2): Curve and surface collapses are performed. This option is only available when used with 
the trimesh option. After geometry has been extracted and built from the volume fraction data curves 
containing exactly one mesh edge are collapsed into a single vertex. Surfaces that are identified with 
exactly 2 curves, each of which have 2 mesh edges are collapsed into a single curve. Only available as 
serial option (-j 1) 
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Fig. 10 Example collapsing of small curve on microstructure model when using defeature=2 and trimesh 

option 

 filter_and_collapse (3): Performs both option filter (1) and collapse (2) on a trimesh. Only available as 
serial option (-j 1) 

 Minimum Number of Cells in a Volume 
When used with defeature options filter (1) or filter_and_collapse (3), specifies the minimum number of 

cells below which a volume will be eliminated. The cells of small volumes will be absorbed into the predominant 
material of the neighboring cells. If not specified and defeature options filter (1) or filter_and_collapse (3) are 
used, the min_vol_cells value will be set to 5. 

 Defeature at Bounding Box 
The defeature_bbox option is used in conjunction with defeature = filter (1). It is used to modify the 

defeature filter criteria at cells that are immediately adjacent to the Cartesian grid's domain boundary. It is most 
effective for microstructure data but can be used with any input format. The defeature = filter (1) option will 
remove protrusions identified by cells that are surrounded on 4 or 5 sides by another material. For cells that are 
at the domain boundary, cells will have missing adjacent cells on at least one face. If 
the defeature_bbox=true option is used, the missing adjacent cells are considered a different material and 
counted in the 4 or 5 surrounding cells with a different material. In contrast, the defeature_bbox=false option 
will not count the missing adjacent cells. Using the defeature_bbox=true has the effect of more aggressively 
modifying cells at the domain boundaries to avoid protrusions. The default for this option 
is defeature_bbox=false. It will be ignored if defeature = filter (1) is not used. 

 Maximum Number of Defeature Iterations 
Used with the defeature option. Controls the maximum number of iterations of defeature filtering that will 

be performed. Setting this value greater than the default of 10 can be useful for very noisy data where a 
significant number of iterations will need to be performed to resolve the geometry. 

When performing non-manifold resolution, the defeature state of some of the cells may be effected. As a result, 
the defeaturing and non-manifold resolution procedures are performed in a loop until no further changes can be 
made. The defeature_iters sets the maximum number of defeature and non-manifold resolution procedures 
that will be performed. Note that if defeaturing reaches the maximum iteration value without completely 
resolving all non-manifold conditions, that subsequent sculpt procedures may not succeed. Set this value higher 
to allow the defeaturing and non-manifold resolution to run to completion. The stair = 1 option can be used to 
interrogate the model to see where non-manifold conditions may still exist. 
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 Thicken a material 
Used with the defeature option. Add additional cells at the boundary of a given material. Takes two input 

values, a material and a volume fraction between 0 and 1. This option is useful for noisy input data that may not 
form contiguous volumes. Thickening a material may close small gaps making the material continuous. To 
perform the thicken operation, cells in adjacent materials are removed and reassigned to the indicated material. 
This option requires both a valid material ID and volume fraction value, where the volume fraction represents the 
amount of material to be added to each neighboring cell. For example: 

thicken material = 1 0.2 

thicken_material = 2 0.5 

Each neighboring cell to material 1 will change approximately 20 percent of its volume to be material 1. 
Other materials present in the cell will be decreased accordingly to maintain a sum of 1.0 for each cell. Additional 
material is accumulated in neighboring cells from each adjacent cell it shares with material 1, so that if for 
example a neighbor cell shares faces with three cells of material 1, it will add 0.6 (0.2 X 3) of material 1 volume 
fraction to the neighbor. If more than one thicken_material option is used, the thicken operation will be 
performed in the order they appear in the input. For the above example, material 1 would first be thickened, 
followed by material 2. If materials 1 and 2 are adjacent, thickening in this case, material 2 would take 
precedence, potentially removing cells from material 1 at their interface. 

 

 

Fig. 11 Bitmap input is used on a Cartesian base grid to generate the mesh for complex head and brain 
anatomy. Left: Some of the materials prior to applying the thicken_material option. Right: After applying the 

thicken_material option. 

 Microstructure Expansion 
This option expands the Cartesian grid by a specified number of layers. It can be used with any of the following 
input options: 

    --input_micro 

    --input_cart_exo 

    --input_spn 
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In some cases the interior material interfaces may intersect the domain boundaries at small acute angles. 
When this occurs it may be difficult or impossible to achieve computable mesh quality at these intersections. To 
address this problem, one or more layers of hexes may be added to the Cartesian grid. The volume fractions from 
cells at the boundary are copied to generate additional layers. This has the effect of increasing the angle of 
intersection for any material interfaces intersecting the domain boundary. Usually a value of 1 or 2 is sufficient to 
sufficiently improve quality. 

Note that the resulting mesh in the expanded layers serves only to improve mesh quality and will only 
duplicate existing data at the boundaries. It may not reflect the actual material structure within the expansion 
layers. 

 

(a) Initial mesh (b) One expansion layer added (c) Two expansion layers added 

 

 Microstructure Shave 
This option potentially modifies the outermost layer of Cartesian cells of a microstructures file. It will identify 

isolated cells where the assigned material is unique from all of its surrounding cells at the boundary. When this 
occurs, the cell material is reassigned to the dominant nearby material. 

This option is useful if it is noted that a cell structure just barely grazes the exterior planar boundary surface. 
Poor quality elements can often result with this condition. The micro_shave option will, in effect, remove 
material from the cell structure, but will result in better quality elements by removing the intersection region 
with the boundary. 

micro_shave can be used with any of the following input options: 

    --input_micro 

    --input_cart_exo 

    --input_spn 
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Setting material and element type 

Element types  

Set the Material 

CAE Fidesys  supports the following materials: 

 Hooke material; 

 Orthotropic material; 

 Transversely isotropic material; 

 Mooney Rivlin material; 

 Material Blatza-Ko; 

 Murnaghan material; 

 Elastoplastic material (Mises criterion, Drucker-Prager); 

 Thermoelastic material; 

 Poroelastic material (Bio Model). 

For Mooney-Rivlin and Murnaghan materials, the following defining relations are used. 

Mooney-Rivlin potential: 

2
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where D, С1, С2 are Mooney-Rivlin material constants. 

Relation of D, С1, С2 and Poisson's ratio : 
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Murnaghan potential: 
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where λ, G, C3, C4, C5 are Murnaghan material constants. 

To set the new material, select the setting material properties section on Command Panel (Mode –Materials, 
Entity – Materials Management). 

 

 
 
Material properties are set in the Materials Management widget. 
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Next, using the “drag & drop” method, add the necessary characteristics from the left column to the Material 
Properties column. 

Select the desired characteristic with the mouse. Hold down the left mouse button and drag the label to Material 
Properties. Double-click in the Value field opposite the property that appears and specify the correct value. 

The right column shows the preset materials. To use these materials in the calculation also drag the material of 
interest into the Materials column (where the active materials are located). Click the Apply button. 

Upon successful addition, the created materials should appear in the Model Tree in the Materials section. 

 
 

Note:  Use Block to link the material and the model. 
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Setting tabular dependencies for materials 

To create tabular dependencies for material characteristics, double-click in the Value field opposite the desired 
property. A button with a triple point will appear. Click this button. The Edit Table widget opens, where you can 
set table dependencies. 

 

 

To specify a formula dependence,  enter the appropriate formula in the Value field and then click Apply. 

 

Import/Export Material 

To import materials right-click in the Imported Material column. Select Import in the context menu. Specify the 
path to the imported material. 
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Panel settings for an existing material change, if an added material with the same name already exists in 
previously imported materials: 

• If it is allowed to overwrite it, tick the Overwrite checkbox. 

• If you need to add a new one, put the Append checkbox, and the material will be added with renaming. 

• By default, the check is set to Ignore - the material is not imported, the previous material remains. 

Click Apply. Next, drag the imported material into the active materials column (Material). Click Apply. 

CAE Fidesys supports importing material in XML format.  

 

To export the created material, right-click the material name, select Export in the context menu. Specify the 
path to save the file, click Apply. 

 

If the value of a property is not entered, then by default it is assumed to be zero (except for the shear modulus, 
which is determined automatically based on the entered values of E and ν). 

Setting the yielding model  

The choice of the correct model of the material plastic flux is very important to obtain a proper solution of the 
problem. Plasticity problems are nonlinear, therefore, they require substantial computer resources and solving 
problems with large plastic strains may take a long time. The Fidesys system of strength analysis for the Hook 
material realizes two criteria of transition into plasticity: the Mises criterion and the Drucker-Prager criterion. 
Problems are solved both for perfectly elastoplastic models and for models with linear hardening. An approach 



 CAE Fidesys — User Guide (version 3.0) 

43 

 

taking into account finite strains in the elastic zone is currently implemented; the linear formulation of the 
problem is used in the zone of plastic flux. 

Von Mises yield criterion  

To add the Mises plasticity to the Hook material, select the section for setting material properties on the 
Command Panel (Mode - Blocks, Entity - Materials Management). 

 

Specify the name of the material. From the left column, drag the Hooke Material inscription into the Material 
Properties column. Fill in the Values fields accordingly: 

 

 

To create the model with the von Mises plasticity without hardening, set elastic properties of the Hook material 
as well as the yield strength: 
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To create the Mises plasticity model with linear hardening, it is also necessary to enter the yield strength in 
tension and the ultimate strain in tension. 

 

Drucker-Prager yield criterion  

There are two ways to specify the Drucker-Prager plastic model without hardening in the CAE Fidesys software 
package - “First Drucker-Prager Criterion”, “Second Drucker-Prager Criterion”, which become available in the 
“Materials Management” widget after specifying elastic constants. 
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“First Drucker-Prager Strength Criterion” implies the setting of the material properties “Yield strength”, “Yield 
strength for compression”: 

 

To use the "Drucker-Prager Second Criterion " it is necessary to enter the properties of the material "Cohesion", 
"Internal friction angle", "Dilatancy angle ": 

 



 CAE Fidesys — User Guide (version 3.0) 

46 

 

To obtain a Drucker-Prager plasticity model with hardening, also specify the limits of strength and ultimate 
strain for tensile and compression (available for both the first and the second plasticity criterion according to 
Drucker-Prager): 

 

Polylinear hardening 
 
Also, with the Mises plasticity in CAE Fidesys, a more general type of hardening is available - polylinear 
hardening, for which you need to fill in the table property of the material “Sigma(epsilon) curve” material (in the 

table pairs of values from the strain on plastic component “plastic component of deformations 11 ” - “ true stress 

11s "): 
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Element types  

CAE Fidesys supports the solution of elastoplastic problems for the following types of already existing finite 
elements: 

– Solid elements (3D); 

– Shell elements (2D). 

Blocks operations  

A block contains an element type, ID and the name of the geometric model of 
the material. It is recommended to create several blocks if several materials or 
several types of geometric entities are used in the calculation. 

For example, if a structure contains solid and shell elements, it is necessary to 
create a block for each type of element. If the construction consists of beams 
with different types of sections, then for each type of section you need to create 
your own block. 

The sequence of operations with blocks can be schematically represented as 
follows:  

 Create block specifying geometric Entity ID; 

 Assign the material to the block; 

 Assign the element type to the block. 

Let us consider these steps in detail.  

1. To create a new block go to Mode – Blocks, Entity – Block, Action – 
Add. 
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2. In the Entity list drop-down menu, select the type of geometric objects that will be included in the 
block. 

Click Apply. 

You can find out the ID of the geometrical entities united into the 
block as follows:  

 in the Model Tree on the left;  

 by clicking on geometrical objects you are interested in – their 
ID will automatically appear in the appropriate field. 

 

The block ID field requires a serial number. 
  
 
 
 
 
 
 
Note: Created block is displayed in the Model Tree on the left in the section Blocks.  
 
 

 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

To look through the list of the geometric entities united into the block, enter in Command Line List block 1. 

In the Console, you will see the list of entities united into the block. 

3. To assign the material to the block, select Block – Set material in the drop-down list. 

You can enter the block ID manually or click the corresponding geometric entity. Available material is selected 
from the drop-down list. 
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Click Apply.  
 
4. To set the element type, select Element Types in the drop-down list. 

The block ID can be entered manually, or by clicking the corresponding geometric object. 

In the Category field, select the item that corresponds to the entity added to the block. 

Specify the order of the element. The order can be selected from 1 to 9. 

Click Apply. 

 

Note: Order 2 corresponds to the choice of the element of the second order, where intermediate nodes are 
added on the edges. The order of the element 3 and further means that the calculation will be carried out by the 
method of spectral elements of the corresponding order. 

 

The following categories are available for the according element types: 

• Point mass: LUMPMASS. 

• Spring: SPRING. 

• Beam: BEAM. 

• Shell: SHELL. 

• Plane (2D): PLANE. 

• Solid: SOLID. 

If an element type is not assigned to a block, the program selects it by default based on the type of the geometric 
object contained in the block. The following rules are used: 

 Volumes meshed by SOLID elements. 

 Surfaces meshed by SHELL or PLANE elements. 

 Curves meshed by BEAM or SPRING elements. 

 Vertices correspond to single-node elements LUMPMASS. 
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Nodes corresponding to the higher order of approximation are arranged in accordance with the default curved 
geometry. To change this rule, you can use the command: 

set node constraint [ON | off | smart] 

Setting off corresponds to the location of nodes of a higher order without taking into account the curved 
geometry; they occupy middle positions between the corner nodes of the elements: in the middle of straight 
edges, in the centers of flat surfaces, etc. The smart setting only takes the curvature into account when it does 
not degrade the quality of the elements. 

 

Setting shell properties  

CAE Fidesys  supports shell elements SHELL. 

To set the properties of the shells - thickness and eccentricity - go to 
Mode - Blocks, Entity - Shells Properties. On the panel that appears, 
specify: 

 Block ID; 

Then click Set shell properties. Specify: 

 Thickness; 

 Material; 

 Eccentricity. 

Note: Eccentricity by default is equal to 0.5.  

 

 

 

The eccentricity for the shell element varies from 0 to 1 and determines the distance between the surface of the 
shell, considered in the  geometric or finite-element model, and the middle surface of the shell (in fact, the 
thickness offset of the middle surface relative to the upper surface of the shell in proportion). By default, 
eccentricity is set to 0.5. 

3D shell cross section view is possible in the Fidesys Viewer postprocessor by clicking 3D-view button in 
the default string. 
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Setting beam properties  

CAE Fidesys  supports beam elements BEAM.  

To specify beam cross section using geometric features and 
moments of inertia, go to Mode – Blocks, Entity – Beam 
parameters.  

On the appeared Panel, specify: 

 Block ID;  

 CS Rotation Angle; 

 cross section profile and the appropriate dimensions to it. 

Click Apply. 

CAE Fidesys  supports beam cross section of the following types: 

 Rectangle; 

 Ellipse; 

 I-Beam; 

 Channel; 

 Corner; 

 T-Beam; 

 Z-Beam; 

 Hollow Rectangle; 

 Trough profile; 

 Circle With Offset Hole; 

        •    setting the section using moments of inertia 

3D beam cross section view is possible in the Fidesys 
Viewer postprocessor by clicking 3D-view button in the 

default string after the calculation is complete. 
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 Specifying Sphere element properties 

 

CAE Fidesys supports point masses LUMPMASS. 

To set the properties of point mass, go to Mode - Blocks, Entity – 
Sphere element Properties. 

On the panel that appears, specify: 

 block ID; 

 mass; 

 Inertia moment. 

Click Apply. 

 

 

Set spring properties 

  

CAE Fidesys supports springs (spring elements). 

To set the properties of the spring, go to Mode - Blocks, Entity - 
Spring Properties. 

On the panel that appears, specify: 

 Block ID; 

 Spring type; 

 Values corresponding to the type of spring. 

Click Apply. 
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Setting boundary conditions  

 Types of boundary conditions  

CAE Fidesys  supports boundary conditions of the following types: 

 Force; 

 Pressure; 

 Displacement; 

 Distributed force; 

 gravity; 

 Stress; 

 Acceleration; 

 Velocity; 

 Angular velocity; 

 Coupling constraint; 

 Contact; 

 Absorbing BC; 

 Heatflux; 

 Pore pressure; 

 Directional restraint; 

 Periodic BC; 

 Radiation. 
 
To set boundary conditions, follow these steps: 

1. Select Mode— Boundary conditions on Command Panel. 

2. Select Boundary Condition Type in Entity block. 

3. Select Action — Create. Set the following parameters: 

 ID/Name (assign a new ID, enter a name using letters and/or numbers, or use the system assigned ID); 

 Entity where the boundary condition is applied (Volume, Surface, Curve, Edge, Vertex, Node, Nodeset, 
Element, Side, Sideset); 

 Entity ID(s) (point mouse cursor at the field Entity ID(s) and select the necessary entities with a mouse, 
their numbers will be entered into the field automatically. If you need to specify several entities, mark 
them holding down the Ctrl key); 

 Other parameters (Value, DOFs, etc.). 

4. Click Apply. 

Using the functionality available on Command Panel you can also 
see the list of Boundary Conditions, modify or delete the 
boundary condition you previously set. 

 

Setting initial conditions 
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Types of initial conditions 

 CAE Fidesys supports the following initial conditions 

 displacement 

 speed 

 angular velocity 

 temperature 

 pore pressure 

 initial stress (set in Materials Management) 

 

 

Time/coordinate dependency 

The time/coordinate dependency can be specified separately for each type of boundary conditions using tabular 
and formulaic dependencies.  

The boundary conditions are set in advance (Mode – Boundary Conditions)..  

 

To set the formulaic dependency on Command Panel, select Mode – BC Dependency, and in the appeared form: 

 Select BC Type; 

 Select an individual component or an entire vector for time dependency application; 

 Select Dependency Type (formula can be entered manually, you can use the standard formulae for the 
time dependency); 

 Set Dependency Parameters. 

Click Apply. 

To view a tabular data or graphs plotted by a given formula, go to the corresponding tabs in the window 
BC Dependency. In addition, there is a possibility to export tabular data or to import new tables. 
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Here are standard formulae for the time dependency: 
 

 
 
 Viewing of the tabular data corresponding to the formula -100*sin(x): 
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Viewing of the graph corresponding to the formula -100*sin(x) 
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Setting contact interaction  

Contact problems are highly nonlinear and require significant computer resources to be solved. Thus, to select 
the model resulting in the most effective solution, it is very important to understand the physical content of the 
problem. Two factors determine nonlinear nature of contact problems. Firstly, the contact area and therefore 
the boundary conditions are unknown until you get the solution. Secondly, it is necessary to take friction into 
account in many contact problems. Effects related to the friction can result in poorly converging problems. 

Contact region  

To set contact areas, select the Contact dialogue (Mode - Boundary conditions, Entity - Contact) 

CAE Fidesys  implements node-surface and node-curve contact interactions. 

 

Note: if contact conditions are not specified, then the parts in the assembly do 
not interact. The interaction of assembly parts through the specified contact 
area means an obstacle to the mutual penetration of parts and the transfer of 
loads. 

It’s recommended to assign contact zones to separate surfaces in 3D and lines 
in 2D. The contact regions should be large enough so that the process of 
interaction of bodies does not outstep, but at the same time it is 
recommended to minimize these regions to save computer resources. 

Specify which of the entities will be the Master, and which - the Slave. 

 

The Master is simulated by surfaces, and the Slave - by nodes. 



 CAE Fidesys — User Guide (version 3.0) 

58 

 

When building a contact pair, you should keep in mind that the choice of Master and Slave can cause various 
results and influence  the accuracy of the solution. 

Recommendations for the selection of Master and Slave entities: 

 If one surface (A) is flat or concave, and the other surface (B) is a sharp edge or bulge, then surface A 
should be the Master. 

 If both contacting surfaces are convex, then the Master surface is assumed to be less convex. 

 If both surfaces are flat, the choice of Master and Slave entities is arbitrary. 

 If one contact surface has a sharp edge, and the other one does not have it, then the first is taken as a 
Slave surface. 

 If one of the contacting bodies is rigid, then its surface is assumed to be the Master. 

 In some cases it is useful to create a symmetrical contact. In addition, each surface is defined as the 
Master, and as a Slave. It’s possible to simulate, for example, the contact of two areas with sharp edges 
or grooved (undulating) surfaces by this methods. 

 

 

Autoselection of contact 

CAE Fidesys implements the automatic definition of contacting entities. To do this, select Autoselect in the 
drop-down list and select the corresponding entity in the Geometry panel. 

 

You will see the applied contact pairs on the left side of the screen in the objects tree. Click the name of the 
desired contact region in the Model Tree to visualize, and it will be highlighted on the model. 
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Offcet - is the distance between bodies at which contact interaction started. It can be considered as the size of a 
rigid body between the contacting bodies. 

 

Each contact pair has an individual number (ID) and a set of properties. The number of contact pairs is not 
limited. To visualize the created contact pair, click the name of the required contact pair on the left in the same 
tree of objects. The selected pair will be highlighted in yellow on the model. 
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The following contact pair settings are available in CAE Fidesys: 

 

To simulate a bonded contact, select the type of contact Tied. Then, if the contact is created, Master and Slave 
entities merge in all directions so that displacements and stresses are continuous through the contact zone. 

If the motion of a rigid body is limited only by contact conditions, it is important to ensure that the elements of 
the contact pair are in interaction in the initial state. However, in some cases, the definition of interaction can be 
difficult. This can occur in the following cases: 

 body contours can be complicated, and it is difficult to define the point at which the first contact 
will occur; 

 in spite of the fact that the geometric model is constructed without gaps, floating point errors 
arising while meshing the model can lead to the appearance of small gaps/overlaps between the 
elements. 

For the same reasons, an initial penetration of the Master entity into the Slave one can occur. In these cases, 
excessively large reactive forces may appear in the contact elements, and this may lead to a divergence of the 
solution. 

Therefore, the definition of initial contact is perhaps the most important aspect of building a model for contact 
analysis. 

Contact algorithm 

CAE Fidesys implements the following contact algorithms: 

 Penalty, 

 Multipoint Constraint (MPC). 

When selecting the Auto method, the program automatically selects one of the listed algorithms to solve the 
contact problem. 

Method of Penalties requires adjustments for both normal and tangential stiffness (see Contact pair settings). 
The main disadvantage is that the penetration between the two surfaces depends on these stiffnesses. Higher 
stiffness values can reduce penetration, but can lead to poor conditioning of the global stiffness matrix and poor 
convergence. Ideally, it is necessary to choose high enough stiffness so that the contact penetration remains 
small enough. At the same time, sufficiently low stiffnesses provide the best convergence of the problem. 

The MPC method requires non-penetration and equality of normal stresses and to apply that, the system uses 
the method of Direct elimination. This approach does not require the defining of stiffness and provides  a 
solution by one iteration (if the contact zone does not change). 

Elements Type 

CAE Fidesys computational algorithms make it possible to simulate a contact with non-conformable mesh. It 
does not require the use of any special finite elements in the contact area to denote the interaction of parts. This 
approach allows to easily set the conditions for interaction in contact or for connected surfaces. 

CAE Fidesys supports the solution of elastoplastic problems for the following types of existing finite elements: 

 Solid elements (3D); 

 Plane elements (2D). 
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Contact status 

The behavior of each contact element can be visualized in Fidesys Viewer by the Contact Status field. 

This field has one component, which has one of the following values: 

 STATUS = 0 - far; 

 STATUS = 2 - contact with slippage; 

 STATUS = 3 - without slippage (or without friction). 

 

 



 CAE Fidesys — User Guide (version 3.0) 

62 

 

Starting calculation  

Analysis types  

 

CAE Fidesys includes the following types of analysis: 

 Static (1); 

 Dynamic (transient) (2); 

 Modal (3); 

 Harmonic (4) 

 Buckling (5); 

 Composite materials effective properties calculation (6). 

 

 

When starting calculation follow these steps: 

1. Select Mode – Calculation settings on Command Panel. 

2. Select the necessary type of analysis: Static, Dynamic, Modal, or Effective properties analysis. 

3. Set the parameters of the type of analysis you chose: solver type, coordinate system, fields, scheme, time 
settings (for dynamic analysis), etc. 

4. Click Apply. 

5. Click Start Calculation. 

You may see the process of calculation in the console. It will also output the messages for the user, including the 
errors in case of unsuccessful or incorrect end of the calculation. If the system ends the calculation successfully, 
you will see the “Calculation finished successfully at <date> <time>” message in the console. 

All the calculations are made in Cartesian coordinate system by default. If necessary, you can also convert the 
results into cylindrical and spherical coordinate systems (use the appropriate filters in Fidesys Viewer). 

The dimension of the calculated problem is 2D or 3D. The following types of 2D problem are included: 

 Plane stress; 

 Plane strain. 

Stress, strain and displacement fields are calculated by default. If necessary, you can also calculate principal 
stresses, strains, and Mises stress intensity (use the appropriate filters in Fidesys Viewer). 

The following types of solvers of linear systems (systems of linear algebraic equations (SLAE)) appearing while 
discretizing the problem, are available: 

 Direct (LU) 

 Iterative. 
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The following solvers for problems of modal analysis at systems of linear algebraic equations (SLAE) are 
available: 

 Krylov- Schur; 

 Arnoldi. 

For dynamic load, one of the two calculation schemes can be used: 

 Explicit 

 Implicit. 

Types of analysis 

For the calculation, the following mechanical models are supported: 

 Elasticity; 

 Plasticity; 

 Nonlinear geometry; 

 Heat transfer; 

 Pore Fluid Transfer. 

To choose a model, the user selects the appropriate checkboxes. Selecting multiple checkboxes simultaneously 
allows setting various combinations of models. For example, the selection of the checkboxes Elasticity and 
Plasticity gives an elastoplastic model and the selection of the checkboxes Elasticity and Thermal conductivity 
gives a model of thermoelasticity. 

To improve the convergence of nonlinear problems, use the following settings: 

 

For nonlinear problems, check convergence of iterations at each loading step in the file Convergence.txt. The file 
is downloaded into the folder that is created next to the file * .pvd which stores the calculation. 

For effective performance of several calculations you can use the Results on Command Panel (see the section 
Result Analysis). 

For visualization and analysis of the obtained results you can use the program Fidesys Viewer included into the 
package. 

Multistep solution 

Setting steps for boundary conditions 

In CAE Fidesys it is possible to specify a multi-step loading through tabular dependence on time or through 
explicit assignment of steps. 
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The tabular dependency is set in the section Set time and/or coordinate BC dependency, and you should set the 
time dependency flag. Setting the load like: 

 

Time Value 

1 5 

2 0 

means a linear decrease of the value from 5 to 0. 

 

Explicit assignment of steps for boundary conditions occurs in the Load step settings window (Mode - Calculation 
settings – Static - Set load steps count). 

Enter the required number of calculation steps. To open the window of load step settings, click the icon . 

Next, specify the required settings: 

 Select the BC; 

 Click in the left column for the boundary condition for which you want to set active steps of 
calculation. 

 Set the active calculation steps for the selected boundary condition in the corresponding field. 

 Setting active steps is possible in the format: "all", "1 2 3 to 5", "1 to 5". 
Click Apply. 
 

 

 

An example of a problem using active calculation steps for boundary conditions (at each step a new movement is 
added): 
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The solution of the same problem in CAE Fidesys: 

 

 

Setting steps for blocks (volumes) 
CAE Fidesys allows you to add or remove blocks (volumes \ surfaces added to the block) at specified loading 
steps. 
 
Adding or excluding blocks in the calculation process takes place in the Setup of load steps window (Mode - 
Calculation Settings - Static / Transient / Buckling - Set load steps count). In this case, all operations occur on the 
basis of blocks, therefore for all geometric entities it is better to create a block in advance. 

Go to the Settings loading steps window. On the general solver settings panel, enter the required number of 

calculation steps and click the icon . 

Next, specify the required settings: 

 Select the Blocks; 

 Click on the block in the left column; 

 Set the active calculation steps for the selected block in the corresponding  field; 
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 Setting active steps is possible in the format: "all", "1 2 3 to 5", "1 to 5". 

Click Apply. 

 

 

 
An example of a problem with using active calculation steps for boundary conditions (at the first step, the model 
is compressed, at the second step one of the fixings is removed, a new volume is added to the deformed model, 
now two volumes are combined to compress): 

 
The solution of the same problem in CAE Fidesys: 
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Detailed examples are given below in the Step-by-Step User Guide. 

Spectral element method 

It is a unique feature of CAE Fidesys  that, in addition to the finite element method (FEM) used by default, 
enables calculations by spectral element method (SEM).  

SEM brief description and advantages 

Spectral element method (SEM) is a FEM modification where piecewise functions are used as basic functions 
consisting of high degree polynomials.  

The main advantages of SEM in comparison to FEM: 

1. High computational speed as there is no need to solve the system of linear algebraic equations due to 
diagonal form of mass matrix. The latter is obtained by specific quadrature formula for volume integration. 

2. High precision of solution approximation at coarse meshing (low number of elements). The solution error 
is estimated as  

, 

where  

 for FEM 

and  

 for SEM. 

 are constants,  is a characteristic element size,  is an element order,  is a numerical solution, 

 is an exact solution in mesh nodes. 

3. Ability of effective paralleling for OpenMP, MPI and CUDA.  

SEM is most effective for the dynamic analysis using an explicit time scheme.  

Here are the results of classical problem of wave propagation in 2D plate (size 1x1). 

To achieve the computational error 2% and less, it is necessary to generate one of the following meshes: 

a) 3-noded triangular mesh of 6 390 197 elements (characteristic element size is 4e-4); 

b) 4-noded quadrilateral mesh of 1 640 961 elements (characteristic element size is 3e-3); 

c) coarse spectral element mesh with 4th element order (only 16 elements are required). 
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Fig.1. The distribution of the field of displacement 
magnitude U across the plate  at the time t1 

 

Fig.2. The distribution of the field of displacement 
magnitude U across the plate  at the time t2 

Here are the examples of computation results for different spectral element orders: 

 

 

 

2nd spectral element order 

 

4th spectral element order 
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8th spectral element order 

 

12th spectral element order 

 

SEM Usage  

To use the method of spectral elements instead of the finite element method to solve the problem, set the order 
of elements 3 and higher (except springs and sphere elements): 

  
 



 CAE Fidesys — User Guide (version 3.0) 

70 

 

Parallel calculations on several computers using MPI technology  

If you have a network of several computers with installed СAЕ Fidesys software, MPI technology allows you to 
combine their computing capacity for parallel solution of the same problem. 

MPI brief description and advantages  

MPI technology currently represents a standard for parallel computing in distributed memory systems, i.e. those 
in which each processor has its own independent address space and communicates with the other processors via 
messages. MPI technology is more effective in solving problems with a large number of degrees of freedom 
because, on the one hand, it allows solving problems that do not fit in the computer memory and, on the other 
hand, large FEM or SEM problems require relatively low intensity of the messages exchange between the 
processors and thus they load the network connection less. This is particularly important for systems with 
distributed memory in which processors are connected by the common network with a capacity of 100 Mbit/s as 
if several computers in the office.  

MPI implementation  in CAE Fidesys 

CAE Fidesys provides the ability to use MPI with the following types of calculations:  

 Statics; 

 Dynamics; 

 Modal; 

 Buckling.  

Models to calculate via MPI: 

 Elasticity; 

 Elastoplasticity; 

 Thermal conductivity; 

 Thermoelasticity; 

 Finite deformations; 

 Pore Fluid Transfer. 

MPI installation 

Intel MPI installs and runs in conjunction with the installation of the CAE Fidesys  software package. If you 
already have the Intel MPI version on your computer and you do not want to replace it, please contact Fidesys 
customer support for instructions on how to install and configure it. 

To use the MPI when calculating, tick Use MPI in the Toolbar in the General settings of the selected calculation 
type. You will then see a special menu MPI Settings to specify needed parameters.  

In the pop-up MPI settings, select parallelization mode: 

a) Local – the calculation will be carried out on the local machine using a specified number of processors. 
The mode gives a gain in comparison to the calculations without MPI only for the local configuration 
with a large number of cores. 

b) Multiple hosts. In this mode, the system launches the calculation on several computers. 

MPI local usage  

To use MPI locally on a single computer, you need to register at first (see below). Then go to the MPI Settings 
Panel, tick Local and select the number of processors in a special window. After this, you can start the 
calculation, no additional settings for MPI local use is required.  
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MPI usage on several nodes  

Requirements for the correct operation  

1. Make sure that the firewall settings on all computers allow correct operation of MPI.  

2. We recommend to disable the firewall on all computers involved in the parallel calculations. 

3. CAE Fidesys should be installed on the same path on all computers. This path cannot be network.  

4. The path to FidesysCalc should be the same on all computers involved in the parallel calculations. 

5. The working directory (the directory where the file .pvd and file folder of the calculation results are 
written) should be available at all nodes on the same path which can be network. The user who performs 
the calculation should have access to write in  the work directory in all nodes. To find out which way is 
the working directory, you can go to the Menu Tools → Options → Paths, the string Working Directory. 
In other words, the calculation should be stored in a network folder, while the network path should be 
indicated in the save dialog: 

 

 

6. There are no special restrictions on the connection speed between the nodes but you should keep in 
mind that if the connection speed is very slow, the calculation using the MPI can take more time than the 
calculation without MPI as all the time saved will be spent on the data exchange between nodes. 

7. This software version has no limit on the number of used nodes. 

MPI setting on several nodes  

If you are sure that your system meets all the requirements given above, go to the MPI settings panel 
(Calculation Settings – Static – General – Use MPI). Put a checkbox next to the point Multiple hosts and click 
Configure…: 

 

 

You will see the following window: 
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Using Add and Delete, add to the list all the hosts you use, in the field Name write the host name in the network, 
in the field Processors indicate the number of processors used on the host. After completing the list, click Ok.  

 

After this, the number of hosts indicated in parentheses after the words Multiple hosts on the MPI settings panel 
should change: 

 

 

Now you can specify other calculation settings and run it as usual; it will be carried out using the MPI on several 
nodes. 

Registration before the first usage  

If you try to carry out the calculation using MPI for the first time, an error  window will pop up. 

To register (without this step, the calculation is impossible), click Yes. In the Windows terminal window you 
should type the login and password of the Windows user, who launches the calculation using MPI.  
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You can also register by running the Windows terminal window from the panel "Start" (to do this, type in the 
search box «cmd») and by typing the command mpiexec –register in the window. Then you need to enter login 
and password in the same way as when registering using a pop-up Fidesys window. 

If you have already registered the service, tick Do not show this message again. 

 

For more information, see the Intel MPI documentation. 

Overview of the calculation results  

The new field MPI Nodes appears in the Fidesys Viewer postprocessor after performing the calculation using 
MPI. It characterizes a partition on the specified earlier processors: 

 

 

Calculation example using MPI  

You can see an example of calculation on two computers in the picture below. Parts that are calculated on 
various computers are presented in different colors. 

 
 

Heterogeneous materials effective property calculation  

In CAE Fidesys  there is the possibility of calculating the effective properties of an heterogeneous material, for 
example, composite or porous material. 
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Geometry of the model for effective property calculation  

A representative volume is a geometric model for calculating the effective properties of the material of 
nonperiodic structures, i.e. the volume of the material by which you can judge the behavior of the material under 
deformation in general. This typically means that the size of the representative volume should be approximately 
an order of magnitude greater than the characteristic pore size or the inclusions in the material. A periodicity cell 
may be a geometric model for the calculation of the effective properties of periodic structure material. 

It is important that the geometric model for the calculation of the effective properties must always be a fragment 
of material «cut» out of it in the form of a rectangular parallelepiped. When calculating, this fragment should be 
positioned so that the edges of the parallelepiped were strictly parallel to the coordinate planes. The system 
doesn’t provide the automatic checking of the model form and position to calculate the effective properties, so 
the user ahould control this – otherwise the calculation can be correctly completed but the results will be 
misleading. 

Examples of valid models for the calculation of the effective properties are shown below. If the tested material is 
solid (left), then the model for calculating its effective properties must be a solid rectangular parallelepiped with 
edges parallel to the coordinate planes. If the material contains pores or cavities, then the model for the 
calculation must contain cavities that may come to the surface (as shown on the right).  

  

  

CAE Fidesys  can perform the generation of periodicity cell geometry of some composite materials with periodic 
structure automatically. In the geometry control mode, there is a button «Create Composite» as shown below. 

 

You can create periodicity cells of the following composite types  

 Fiber-layered (two-layer) composite; 

 single-layer fiber; 

 single-layer fiber with shells; 
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 dispersed fiber reinforced (spherical inclusions); 

 dispersed fiber reinforced with shells. 

The user needs only to set the parameters of materials and click "Create" - the geometry will be generated 
automatically by means of the CAE Fidesys  interface. The user can also create the geometry for the calculation 
manually by means of the interface or by import. The most important thing is that the geometric model for the 
calculation of the effective properties is «cut» out of the material in form of the rectangular parallelepiped with 
edges parallel to the coordinate system in the CAE Fidesys  interface. 

Starting calculation  

After creating the geometry, it is necessary to carry out the same 
actions as when calculating for static load: blocks creation, finite 
element mesh generation, material properties setting, etc, except 
for the boundary conditions application. To calculate the effective 
properties, it is unnecessary to apply the boundary conditions to 
the model: when calculating a number of boundary conditions 
types are automatically applied to the model sequentially; the 
static load problem is solved for each type; results of all the 
problems are averaged and, as a result of averaging, the effective 
properties of the material are calculated. The user only needs to 
choose the type of boundary conditions: periodic or nonperiodic. 

Periodic boundary conditions are preferred if the effective 
properties of the material of periodic structure are calculated, and 
the periodicity cell serves as a model for the calculation. For 
example, if the material is a composite with matrix and inclusions, 
moreover, the stiffness of the inclusions is much higher than the 
one of the matrix, and the inclusions are located on the surface of 
the model for the calculation – in this case it is necessary to use 
periodic conditions. If the effective properties of the material of 
irregular structure are studied and a representative volume is a 
model for the calculation, then the nonperiodic boundary 
conditions are preferred. 

In CAE Fidesys the SLAE direct solver is available to calculate the 
effective properties. 

Element types  

CAE Fidesys supports the effective properties calculation for the following existing finite elements: 

 Solid elements (3D); 

 Plane elements (2D). 

The system doesn’t support the effective properties calculation for beam and cladding elements. 

Effective property calculation and its results  

CAE Fidesys supports the calculation of such effective properties as: 

1) elastisity moduli  

2) density 

3) coefficients of thermal expansion 

4) thermal conductivity coefficients. 

     1. Effective elasticity moduli. 
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To set effective linear elastic properties calculation tick"Elasticity" in the settings for calculating effective 
properties. To calculate effective properties the model undergoes a series of strains. The following types of 
strains are used: 

 tension (along each of the coordinate axes); 

 shears (in each of the coordinate planes). 

The strain magnitude is 0.2% for all types. 

Effective properties are evaluated in the form of the generalized Hook's law: 

klijklij
C    

The result of the calculation is effective elastic modules 
ijkl

C  displayed to the command line and in the file called 

Cijkl.txt in the working directory. The modules are evaluated in the coordinate system where the calculation was 
carried out (in which coordinate planes are parallel to the edges of calculation model). 

Modules 
ijkl

C  contain 21 independent constants – it is often more than it is necessary to describe effective 

properties of the tested heterogeneous material. That is why there is a possibility of the automatic conversion of 
the obtained effective elastic modules into constants of orthotropic, transversally isotropic or isotropic material. 
After completing the calculation of the effective properties, the window «Process effective properties data» 

opens. In the window, obtained effective elastic modules 
ijkl

C  are shown at the bottom right in the form of a 

symmetric matrix sized 6x6 (the matrix part below the main diagonal is not displayed because of the symmetry). 

If the calculated effective elastic moduli are unphysical, immediately after opening the data processing window a 
message will pop up, warning that the matrix is not symmetric with sufficient accuracy or is not positive definite.  
In this case you should check again the correct choice of model for calculation:  

 if it is a rectangular parallelepiped with faces parallel to the coordinate planes  

 in the two-dimensional case, if it is a rectangle with sides parallel to the coordinate axes 

  if it is a periodicity cell in case of calculation with periodic boundary conditions. 

If the model is correct, it is necessary to improve (grind) the grid. 

When the calculation is complete, the window opens automatically. If the user closes it, it can be re-opened in 
the mode Material > Effective properties: 

 

The user can assess whether the matrix with obtained 
ijkl

C  corresponds to orthotropic materials with the 

acceptable tolerance. For the exact orthotropic material, the matrix should look as follows (where the letters X 
denote those components that can be nonzero). 
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Since the components of the matrix are the result of numerical calculation of effective properties - they tend to 
contain some errors. If, from the user's point of view, the matrix corresponds to orthotropic materials with 
acceptable tolerance, select the «Orthotropic» type of material and click «Process Data», and the system will 
calculate nine constants of orthotropic material. If the material is not orthotropic with sufficient accuracy or if 
orthotropic constants turned out to be unphysical, when you click "Process data” the system will show you a 
message with a warning. 

If orthotropic constants do not depend on the direction (i.e., for example, different Young's moduli are the same 
or differ from each other within the acceptable error) then you can select the type of material «isotropic» and 
click «Process data» again. The system will calculate two constants of an isotropic material – Young’s Modulus 
and Poisson's Ratio. If the material is not isotropic with sufficient accuracy or if Young's modulus and / or 
Poisson's ratio are unphysical, when you click "Process data” the system will show you a message with a warning. 

1. Effective density. 

Density is an additive quantity. Therefore, the effective density is calculated as the mass of the model divided by 
the effective volume (including pores and voids in the material). Density is calculated automatically for any 
calculation of effective elastic moduli. 

2. Effective coefficients of thermal expansion. 

If you tick "Elasticity" in the calculating effective properties menu and at least one material in the model has 
thermal expansion coefficients, together with the calculation of effective linear elastic properties the system will 
also perform the calculation of effective thermal expansion. To calculate the effective coefficients of thermal 
expansion the model is uniformly heated. The heating value is 1 K. Effective thermal expansion is estimated as: 

th

ij ij T    

The results of the calculation are effective coefficients of thermal expansion,which are output to the command 
line and to a JSON file called EffProps.json located in the working directory. Coefficients are calculated in that 
coordinate system, in which the calculation was carried out (to the coordinate planes / axes of which the faces / 
sides of the calculation model are parallel). 

Coefficient matrix  ij  contains 6 independent constants, often this is more than enough to describe the 

effective linear thermal expansion of the studied heterogeneous material. Therefore, it is possible to 
automatically recalculate obtained effective coefficients of linear thermal expansion into constants of an 
orthotropic or isotropic material. The window "Process data on effective properties" will appear after the 

calculation is completed. You may see the effective coefficients of thermal expansion ij  on the “Temperature” 

tab on the right in the form of a symmetric matrix of thermal expansion of size 3x3 (the part of the matrix below 
the main diagonal is not displayed due to symmetry). 

If the calculated effective thermal conductivities are unphysical, immediately after opening the data processing 

window, the system will show a warning that the matrix ij  is not symmetric with sufficient accuracy or is not 

positively definite. In this case you should check again the correct choice of model for calculation:  

 if it is a rectangular parallelepiped with faces parallel to the coordinate planes  

 in the two-dimensional case, if it is a rectangle with sides parallel to the coordinate axes 
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  if it is a periodicity cell in case of calculation with periodic boundary conditions. 

If the model is correct, it is necessary to improve (grind) the grid. 

The user can assess whether the matrix with obtained ij  corresponds to orthotropic materials with the 

acceptable tolerance. For the exact orthotropic material, the matrix should look as follows (where the letters X 
denote those components that can be nonzero). 

                                                                                                   

0 0
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 
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   

Since the components of the matrix are the result of numerical calculation of effective properties - they tend to 
contain some errors. If, from the user's point of view, the matrix corresponds to orthotropic materials with 
acceptable tolerance, select the «Orthotropic» type of material and click «Process Data», and the system will 
calculate nine constants of orthotropic material. If the material is not orthotropic with sufficient accuracy or if 
orthotropic constants turned out to be unphysical, when you click "Process data” the system will show you a 
message with a warning. 

If orthotropic constants do not depend on the direction (i.e., for example, different Young's moduli are the same 
or differ from each other within the acceptable error) then you can select the type of material «isotropic» and 
click «Process data» again. The system will calculate two constants of an isotropic material – Young’s Modulus 
and Poisson's Ratio. If the material is not isotropic with sufficient accuracy or if Young's modulus and / or 
Poisson's ratio are unphysical, when you click "Process data” the system will show you a message with a warning. 

3. Effective thermal conductivity. 

To set the calculation of the effective thermal conductivity tick “Thermal conductivity”in the settings for 
calculating the effective properties. To calculate the effective thermal conductivity coefficients, the model 
undergoes a series of heatings: the system sets different temperatures corresponding to a certain temperature 
gradient in the model on its faces. The system uses gradients directed along each coordinate axis. The effective 
thermal conductivity of the material is estimated in the form of the Fourier law of thermal conductivity:

     

                                                                                      
 i ij j

q T  
 

 

The result of the calculation is the effective thermal conductivity coefficients ij , output to the command line 

and to a JSON file with the name EffProps.json located in the working directory. The program calculates the 
coefficients in the coordinate system in which the calculation was carried out (to the coordinate planes / axes of 
which the faces / sides of the calculation model are parallel). 

The coefficient matrix ij contains 6 independent constants. Often this is more than enough to describe the 

effective linear thermal conductivity of the studied inhomogeneous material. Therefore, it is possible to 
automatically convert the obtained effective coefficients of linear thermal conductivity to the constants of an 
orthotropic or isotropic material. After the calculation is completed, the “Process data by effective properties” 

window also appears. Temperature tab, bottom right, shows effective thermal conductivity ij coefficients in the 

form of a symmetric thermal conductivity matrix of size 3x3 (a part of the matrix below the main diagonal is not 
displayed due to symmetry). 

If the calculated effective thermal conductivities are unphysical, immediately after opening the data processing 

window, the system will show a warning that the matrix ij is not symmetric with sufficient accuracy or is not 

positively definite. In this case you should check again the correct choice of model for calculation:  

 if it is a rectangular parallelepiped with faces parallel to the coordinate planes  

 in the two-dimensional case, if it is a rectangle with sides parallel to the coordinate axes 

  if it is a periodicity cell in case of calculation with periodic boundary conditions. 
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If the model is correct, it is necessary to improve (grind) the grid. 

The user can assess whether the matrix with obtained ij  corresponds to orthotropic materials with the 

acceptable tolerance. For the exact orthotropic material, the matrix should look as follows (where the letters X 
denote those components that can be nonzero). 
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Since the components of the matrix are the result of numerical calculation of effective properties - they tend to 
contain some errors. If, from the user's point of view, the matrix corresponds to orthotropic materials with 
acceptable tolerance, select the «Orthotropic» type of material and click «Process Data», and the system will 
calculate nine constants of orthotropic material. If the material is not orthotropic with sufficient accuracy or if 
orthotropic constants turned out to be unphysical, when you click "Process data” the system will show you a 
message with a warning. 

If orthotropic constants do not depend on the direction (different coefficients of thermal conductivity are the 
same or differ from each other within the acceptable error) then you can select the type of material "Isotropic" 
and click "Process Data" again. The system will calculate one constant - isotropic coefficient of linear thermal 
conductivity of the material. If the material is not isotropic with sufficient accuracy, when you click "Process 
data” the system will show you a message with a warning. 

The calculation of the effective thermal conductivity of an inhomogeneous material can be carried out separately 
or together with calculations of effective elastic properties (in the second case, in the calculation settings it is 
necessary to tick the checkboxes “Elasticity” and “Thermal conductivity”). If the thermal expansion coefficients 
of at least one material in the model are specified in the joint calculation, the effective moduli of elasticity, the 
effective coefficients of thermal expansion, and the effective coefficients of thermal conductivity will be 
calculated. In the window for processing results, both thermal conductivity coefficients and thermal expansion 
coefficients are located on the “Temperature” tab. 
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Processing Results and Exporting Effective Material 

The picture below shows the window exterior «Process effective properties data». 

 

If the processed material constants satisfy the user, the option to export the material into the file XML is 
available in the same window. You need to select a name for the effective material and the name of the XML file 
into which it will be exported. When you click «Export Material», the system first creates the material with the 
name entered and with the obtained effective properties. Then all materials created during the calculation are 
exported to an XML file with the entered name. You can import these materials from the created file. 
If a heterogeneous material, the efficient properties of which are investigated, is orthotropic or isotropic for 
empirical reasons and the calculation results do not correspond to that – you should try to refine the mesh or to 
choose a model for calculation differently. 
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SEG-Y format 
SEG-Y is a sequential trail format designed for storing fully or partially processed seismic data. 

https://en.wikipedia.org/wiki/SEG-Y 
 
To record the selected calculation results in the SEG-Y format, it is necessary to place the Receivers on the model 
in the preprocessor (Command Panel, Mode - Receivers, Operation - Create).  

 
 

Select from the drop-down list the geometric entities that will be receivers. 
 

 
 
Specify which data fields to save in SEG-Y format. 
 

 
 
Installed receiver lines are displayed in the Tree on the left in the Results Settings section. 

https://en.wikipedia.org/wiki/SEG-Y
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Viewing data in SEG-Y format is possible in the CAE Fidesys Viewer postprocessor, and you need to open the file 
with the .sgy extension. 
 

 
In Fidesys Viewer it is possible to select the required subregions of the model using the Slice / Clip filters (Menu - 
Filters - Alphabetical Index - Slice) 
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An example of the resulting SEG-Y file for Vy speed in CAE Fidesys: 

 
Features of writing data to the * .sgy file 

 

 All data in the file header, with the exception of the results themselves, are written in integer form. 

 The time step (recording step) is recorded in microseconds. 

 The coordinates of the receiver are recorded in meters (If the distance between receivers is less 
than one meter, then the coordinates of the paths may coincide, and the wave pattern may be 
incorrect). 

 Inline number coincides with the id of the node in which it is specified, the Crossline number 
matches the line number of the receivers. 
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The spectral method for solving linear dynamic problems using the response 
spectrum (response spectrum, reaction spectrum) 

Modal Analysis 

Calculation using the response spectrum is based on modal analysis. Before starting the calculation of natural 
frequencies and vibration modes, go to the tab Calculation settings – Modal Frequency analysis - Output field 
and check the Evaluate effective masses. 

.  

Next, start the calculation and go to Fidesys Viewer. 

Response Spectrum Setting 

The response spectrum is set in the Fidesys Viewer program. In the main menu, go to Filters - Index – Modal 
Combinations. 

The following settings are available in the appeared window of properties of calculation results: 

1. The choice of the combination method of the mods Absolute sum, Square root of sum of squares, 
Complete quadratic combination; 
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2. Setting the value of the modal damping coefficient Mode Damping Ratio; 

3. The way to set the response spectrum of the Dependency Type (CSV File - assignment via the csv format 
table, Formula - assignment through the formula); 

If you select CSV File in step 3, then CSV File - the path of the csv file is selected; if you select Formula in step 3, 
then Calc Function is the task of the function in which the argument is the natural frequency; 

Field Info spectral curve selection - displacement, speed, acceleration. 

 

After all the settings, click Apply. 

Further, it is possible to open the necessary result plots (for 
example, displacements obtained by the SRSS method will be 
available under the name Displacement_SRSS). 
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Results Visualization and Postprocessing 

About Fidesys Viewer software 

The Fidesys Viewer software is used for visualization and analysis of the obtained results: 

 Visualization of vector and tensor fields; 

 Graph; 

 Time dependency analysis; 

 SEG-Y files. 

You don’t need to install Fidesys Viewer individually as it is included into the CAE Fidesys  package.You don’t 
need a license to use Fidesys Viewer: the results of calculations obtained by using the CAE Fidesys  preprocessor 
are available for viewing in Fidesys Viewer even after the license expires. 

Main Window 

 

Workbench (1) displays the model and visual effects. 

Main Menu (2) includes standard operations for working with files and projects, managing the visualization 
modes, panel display settings, filters, tools, and help available in the drop-down lists of the menu. 

Toolbar (3) comprises the buttons for calling the most frequently used commands while working with the 
program. 

Pipeline Browser (4) includes the opened models and filters applied to them. 

Properties Page (5) displays the properties of the selected object in the Workbench or in the Pipeline Browser. 

You can show or hide additional panels in the menu View. 

Basics of the program 

Fidesys Viewer allows you to view and analyze the results. You can do that using multiple filters selected in the 
item View in the menu. Some of them are described below. 
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Display on the data field and legend model  

Fields and components of display can be selected in the Toolbar: 

 

You can also see the Color Map by clicking in the Toolbar. 

Selection  

In order to select points or cells, use the following buttons in the Toolbar: 

 
On-screen information display  

Numerical results for the data fields can be viewed in the tab Information. If the entire model is in focus, the 
fields of the tab Information contain a range of data – from minimum to maximum value. 

The values in points can be found using the filter Probe Location (Filters →  Alphabetical →  Probe Location). 
Then you need to specify the viewing point coordinates. After applying the filter, data field values are displayed 
only for the specified point in the tab Information. 

It is also possible to view the numerical results for the selected points by clicking Point Information on 
the Toolbar.  

The values in the points/nodes/elements can be identified and viewed by using Selection Inspector (View 
→Selection Inspector).  

 

Overview of the strained model  

To view the strained model, select Filters →  Alphabetical →  Warp By Vector. In the Properties tab, you can 
select the display scale. 

To quickly access the filter, click Warp By Vector  on the top panel. 

 

Spherical/cylindrical coordinate systems  

To receive data from the spherical or cylindrical coordinate systems, select Filters →   Alphabetical → 
Coordinate systems. Next, select the data field that you want to represent in new coordinates. After applying 
the filter, a new data field will appear in the tab Information, for example, Stress (spher.). 

 

Graphing along straight line  

To graph along a straight line, select Filters →   Alphabetical → Graph along a straight line.  

Specify coordinates of the beginning and end of the line. In the tab View, select the appropriate data field to 
display in the graph. 

 

Graphing along curves  

To graph along a curve, select nodes (see par. Selection) for which graph will be plotted. Next, use Filters →   
Alphabetical → Extract selected and then Filters →   Alphabetical → Show data.  

Graphing in time dependency  

To plot a time dependency graph, you should allocate points of interest through the Allocation Inspector or by 
the button Select points in the standard string and then apply the filter Filters →   Alphabetical → Plot 
selection over time. 
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Estimation of the mesh quality  

To estimate the mesh quality, select View → Filters → Alphabetical → Mesh Quality. Specify the necessary 
settings in the tab Properties. After applying the filter, new fields will appear based on the analysis of which we 
can draw conclusions about the quality of the resulting mesh.  

 

Slice 

To view the model slice, select Filters → Alphabetical → Slice. Specify the normal or the direction in which you 
want to make the slice.  

 

Cross section  

To view the model cross section, select Filters → Alphabetical → Cross section. Specify the normal or the 
direction in which you want to make the slice.  

 

Beam and shell 3D-display  

To view beams and shells in 3D in the Fidesys Viewer postprocessor, you can click on the button 3D in 
the standard string. 

 

Margin of Safety 

To view the model cross section, select Filters → Alphabetical → Margin Of Safety. If the ultimate strength and 
yield strength were not specified when preprocessing, you should set them in the tab Properties. Margin of 
safety is calculated by the first theory of strength, energy theory, Tresca theory, Mohr’s theory of failure, 
Pisarenko-Lebedev theory. Obtained values can be viewed in the tab Information in the new field Margin Of 
Safety. The first component of the field is the margin of safety by the first theory of strength; the second is the 
margin of safety by the energy theory, etc. 

Formulas for Strength Criteria 

             σt —  uniaxial tensile strength; 

σc — uniaxial compression strength; 

σm — tension von Mises; 

c — soil cohesion; 

φ — angle of friction; 

σ1 — first major stress; 

σ2 — second major stress; 

σ3 — third major stress; 

n — the field of the margin of safety that needs to be displayed. 

1. Calculation according to the first theory of strength. 

It is used in the assumption of brittle fracture. By contours σ1 contours of safety factors are built n = σt / σ1 

2. Calculation according to the energy theory of strength (Mises stress). 

It is used in the assumption of viscous fracture or if plastic state is not allowed. 

By contours σi isolines of safety factors are built  n = σy / σm or n = σ0,2 / σm, where σy or σ0,2 – physical or conditional 

yield strength. 

3. Calculation according to the Pisarenko-Lebedev theory. 
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It is used in mixed fracture. 

By fields σm and σ1 contours of safety factors are built  

, where 

 

4. Calculation according to the Mohr’s theory, mixed destruction. 

Contours of the margin of safety 

 

5. The third theory of strength by Tresk, viscous destruction or prevention of plastic flow. 

A special case from Mohr's theory for 

 

6. Mohr-Coulomb Criterion 

 - normal stress on the fracture plane 

A = c; B = - tanφ 

or 

If strength limits are specified σc and σt , then 

 

where 

a = σt + σc; 

b = σt - σc < 0 (with b > 0 the angle of internal friction becomes negative, which is unacceptable) 

Margin of safety: 

 

7. Mogi-Coulomb Criterion 
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or 

 

Safety factor 

 

8. Drucker-Prager criterion 

 

or 

 

Safety margin: 

 

This criterion was developed to describe the plastic deformation of clay soils. You can also use it to describe the 

destruction of rocky soils, concrete, polymers, foam and other pressure-dependent materials. 

 

9. Navier criterion 

Another name for the Mohr-Coulomb criterion 
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 - the normal stress at failure; 

A = c; B = - tanφ; 

The minus is due to the fact that compression should lead to hardening, and compression σn corresponds to 

negative values c = - τB - tensile strength (shear), which is entered by the user for each material, or cohesion; 
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Harmonic analysis 

To plot the frequency dependencies after performing a calculation using harmonic analysis, select Filters → 
Index → Harmonic Analysis. Specify the node number, the characteristics of which will be presented on the 
graph. 

 

Data saving 

To get numerical values of the obtained results, save the data in .csv format. To do it Click Ctrl+S or select File → 
Save. The saved file is an ordinary table of numerical data which can be opened in any text editor.  

For dynamic problems, saving the model variation under deformation is available. To do it Select File → Save 
Animation. 
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Step-by-Step User Guide 

Solving any problem using  CAE FIDESYS package includes 6 basic steps: 

 Model generating 

 Meshing 

 Setting boundary conditions 

 Setting the material 

 Starting calculation 

 Results analysis 

 See some examples with step-by-step guide below. 

Static analysis (3D) 

NAFEMS test “Thick Plate Pressure”, Test No LE10, Date/Issue 1990-06-15/2. 

The problem of static load of a plate is being solved.  

The pictures below represent a geometric model of the problem: 

  

Displacements along the normal to the sides are constrained in the side slices of the plate. All of the points of the 
outer curvilinear surface are fixed in the XY plane. The outer curvilinear surface is fixed along the middle line of 

displacements along Z axis. The pressure to the upper side is 1 MPa. The material parameters are E = 210 hPa,  = 
0.3. 

Test pass criterion is the following: stress σyy at the point D is -5.38MPa to within 3%. 

 



 CAE Fidesys — User Guide (version 3.0) 

94 

 

 

Geometry creation 

1. Create the first elliptic cylinder. 

Select volume geometry generation section on Command Panel (Mode 
— Geometry, Entity — Volume, Action — Create). Select Cylinder in 
the list of geometric elements. Specify the cylinder dimensions:  

 Height: 0.6 

 Cross section: Elliptical 

 Major Radius: 2 

 Minor Radius: 1 

Click Apply.  

2. Create the second elliptic cylinder.  

Select volume geometry generation section on Command Panel (Mode 
— Geometry, Entity — Volume, Action — Create). Select Cylinder in 
the list of geometric elements. Specify the cylinder dimensions:  

 Height: 0.6; 

 Cross section: Elliptical; 

 Major Radius: 3.25; 

 Minor Radius: 2.75. 

Click Apply.  

As a result, two generated entities are displayed in the Model Tree 
(Volume 1 and Volume 2): 

3. Subtract the first cylinder from the second one .  

Select volume geometry generation section on Command Panel 
(Mode — Geometry, Entity — Volume, Action — Boolean). Select 
Subtract in the list of operations. Set the following parameters: 

 A Volume ID(s): 1 (the volumes to be subtracted); 

 B Volume ID(s): 2 (volumes from which other volumes will 
be subtracted); 

 Imprint. 

Click Apply. 

 

 

As a result, only one volume is displayed in the Model Tree (Volume 2). 

 

4. Leave a quarter of a volume (symmetry of the problem). 

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action 
— Webcut). Select Coordinate Plane in the list of possible webcut types. Set the following parameters:  

 Volume ID(s): 2 (the volume to be webcut); 
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 Webcut with: YZ Plane; 

 Offset value: 0; 

Click Apply. 

 

Do the same for the ZX Plane: 

 Volume ID(s): 2 (the volume to be webcut); 

 Webcut with: ZX Plane; 

 Offset value: 0; 

Click Apply. 

 

 

 

 

 

 

 

 

As a result, the original volume in the Model Tree is split into three (Volume 2, Volume 3 and Volume 4). 

 

  

Delete the volumes 2 and 3. To do this, select these volumes in the Model Tree holding down Ctrl and click 
Delete in contextual menu. As a result, a quarter of the original volume is left (Volume 4). 
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5. Split the outer curvilinear surface into two (it is necessary for restraining 
this surface from displacements along the middle line).  

Select surface geometry modification section on Command Panel (Mode — 
Geometry, Entity — Volume, Action — Webcut). Set the following 
parameters: 

 Coordinate plane; 

 Volume ID(s): 4 (volume to be cut); 

 Plane: XY; 

 Offset value: 0; 

 Put a checkmark in the Merge box. 

Click Apply. 

 

The result will be two volumes 4 and 5 glued to each other along the section plane: 

 

Meshing  

1. Select meshing on curves section on Command Panel (Mode — Mesh, 
Entity — Curve, Action — Mesh). Specify the parameters of mesh 
refinement: 

 Select Curves: 43 44 45 46 (using space after each curve); 

 Select the way of meshing: Equal; 

 Select the checkbox Interval; 

 Specify the number of intervals: 6 

Click Apply. Click Mesh. 

 

Select meshing on curves section on Command Panel (Mode — Mesh, Entity 
— Curve, Action — Mesh). 

 Select Curves: 12 14 39 41 (using space after each curve); 

 Select the way of meshing: Equal; 

 Select the checkbox Interval; 
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 Specify the number of intervals: 4. 

Click Apply. Click Apply Scheme 

On the command panel, select the mesh generation mode on 
the curves (Mode - Mesh, Entity - Curve, Action –Mesh) 

• Select Curves: 51 53 61 62 (through spaces); 

• Settings for Curve: Equal; 

• Set the Interval flag; 

• Indicate the number of interval: 1; 

Click Apply Size. 

Click Mesh. 

  

2. Select volume mesh generation section on Command Panel (Mode — Mesh, Entity — Volume, Action — 
Mesh). 

 Select Volumes: 4 5  (or by the command all); 

 Select Meshing Scheme: Map. 

Click Apply Scheme.  

Click Mesh. 

  

 

The resulting number of elements can be viewed in the Property Page by clicking on the inscription Volume 4 in 
the Model Tree on the left.  

To view the mesh properties, you can follow these steps: 

• Select the entire model  

• Right-click  the model 
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• In the pop-up menu, select List Information – List Mesh Info  

• Information on the mesh will be displayed in Command Line  
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Setting boundary conditions 

1. Fix one side (slice) along X axis. 

Select Mode — Boundary Conditions, Entity — Displacement, Action — Create on Command Panel. Set the 
following parameters: 

 System Assigned ID 

 Entity List: Surface 

 Entity ID(s): 33 40; 

 Degrees of Freedom: X-Translation 

 DOF Value: 0 

Click Apply. 

 

2. Fix one side (slice) along Y axis. 

Select Mode — Boundary Conditions, Entity — Displacement, Action — Create on Command Panel. Set the 
following parameters: 

 System Assigned ID 

 Entity List: Surface 

 Entity ID(s):  35 39; 

 Degrees of Freedom: Y -Translation 

 DOF Value: 0 

Click Apply.  

3. Fix the outer curvilinear surface along X and Y axes. 

Select Mode — Boundary Conditions, Entity — Displacement, Action — Create on Command Panel. Set the 
following parameters: 
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 System Assigned ID 

 Entity List: Surface 

 Entity ID(s):  36 38; 

 Degrees of Freedom: x-Translation and y-Translation 

 DOF Value: 0 

 Click Apply. 

 

4. Fix the middle line of the outer curvilinear side along Z axis. 

Select Mode — Boundary Conditions, Entity — Displacement, Action — Create on Command Panel. Set the 
following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s):  50; 

 Degrees of Freedom: z-Translation; 

 DOF Value: 0. 

Click Apply. 

 

5. Apply pressure to the upper side. 

Select Mode – Boundary Conditions, Entity – Pressure, Action – Create. Set the following parameters: 

 System Assigned ID 

 Entity List: Surface 

 Entity ID(s): 31 
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 Magnitude Value: 1e6 (an exponential number format using the Latin letter“e” is supported ) 

Click Apply. 

 

All applied boundary conditions should be displayed in the Model Tree on the left. In addition, the boundary 
conditions are available for editing from the Model Tree. 

To view all the applied boundary conditions also click Show BC on the top panel.  
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Setting material and element type 

1. Create the material.  

Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Block, Action — Set 
Material).  

 In the Materials Management window that opens, in the second 
column, double-click the caption. Enter the name of the material and 
write “Material 1”. Press the ENTER key. 

Next, using the “drag & drop” method, add the necessary 
characteristics from the left column to the Material Properties column. 

In the left column, select Elasticity - Hooke Material. Select with the 
mouse the characteristic Young's modulus. Hold down the left mouse 
button and drag the label to Material Properties. Double-click in the 
Value field opposite the Young Module and enter the number 210e9. 

Similarly, from the Hooke Material section add the Poisson Ratio 0.3. 

Click OK. 
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2. Create a block of one type of the material.  

Select setting the material properties section on Command Panel (Mode — 
Blocks, Entity — Block, Action — Add). Set the following parameters: 

 Block ID: 1; 

 Entity list: Volume;  

 Entity ID(s): 4 5 (or by the command all). 

Click Apply. 
 

 
 
 
 
 

3. Assign the material to the block.  

On the command panel, select the mode for setting material properties 
(Mode - Blocks, Entity - Block, Action - Set Material). Set the following 
parameters: 

 Block ID (s): 1; 

 Available materials: Material 1. 

Click  Apply. 
 
 
 
 
 
 
 

4. Assign the element type.  

Select material properties setting section on Command Panel (Mode — 
Blocks, Entity — Block, Action — Element Types). Set the following 
parameters:  

 Block ID(s): 1; 

 Category: Solid; 

 Order: 1. 

Click Apply. 
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Starting calculation  

1.  Set the type of the problem to be solved.  

Select calculation settings section on Command Panel (Mode — Calculation 
settings, Calculation settings — Static, Static — General). Select: 

 Dimension: 3D; 

 Model: Elasticity.  

Click Apply. 

2. Set the solver settings. 

Select calculation setting section on Command Panel (Mode — Calculation 
settings, Calculation settings — Static, Static — Solver). Select the solver 
method (direct or iterative) and set Convergence Parameters in case of 
choosing an iterative one. You can also leave all the settings by default.  

Click Apply.  

Click Start Calculation.  

3. In a pop-up window select a folder to save the result and enter the file 
name. 

4. If the calculation is finished successfully, you will see a message in the 
Console: “Calculation finished successfully at <date> <time>”.  

Results analysis  

1. Open the file with the results. There are three ways to do this. 

 Press Ctrl+E.  

 Select Results in the Main Menu. Click Open last result. 

 Select Results on Command Panel (Mode – Results). Click Open 
Results.  

 

 

 

 

2. Display the component yy of the stress field and the mesh on the 
model. 

In Fidesys Viewer window set the following parameters on the Toolbar: 

 Representation Mode: Surface; 

 Representation Field: Stress; 

 Representation Component: YY. 

 Surface with edges. 

 

3. Select a point where you need to view the stress. 

Select a point on the model by using Select Points Through.  
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Select a point D on the upper side. From the main menu, 
select View – Allocation Inspector. 

In Allocation Inspector, go to the tab Point Tag and select 
and click on the Stress line in the drop-down list. 

As a result, Stress components at the point D are displayed at 
the picture. 

 

 

 

 

 

4. View the numerical value σyy at the selected point D. 

The difference between the obtained value -5.266e+06 and the required one -5.380e+06 is 2.12%. 

5. Download numerical data. 

Select File → Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. 
Click ОК. The saved file is an ordinary table of numerical data which can be opened in any text editor. 

6. You can see the way the body is deformed under the applied pressure. 

To do this select the filter Warp By Vector. Set the following parameters in the tab Properties: set the value to 
5000 in the field Scale Factor. 
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As a result, the deformed body is displayed in the picture. To see the original model, click near it in the Model 
Tree. The picture below shows the deformed (solid grey filling) and the original model (with the field of 
displacements distribution along Y axis). 

 

Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface. 
The following program code allows performing the steps of the above-described guide you only need to 
manually specify the full path and name of the file to be saved. 
 

reset 
create Cylinder height 0.6 major radius 2 minor radius 1  
create Cylinder height 0.6 major radius 3.25 minor radius 2.75  
subtract volume 1 from volume 2  
webcut volume 2 with plane xplane offset 0  
webcut volume 2 with plane yplane offset 0  
delete Body 2 3 
webcut volume 4 with plane zplane offset 0 merge 
curve 43 44 45 46 scheme equal 
curve 43 44 45 46 interval 6 
mesh curve 46 44 45 43 
curve 12 14 39 41 scheme equal 
curve 12 14 39 41 interval 4 
mesh curve 12 14 39 41 
curve 51 53 61 62 scheme equal 
curve 51 53 61 62 interval 1 
mesh curve 51 53 61 62 
volume 4 5 scheme map 



 CAE Fidesys — User Guide (version 3.0) 

107 

 

mesh volume 4 5 
list Volume 4 mesh 
create displacement on surface 33 40 dof 1 fix 0 
create displacement on surface 35 39 dof 2 fix 0 
create displacement on surface 36 38 dof 1 dof 2 fix 0 
create displacement on curve 50 dof 3 fix 0 
create pressure on surface 31 magnitude 1e6  
create material 1 
modify material 1 name 'Material 1' 
modify material 1 set property 'MODULUS' value 2.1e+11 
modify material 1 set property 'POISSON' value 0.3 
block 1 add volume 4 5 
block 1 material 1 
block 1 element solid order 1 
analysis type static elasticity dim3 
calculation start path 'D:/Fidesys/example.pvd' 
 

 It is also possible to run the file Example_1_Static_3D.jou by selecting Journal Editor on Toolbar. In a 
pop-up window of the main menu select File → Open and open the necessary journal file. 
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Static load (gravity force) 

R.J. Roark, Formulas for Stress and Strain, 4th Edition? McGraw-Hill Book Co., Inc., New York, NY, 1965, pg 112, no. 
33  

The problem of the tube bending of under gravity force is to be solved. The pictures below represent a geometric 
model of the problem: 

  

 

The side edges are rigidly fixed on all displacements and rotations. Material parameters are E = 30e6 psi,     = 

0.0, =0.00073 lb-sec2/in4. The gravity force is defined via the acceleration g=386 in/sec2. The geometrical 
dimensions of the model: L=200 in, d0=2 in, di=1 in. 

Due to the symmetry of the problem, half tube will now be considered (L/2). 

 

 

Test pass criterion is the following: displacement in the center of the tube uyy at the point D (0, d0/2, 0) is -0.12529 
within 3%.  
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Geometry creation 

1. Create the first circular cylinder. 

Select volume geometry generation section on Command Panel (Mode 
— Geometry, Entity — Volume, Action — Create). Select Cylinder in 
the list of geometric elements. Specify the cylinder dimensions:  

 Height: 100; 

 Cross section: Circular; 

 Radius: 1; 

Click Apply. 

 

 

 

 

 

 

 

 

2. Create the second cylinder.  

Select volume geometry generation section on Command 
Panel (Mode — Geometry, Entity — Volume, Action — Create). 
Select Cylinder in the list of geometric elements. Specify the 
cylinder dimensions:  

 Height: 100; 

 Cross section: Circular; 

 Radius: 0.5; 

Click Apply. 

As a result, two generated entities are displayed in the Model 
Tree (Volume 1 and Volume 2).
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3. Subtract the first cylinder from the second one.  

Select volume geometry generation section on Command Panel (Mode — 
Geometry, Entity — Volume, Action — Boolean). Select Subtract in the 
list of operations. Set the following parameters: 

 A Volume ID(s): 1 (the volumes to be subtracted); 

 B Volume ID(s): 2 (volumes from which other volumes will be 
subtracted). 

Click Apply. 

As a result, only one volume is displayed in the Model Tree (Volume 1). 

 

 

 

 

 

 

 

 

 

 

 

4. Place the volume to the coordinate origin.  

Select volume geometry generation section on Command Panel 
(Mode — Geometry, Entity — Volume, Action — Transform). Select 
Move from the list of possible types of slices. Set the following 
parameters:  

 Volumes ID(s): 1 (the volume to be cut); 

 Checkbox Distance; 

 Z Distance: 50; 

Click Apply. 

Thus, the center of the left end of the tube is placed in the origin of 
coordinates.  



 CAE Fidesys — User Guide (version 3.0) 

111 

 

 

Meshing  

1. Set the approximate size of the elements. 

Select volume mesh generation section on Command Panel (Mode — 
Mesh, Entity — Volume, Action — Intervals). Specify the approximate 
size of the elements: 

 Select volumes: 1; 

 Select Approximate size from the drop-down list; 

 Approximate size: 0.25; 

Click Apply Size. 

 

2. Select the way of mesh generation. 

Select volume mesh generation section on Command Panel (Mode — 
Mesh, Entity — Volume, Action —Mesh). 

 Select volumes: 1; 

 Select meshing scheme: Polyhedron 

Click Apply Size. Click Mesh. 
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The resulting number of elements can be found on the property page by clicking on Volume 1 in the Model Tree 
on the left.  

To view the mesh properties, you can follow these steps: 

 Select the entire model  

 Right-click on the model 

 In the pop-up menu, select List Information – List Mesh Info  

 Information on the mesh will be displayed in Command Line  

 

Setting boundary conditions  

1. Fix the right lateral edge at all directions. 

Select Mode — Boundary Conditions, Entity — Displacement, Action — Create 
on Command Panel. Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s):  8; 

 Degrees of Freedom: All; 

 DOF Value: 0. 

 Click Apply. 

 

2. Fix the left lateral edge along X and Z axes by analogy. 

Select Mode — Boundary Conditions, Entity — Displacement, Action — Create 
on Command Panel. Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s):  9; 

 Degrees of Freedom: X-Translation Disp, Z-Translation Disp; 

 DOF Value: 0. 

Click Apply. 
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3. Set the gravity force.  

Select  Mode — Boundary Conditions, Entity — Gravity, Action — Create on 
Command Panel. Set the following parameters: 

 Global; 

 Directions: Y; 

 Value: -386. 

 Click Apply. 

 

 

Setting material and element type  

1. Create the material.  

Select setting the material properties section on Command Panel (Mode —
Material, Entity — Materials management).  

In the Materials Management window that opens, in the second column, click 
on the caption Enter the name of the material and write “Material 1”. Press the 
ENTER key. 

In the left column, select Elasticity - Hooke Material. Select with the mouse the 
characteristic Young's modulus. Hold down the left mouse button and drag the 
label to Material Properties. Double-click in the Value field next to Young’s 
modulus and enter the number 30e6.  

Similarly, from the Hooke Material section add the Poisson Ratio 0.3 ; from the section General add Density: 
0.00073. 

Click Apply. 
 

 

2. Create the block of one material type.  

Select setting the material properties section on Command Panel (Mode — 
Blocks, Entity — Block, Action — Add). Set the following parameters: 

 Block ID: 1;  

 Entity list:: Volume; 

 Entity ID(s): 1 (or by the command all). 

Click Apply. 
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3. Assign the material to the block.  

Select setting the material properties section on Command Panel (Mode — 
Blocks, Entity — Block, Action — Set material). Set the following parameters: 

 Block ID(s): 1;  

 Select the previously created material in the list: Material 1. 

Click Apply. 

 
 
 
 
 
 
 
 
 
 
 
 

4. Assign the element type to the block.  

Select setting the material properties section on Command Panel (Mode — 
Blocks, Entity — Block, Action — Element Types). Set the following 
parameters:  

 Block ID(s): 1; 

 Category: Solid; 

 Order: 1 

Click Apply. 
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Starting calculation 

1. Set the type of the problem to be solved.  

Select calculation setting section on Command Panel (Mode — Calculation 
settings, Calculation settings — Static, Static — General). Select: 

 Dimension: 3D; 

 Model: Elasticity.  

Click Apply. 

In a pop-up window select a folder to save the result and enter the file name. 

If the calculation is finished successfully, you will see a message in the 
Console: “Calculation finished successfully at <date> <time>”.  

 
 
 
 
 
 
 
 
 
 
 

Results analysis  

1. Open the file with the results. There are three ways to do this. 

 Click Ctrl+E. 

 Select Calculation → Open Results in the Main Menu. Click 
Open last result. 

 Select Results on Command Panel (Mode — Results). Click  
Open Results.  

To apply all of the filters changes automatically in Fidesys Viewer, 
click Apply changes to parameters automatically on Command 

Panel. 

2. Display the Uyy component of the displacement field on the model. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 Representation Mode: Surface; 

 Representation Field: Displacement; 

 Representation Component: Y. 

 Surface. 

 

After applying the settings, you will see the following picture: 
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3. Check the maximum value Uyy at the selected point D.  

In the picture, it is the maximum in modulus Displacement (blue). It corresponds to -0.127222 in the color legend. 

The difference between the resulting value -0.1254 and the required -0.12524 is 0.13%. 

  

4. Download numerical data. 

Select File → Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. 
Click  ОК. The saved file is an ordinary table of numerical data which can be opened in any text editor. 

5. You can see the way the body is deformed under the applied pressure. 

To do this select Filters → Alpabatical → Warp By Vector. Set the following parameters in the tab Properties::  

 Vectors: Displacement; 

 Scale Factor: 100. 

As a result, the deformed body is displayed at the picture. To see the original model, click the button near the 
model in the Model Tree. The picture below shows the deformed (solid grey filling) and the original model (with 
the field of displacements distribution along Y axis).  
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Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface. 
The following program code allows performing the steps of the above-described guide, you only need to 
manually specify the full path and name of the file to be saved. 

 
reset 
create Cylinder height 100 radius 1  
create Cylinder height 100 radius 0.5  
subtract volume 2 from volume 1  
volume 1 size 0.25 
volume 1 scheme sweep  
mesh volume 1 
list volume 1 mesh 
create displacement on surface 8 dof all fix 0  
create displacement on surface 9 dof 1 dof 3 fix 0  
create gravity global 
modify gravity 1 dof 2 value -386 
create material 1 
modify material 1 name 'Material1' 
modify material 1 set property 'POISSON' value 0 
modify material 1 set property 'MODULUS' value 3e+7 
modify material 1 set property 'DENSITY' value 0.00073 
block 1 add volume 1  
block 1 material 1 
block 1 element solid order 2 
analysis type static elasticity dim3 
calculation start path "D:/Fidesys/calc/example.pvd 
 

It is also possible to run the file Example_2_Static_3D.jou by selecting Journal Editor on Toolbar. In a 
pop-up window of the main menu select File → Open and open the necessary journal file. 
 

 

Static load (beam model, reaction forces)  
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S.H. Crandall, N.C. Dahl, An Introduction to the Mechanics of Solids, McGraw-Hill Book Co., Inc., New York, NY, 
1959, pg. 389, ex. 8.9 

 

The problem of static load of a square section beam is being solved. The picture represents a geometric model of 
the problem: a = 50 In, beam section 1 x 1 in. The boundary conditions are presented in the picture; the force 

applied at the point B is Fy = -1000 lb. The material parameters are E = 30e6 psi ,  = 0.3. 

Test pass criterion is the following: reaction force RA at the point A (0,0,0) is 
148.15 lb, reaction moment at the point C is 27778 in-lb within 1.5%. 

Geometry creation 

1. Create a straight line 100 in length (segment AB).  

Select volume geometry generation section on Command Panel (Mode — 
Geometry, Entity — Curve, Action — Create). Select Line in the list of 
geometric elements. Create it using Location and Direction. Set the 
following parameters:  

 Location: 0 0 0 (line origin); 

 Direction: 1 0 0 (along Х axis);  

 Length: 100; 

Click Apply. 

2. Create a straight line 50 in length (segment BC).  

Select volume geometry generation section on Command Panel (Mode — 
Geometry, Entity — Curve, Action — Create). Select Line in the list of 
geometric elements. Create it using Location and Direction. Set the 
following parameters:  

 Location: 100 0 0 (line origin); 

 Direction: 1 0 0 (along Х axis); 

 Length: 50; 

Click Apply. 

As a result, in left side of the Model Tree there are two free curves having no 
common vertices.  

 

 

 

 

3. Unite two vertices.  
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Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Vertex, Action — 
Merge). Set the following parameters:  

 Ver tex ID: 2 3 (using space after each of them); 

Click Apply. 

 

 

 

 

 

 

 

 

 

 

Meshing 

1. Select meshing on curves section on Command Panel (Mode — 
Mesh, Entity — Curve, Action — Mesh). Specify the parameters of 
mesh refinement: 

 Select Curves: all;  

 Select the way of meshing: Equal; 

 Select the meshing parameters: Interval; 

 Interval: 1. 

Click Apply Size.  

Click Mesh. 
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Setting boundary conditions 

1. Fix the point C at all directions.  

Select Mode — Boundary Conditions, Entity — Displacement, Action — 
Create on Command Panel. Set the following parameters: 

 System Assigned ID; 

 Entity List: Vertex; 

 Entity ID(s):  4; 

 Degrees of Freedom: All;  

 DOF Value: 0. 

 Click Apply.  

 

2. Fix the point A at the Y and Z displacement.  

Select Mode — Boundary Conditions, Entity — Displacement, Action — 
Create on Command Panel. Set the following parameters: 

 System Assigned ID; 

 Entity List: Vertex; 

 Entity ID(s):  1; 

 Degrees of Freedom: Y-Translation Disp, Z-Translation Disp; 

 DOF Value: 0.  

 Click Apply.  
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3. Apply force at the point B.  

Select Mode — Boundary Conditions, Entity —Force, Action — 
Create on Command Panel. Set the following parameters: 

 System Assigned ID; 

 Entity List: Vertex;  

 Entity ID(s):  2; 

 Force: 1000; 

 Click  Direction 0 -1 0. 

Click Apply. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Setting material and element type 

1. Create the material.  

Select setting the material properties section on Command Panel 
(Mode — Material, Entity — Materials Management).  

In the Materials Management window that opens, in the second 
column, click on the caption Enter the name of the material and 
write “Material 1”. Press the ENTER key. 

In the left column, select Elasticity - Hooke Material. Select with 
the mouse the characteristic Young's modulus. Hold down the left mouse button and drag the label to Material 
Properties. Double-click in the Value field next to Young’s modulus and enter the number 30e6.Similarly, from 
the Hooke Material section add the Poisson Ratio 0.3;  

Click Apply. 
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2. Create the block of one type of the material.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Block, Action — Add). Set the following 
parameters: 

 Block ID: 1;  

 Entity list: Curve; 

 Entity ID(s): 1 2 (or by the command all). 

Click Apply. 
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3. Assign the material to the block.  

Select setting the material properties section on Command Panel (Mode 
— Blocks, Entity — Block, Action — Set material). Set the following 
parameters: 

 Block ID(s): 1;  

 Select the previously created material in the list: Material 1. 

Click Apply. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

4. Assign the element type.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Block, Action — Element types). Set the 
following parameters:  

 Block ID(s): 1; 

 Category: Beam; 

 Order:1. 

Click Apply. 
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Setting beam cross section profile  

1. Set beam parameters.  

Select setting the material properties section on Command Panel (Mode 
— Blocks, Entity — Beam Properties). Set the checkbox Select profile. 
Select Rectangle in the list of geometric elements. Specify the following 
parameters:  

 Block ID: 1; 

 Height (H): 1; 

 Width (B): 1;  

Click Apply. 

 
 
 
 

Starting calculation 

1. Set the type of the problem to be solved.  

Select calculation setting section on Command Panel (Mode — 
Calculation settings, Calculation settings — Static, Static — General). 
Select: 

 Dimension: 3D; 

 Model: Elasticity.  

Click Apply. 

 

2. Set the solver settings. 

Select calculation setting section on Command Panel (Mode — 
Calculation settings, Calculation settings — Static, Static — Solver). 
Select the solver method (direct or iterative) and set Convergence 
Parameters in case of choosing an iterative one. You can also leave all 
the settings by default.  

Click Apply.  

3. Set the reaction force calculation  

Go to the tab Static – Output fields and set the checkbox Calculate 
nodal and reaction forces.  

Click Apply.  

Click  Start Calculation. 

Note: Without setting the checkbox Calculate nodal and reaction 
forces, the field is not calculated. 
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4. In a pop-up window select a folder to save the result and enter the file name. 

5. If the calculation is finished successfully, you will see a message in the Console: “Calculation finished 
successfully at <date> <time>”.  

Results analysis 

1. Open the file with the results. There are three ways to do this. 

 Click  Ctrl+E. 

 Select Calculation → Open Results in the Main Menu. Click  Open 
last result. 

 Select Results on Command Panel (Mode — Results). Click  
Open Results.  

 

2. Display the uy component of the displacements field. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 Representation Mode: Surface; 

 Representation Field: Displacement; 

 Representation Component: Y.  

The field of displacements distribution along the Y axis wil be displayed on the model  

 

3. Check the numerical value of the reaction force at the point A.  

 Display Component 2 of the Reaction Forces field. 

 

On the Fidesys Viewer Main Panel, click Select Points On surface. 

 

Select the limiting left point (point A) on the geometric model. 

To quickly view the information at the fixed point, click pointsInfo on the Main Panel.  

 

In the pop-up window, components of the reaction force at the selected point will be displayed.  

 

The difference between the resulting value 150.977 and the required 148.15 is less than 1,8%. 

Do not close the window Points information. 

4. Check the numerical value of reaction moments at the point C. 

Display Component Z of  the Reaction_moment field. 
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On the Fidesys Viewer Main Panel, click Select Points On surface. 

 

Select the limiting right point C on the geometric model. 

In the window Points information components of the reaction moment at the selected point will be displayed. 

 

The difference between the resulting value -27353.5  and the required -27377.3  is less than 0.01%. 

5. Open 3D-image of the beam. 

To display 3D-view of the beam cross section, set the focus on the calculation title and click the button  in 
the Fidesys Viewer standard line. 

 

To apply all of the filters’ changes automatically, click Apply changes to parameters automatically on 
Command Panel. 

 

6. Download numerical data. 

Select File → Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. 
Click ОК. The saved file is an ordinary table of numerical data, any text editor can open it. 

Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface. 
The following program code allows performing the steps of the above-described guide, you only need to 
manually specify the full path and name of the file to be saved. 
 

reset 
create curve location 0 0 0 direction 1 0 0 length 100 
create curve location 100 0 0 direction 1 0 0 length 50 
merge vertex 2 3 
curve all scheme equal 
curve all interval 1 
mesh curve all 
create displacement on vertex 4 dof all fix  
create displacement on vertex 1 dof 2 dof 3 fix  
create force on vertex 2 force value 1000 direction 0 -1 0 
create material 1 
modify material 1 name 'Material1' 
modify material 1 set property 'MODULUS' value 3e+7 
modify material 1 set property 'POISSON' value 0 
block 1 add curve 1 2  
block 1 material 1 
block 1 element beam  
block 1 attribute count 7 
block 1 attribute index 1 value 1 name 'Rectangle' 
block 1 attribute index 2 value 0.0 name 'ey' 
block 1 attribute index 3 value 0.0 name 'ez' 
block 1 attribute index 4 value 0.0 name 'angle' 
block 1 attribute index 5 value 0 name 'section_id' 
block 1 attribute index 6 value 1 name 'geom_H' 
block 1 attribute index 7 value 1 name 'geom_B' 
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analysis type static elasticity dim3 
solver method auto use_uzawa auto try_other on 
output nodalforce on energy off midresults on record3d on log on vtu on material off 
calculation start path 'D:/Fidesys/example3.pvd' 
 

It is also possible to run the file Example_3_Static_Beam.jou by selecting Journal Editor on Toolbar. In a 
pop-up window of the main menu select File → Open and open the necessary journal file.  
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Static load (shell)  

Timoshenko S.P. Voynovskiy-Kriger S. Plates and shells, Nauka, Moscow, 1966, 636 pages [in Russian] 

 

 

The problem of static load of square shell which two sides are clamped 
and the other two are freely supported, is being solved.. The picture 
represents a geometric model of the problem: a = 1 m, shell thickness 
is 0.1 m. The boundary conditions are presented in the picture. The 
plate is loaded by uniform pressure of 10 kPa. 

Test pass criterion is the following: the maximum deflection is 1.19e-6, 
moments Мx=252 N·m and Мy=332 N·m.  

 

 
 
 
 

Geometry creation 

1. Create the square 1 m on side.  

Select volume geometry generation section on Command Panel (Mode 
— Geometry, Entity — Surface, Acti on — Create). Select Rectangle in 
the list of geometric elements. Set the parameters:  

 Width: 1; 

 Height: Optional. 

Click Apply.  
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Meshing 

1. Select surface mesh generation section on Command Panel 
(Mode — Mesh, Entity — Surface, Action — Mesh). Specify the 
following parameters:  

 Select surfaces: 1; 

 Select meshing scheme: Polyhedron; 

Click Apply Scheme.  

Click Mesh. 
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Setting boundary conditions 

1. Fix the two edges rigidly.  

Select Mode — Boundary Conditions, Entity — Displacement, 
Action — Create on Command Panel. Set the following 
parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s):  1 3 (or sequentially click on the top and 
bottom edges); 

 Degrees of Freedom: All; 

 DOF Value: 0. 

 Click Apply. 

 

2. Fix the two other edges at displacements.  

Select Mode — Boundary Conditions, Entity — Displacement, 
Action — Create on Command Panel. Set the following 
parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s):  2 4 (or sequentially click on the right and 
left edges); 

 Degrees of Freedom: X-Translation Disp, Y-
Translation Disp, Z-Translation Disp; 

 DOF Value: 0. 

Click Apply.  
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3. Apply the uniform pressure on the surface. 

Select Mode — Boundary Conditions, Entity — Pressure, 
Action — Create on Command Panel. Set the following 
parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s):  1; 

 Magnitude Value: 1e4; 

Click Apply. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Setting material and element type 

1. Create the material.  

Select setting the material properties section on Command Panel 
(Mode — Material, Entity — Materials management).  

In the Materials Management window that opens, in the second 
column, click on the caption Enter the name of the material and write 
“Material 1”. Press the ENTER key. 

In the left column, select Elasticity - Hooke Material. Select with the 
mouse the characteristic Young's modulus. Hold down the left mouse 
button and drag the label to Material Properties. Double-click in the 
Value field next to Young’s modulus and enter the number 2e11.Similarly, from the Hooke Material section add 
the Poisson Ratio 0.3;  

 

Click Apply.  
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2. Create the block of one type of the material.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Block, Action — Add). Set the following 
parameters: 

 Block ID: 1; 

 Entity list: Surface; 

 Entity ID(s): 1 (or by the command all). 

Click Apply. 
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3. Assign the material to the block.  

Select setting the material properties section on Command 
Panel (Mode — Blocks, Entity — Block, Action — Set material). 
Set the following parameters: 

 Block ID(s): 1; 

 Select the previously created material in the list: 
Material 1. 

Click Apply. 
 

 
 
 
 
 
 
 
 
 

4. Assign the element type.  

Select setting the material properties section on Command 
Panel (Mode — Blocks, Entity — Block, Action — Element 
types). Set the following parameters:  

 Block ID(s): 1; 

 Category: Shell; 

 Order:1. 

Click Apply. 
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5.  Setting shell thickness 

Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Shell Properties). 
Select in the list of possible operations. Set the following parameters:  

 Block ID: 1; 

Click Set shell properties. 

 

Specify: 

 Thickness: 0.1; 

 Material; 

 Eccentricity: 0.5. 

Click Apply. 

Starting calculation 

1. Set the type of the problem to be solved.  

Select calculation setting section on Command Panel (Mode — 
Calculation settings, Calculation settings — Static, Static — 
General). Select: 

 Dimension: 3D; 

 Model: Elasticity.  

Click Apply. 

 

2. Set the solver settings. 

Select calculation setting section on Command Panel (Mode — 
Calculation settings, Calculation settings — Static, Static — 
Solver). Select the solver method (direct or iterative) and set 
Convergence Parameters in case of choosing an iterative one. You 
can also leave all the settings by default. Click Apply.  

3. Set the reaction force calculation  

Go to the tab Static – Output fields and set the checkbox 
Calculate nodal and reaction forces.  

Click Apply.  

Click Start Calculation. 
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Note: Without setting the checkbox Calculate nodal and reaction forces, the field is not calculated. 

4. In a pop-up window select a folder to save the result and enter the file name. 

5. If the calculation is finished successfully, you will see a message in the Console: “Calculation finished 
successfully at <date> <time>”.  

Results analysis 

1. Open the file with the results. You can do this in one of the three 
ways.  

 Click  Ctrl+E. 

 Select Calculation → Open Results in the Main Menu. Click  
Open last result. 

 Select Results on Command Panel (Mode — Results). Click  
Open Results.  

2. Display the uz component of the displacement field. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 Representation Mode: Surface; 

 Representation Field: Displacement; 

 Representation Component: Z. 

 

The field of displacements distribution along the Z axis will be displayed on the model  

3. Check the numerical value of the maximum displacement.  

Display maximum Component 3 of the Displacement field.  

 

The difference between the resulting value 1.209е-6  and the required -1.19e-6 is 1.6% 

 

4. Check numeric values of moments in the center of the plate. 
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Display component XX of the MomentsShell field. 

 
 

 

Select the filter Probe Location (Filters – Alphabetical – Probe Location) 
in the Fidesys Viewer Main Menu. In the tab Properties set the following 
values:  

 Point: (0,0,0);  

 Number of Points: 1; 

 Radius: 0. 

 

Go to the Information tab and look at the MomentsShell field. 

 

 

 

 

 

 

 

 

 

 

 

The difference between the resulting values (Мx=260.347 and Мy=344.745) and the required (Мx=252 and Мy=332) 
is 3.3% and 3.8%, relatively. 

5. Open 3D-image of the shell. 

To display 3D-view of the beam cross section, set the focus on the calculation title and click the button 
3D-view  in the Fidesys Viewer standard line. 
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A new file example *.pvd will be opened and you will be able to apply various filters to it and to view its deformed 
view. 

Choose the new file example_3D.pvd in the Model Tree and display Filters – Alphabetical – Warp by Vector for it 
with the following fields values  

 Vectors: Displacement  

 Scale Factor: 2е5 

 

On the Toolbar, set once again the following parameters for the deformed type: 

 

The first buckling mode will be displayed on the screen but the shell will be enveloped with thickness. 

 

To apply all of the filters changes automatically, click Apply changes to parameters automatically on 
Command Panel. 

6. Download numerical data. 

Select File → Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. 
Click ОК. The saved file is an ordinary table of numerical data which can be opened in any text editor. 
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Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface. 
The following program code allows performing the steps of the above-described guide, you only need to 
manually specify the full path and name of the file to be saved. 

 
reset 
create surface rectangle width 1 zplane  
surface 1 scheme polyhedron  
mesh surface 1 
create displacement  on curve 1 3  dof all fix 0  
create displacement  on curve 2 4  dof 1 dof 2 dof 3 fix 0  
create pressure  on surface 1  magnitude 1e4  
create material 1 
modify material 1 name 'Material1' 
modify material 1 set property 'MODULUS' value 2e+11 
modify material 1 set property 'POISSON' value 0.3 
block 1 add surface 1  
block 1  material 1 
block 1  element shell  
block 1 attribute count 2 
block 1 attribute index 1 value 0.1 name 'thickness' 
block 1 attribute index 2 value 0.5 name 'eccentricity' 
analysis type static elasticity dim3 
solver method auto use_uzawa auto try_other on 
output nodalforce on energy off midresults on record3d on log on vtu on material off  
calculation start path "D:/Fidesys/example.pvd 
 

It is also possible to run the file Example_4_Static_Shell.jou by selecting Journal Editor on Toolbar. In a 
pop-up window of the main menu select File → Open and open the necessary journal file.  
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Hydrostatic pressure on cylinder (setting boundary conditions according to 
coordinates) 

Societe Francaise des Mecaniciens, Guide de validation des progiciels de calcul de 
structures, (Paris, Afnor Technique,1990.) Test No. SSLS08/89. I-Deas Model 
Solution Verification Manual 

The problem of hydrostatic load of the cylindrical shell is being solved. The 
picture represents a geometric model of the problem: radius 1 m, shell thickness 
0.02 m. The shell is fixed on the condition of the symmetry. The plate is loaded 
by the pressure p = 20000·z/L Pa. 

 

Test pass criterion is the following: displacement  at the point (0, R, L) is 

2.8610-6 m. 

 
 

Geometry creation 

1.  Create the cylinder of 1 m radius  and 4 m high.  

 Select volume geometry generation section on Command Panel 
(Mode — Geometry, Entity — Volume, Action — Create). Select 
Cylinder in the list of geometric elements. Specify the cylinder 
dimensions:  

 Height: 4;  

 Cross section: Circular; 

 Radius: 1. 

Click Apply. 

 

 

2. Get the cylindrical shell out of the volumeric cylinder. 

Select the volume removing section on Command Panel (Mode — 
Geometry, Entity — Volume, Action — Delete). Enter the number of 
the created volume – 1 into the field Volume ID(s).  

Put a tick against Keep lower geometry. 

Click Apply. 

 

As a result, three plane bodies (Body 2, Body 3, Body 4) are obtained.  

This will be displayed in the Model Tree. 
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3. Delete side surfaces Surface 2 and Surface 3.  

Select the surface removing section on Command Panel (Mode — Geometry, Entity — Surface, Action — 
Delete). Enter numbers – 2 3 in the window Surface ID(s).  

Click Apply. 

As a result, only the lateral cylindrical shell of 1 m radius and 4 m high will remain of the initial volume. 
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4. Leave a quarter of a shell (symmetric problem).  

Select volume geometry generation section on Command Panel 
(Mode — Geometry, Entity — Volume, Action — Webcut). Select 
Plane in the list of possible webcut types. Set the following 
parameters:  

 Body ID: 2 (the body to be webcut);  

 Webcut with: YZ Plane;  

 Offset value: 0.  

Click Apply.  

 

Do the same for the ZX Plane.  

 Body ID: 2 (the body to be webcut);  

 Webcut with: ZX Plane;  

 Offset value: 0. 

Click Apply. 

 

 

 
As a result, the original Body 2 in the Model Tree is split into three (Body 2, Body 5 and Body 6).  
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5. Delete surfaces Surface 5 and Surface 6.  

Select the surface removing section on Command Panel 
(Mode — Geometry, Entity — Surface, Action — Delete). 
Enter numbers – 5 6 into the window Surface ID(s).  

Click Apply. 

As a result, only a quarter of the original shell Body 6 (Surface 
7) is left.  
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6. Move the surface to the coordinate origin.  

Select surface geometry modification section on Command Panel  
(Mode — Geometry, Entity — Surface, Action — Transform). 
Select Move in the list of possible webcut types. Set the following 
parameters:  

 Surface: 7 (the surface to be moved);  

 Checkbox Distance;  

 Z Distance: 2. 

Click Apply.  
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Meshing  

1. Specify the parameters of mesh refinement. 

Select meshing on curves section on Command Panel (Mode — 
Mesh, Entity — Curve, Action — Mesh ).  

Split the cross-cut curves Surface 17 and Surface 18 into 10 
elements.  

 Select Curves: 17 18 (or click the mouse while holding 
down the Ctrl key on contour of the cross-cut curves);  

 Select the way of meshing: Equal;  

 Select splitting settings: Interval;  

 Specify interval number: 10.  

Click Apply Size. 

Split longitudinal curves Curve 5 and Curve 16 into 20 elements.  

 Select Curves: 5 16 (or click the mouse while holding 
down the Ctrl key on contour of the longitudinal 
curves);  

 Select the way of meshing: Equal;  

 Select splitting settings: Interval;  

 Specify interval number: 20.  

 Click Apply Size.  

2. Create the mesh.  

Select the surface mesh generation section on Command Panel 
(Mode — Mesh, Entity — Surface, Action — Intervals).  

 Select Surfaces to Mesh (specify their ID)): 7 (or by the 
command all);  

 Select meshing scheme: Automatic Sizing. 

Click Apply Size. 

Click Mesh. 

The resulting number of elements can be viewed in the Property 
Page by clicking on the inscription Surface 7 in the Model Tree on 
the left.  

To view the mesh properties, you can follow these steps: 

 Select the entire model  

 Right-click on the model 

 In the pop-up menu, select List Information – List Mesh 
Info  

 Information on the mesh will be displayed in 
Command Line  
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Setting material and element type  

1. Create the material.  

Select setting the material properties section on Command Panel (Mode — Material, Entity — Materials 
management).  

In the Materials Management window that opens, in the second column, click on the caption Enter the name of 
the material and write “Material 1”. Press the ENTER key. 

In the left column, select Elasticity - Hooke Material. Select with the mouse the characteristic Young's modulus. 
Hold down the left mouse button and drag the label to Material Properties. Double-click in the Value field next to 
Young’s modulus and enter the number 2.1e11. Similarly, from the Hooke Material section add the Poisson Ratio 
0.3. 

Click Apply. 
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2. Create the block of one type of the material.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Block, Action — Add). Set the following 
parameters:  

 Block ID: 1;  

 Entity List: Surface;  

 Entity ID(s): 7 (or by the command all).  

Click Apply. 
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3. Assign the material to the block.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Block, Action — Set material). Set the 
following parameters:  

 Block ID(s): 1;  

 Select the previously created material in the list: 
Material 1.  

Click Apply. 

4. Assign the shell thickness.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity —Shell propetries). Set the following 
parameters:  

 Block ID: 1;  

 Thickness: 0.02;  

 Eccentricity: 0.5. 

Click Apply. 

 
 
 
 
 

5. Assign the element type to the block.  

Select setting the material properties section on Command Panel (Mode 
— Blocks, Entity — Block, Action — Element types). Set the following 
parameters:  

 Block ID(s): 1;  

 Category: Shell;  

 Order: 1.  
Click Apply. 
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Setting boundary conditions  

1. Fix the cross-cut curve Surface 17 by the symmetry 
condition.  

Select Mode — Boundary Conditions, Entity — Displacement, 
Action — Create on Command Panel. Set the following 
parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s):  17 (or click on the cross-cut curve); 

 Degrees of Freedom: Z-Translation Disp; X-
Rotation Disp; Y-Rotation Disp. 

Click Apply.  

 

2. Fix the longitudinal curve Curve 5 on the symmetry 
condition.  

Select Mode — Boundary Conditions, Entity — Displacement, 
Action — Create on Command Panel. Set the following 
parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s):  5 (or click on the longitudinal curve); 

 Degrees of Freedom: X-Translation Disp; Y-
Rotation Disp; Z-Rotation Disp. 

Click Apply. 

 

3. Fix the longitudinal curve Curve 16 by the symmetry 
condition.   

Select Mode — Boundary Conditions, Entity — Displacement, 
Action — Create on Command Panel. Set the following 
parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entity ID(s):  16 (or click on the longitudinal curve);  

 Degrees of Freedom: Y-Translation Disp; X-Rotation Disp; 
Z-Rotation Disp. 

Click Apply. 
 
 
 
 
 

4. Apply pressure to the cylinder inner surface with value of 1. 
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Select Mode — Boundary Conditions, Entity — Pressure, Action — Create on Command Panel. Set the 
following parameters: 

 System Assigned ID;  

 Entity List: Surface; 

 Entity ID(s):  7 (or click on the cylinder surface);  

 Magnitude Value: 1. 

 
Click Apply. 
 
 
 
 

5. Set pressure dependency of the z-coordinate. 

Select Mode — BC Dependence. 

 

In the pop-up window BC Dependency, set the following 
parameters:  

 BC name: Pressure 1;  

 Select checkbox Formula, Manually;  

 In the field below, enter -20000*z/4. 

Click Apply. 

 

To view the plotted graph, please, use the appropriate tab. 
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Starting calculation 

1. Set the type of the problem to be solved.  

Select calculation setting section on Command Panel (Mode — 
Calculation settings, Calculation settings — Static, Static — 
General). Select: 

 Dimension: 3D; 

 Model: Elasticity.  

Click Apply. 

Click  Start Calculation. 

In a pop-up window select a folder to save the result and enter 
the file name. 

If the calculation is finished successfully, you will see a message in 
the Console: “Calculation finished successfully at <date> <time>”.  
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Results analysis 

1. Open the file with the results. You can do this in one 
of the three ways. 

 Click  Ctrl+E. 

 Select Calculation → Open Results in the 
Main Menu. Click  Open last result. 

 Select Results on Command Panel (Mode — 
Results). Click Open Results.  

2. Display the Uz component of the displacement field 
on the model.  

In Fidesys Viewer window set the following parameters on 
Toolbar: 

 Representation Mode: Surface; 

 Representation Field: Displacement; 

 Representation Component: 3. 

3. Compare the numerical value of the target 
displacement at the point (0,1,4) with the initial one of the 
source -2.86e-6. 

Select Filters → Alphabetical → Probe Location. In the tab Properties, set the following parameters for the 
filter:  

 Point (0, 1, 4); 

 Number of Points: 1; 

 Radius: 0. 

 

The difference between the resulting value -2.99994-06 and the required -2.86e-6 is 4.89%. 

You can see the way the body is deformed under the applied pressure. 

Select the filter Warp By Vector to do this. Set the following parameters in the tab Properties:  
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 Vectors: Displacement;  

 Scale Factor: 1e5.  

As a result, the deformed body is displayed at the picture. 

Select the following display settings for the deformed view: 

 

To see the original model, click the icon near the model in the Model Tree.  

 

Consider the direction of the coordinate axes in the picture. 

 

4. Download numerical data. 

Select File → Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. 
Click  ОК. The saved file is an ordinary table of numerical data which can be opened in any text editor. 
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Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface. 
The following program code allows performing the steps of the above-described guide, you only need to 
manually specify the full path and name of the file to be saved. 
 

reset 
set node constraint on 
create Cylinder height 4 radius 1  
delete volume 1 keep_lower_geometry  
delete Surface 2 3  
webcut body 2 with plane xplane offset 0 preview  
webcut body 2 with plane xplane offset 0  
webcut body 2 with plane yplane offset 0 preview  
webcut body 2 with plane yplane offset 0  
delete Surface 5 6  
move Surface 7 preview z 2 include_merged  
move Surface 7 z 2 include_merged  
curve 17 18 interval 10 
curve 17 18 scheme equal 
curve 5 16 interval 20 
curve 5 16 scheme equal 
surface all size auto factor 5 
mesh surface all 
list Surface 7 mesh 
create material 1  
modify material 1 name 'material 1' 
modify material 1 set property 'POISSON' value 0.3 
modify material 1 set property 'MODULUS' value 2e+11 
set duplicate block elements off 
block 1 surface 7  
block 1 material 'material 1' 
block 1 element type shell8 
undo group begin 
block 1 attribute count 2 
block 1 attribute index 1 value 0.02 
block 1 attribute index 2 value 0.5 
undo group end 
block 1 element shell order 2 
create displacement on curve 17 dof 3 dof 4 dof 5 fix  
create displacement on curve 5 dof 1 dof 5 dof 6 fix  
create displacement on curve 16 dof 2 dof 4 dof 6 fix  
create pressure on surface 7 magnitude 1  
bcdep pressure 1 value '-20000*z/4' 
analysis type static elasticity dim3 
calculation start path "D:/Fidesys/example.pvd" 
 
 

 It is also possible to run the file Example_5_Static_3D_Shell.jou by selecting Journal Editor on Toolbar. 
In a pop-up window of the main menu select File → Open and open the necessary journal file. 
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Buckling (shell model) 

S.P. Timoshenko, J.M Manages “Theory of elastic stability” second 
edition. Dunod, 1966, 500 pages  

The problem of cylindrical shell buckling under the pressure uniformly 
distributed over the entire surface is being solved. 

The picture represents a geometric model of the problem: R = 2 m, L = 2 
m, thickness h = 0.002 m. Due to the symmetry of the problem, the ¼ 
part of the cylinder is regarded. Constraints on the lines AB and CD are 
due to the conditions of symmetry; a uniformly distributed load on the 

surface is ABCD q = 1 kPa. The material parameters are E = 200 GPa,  = 
0.3.  

It is necessary to compare the first three critical values. 

Geometry creation 

1. Create a cylinder with radius of 2 m and length of 2 m.  

Select volume geometry generation section on Command Panel 
(Mode — Geometry, Entity — Volume, Action — Create). Select 
Cylinder in the list of geometric elements. Creat leaving Circular at the 
base. Set radius of 2 and height of 2 

Click Apply. 

 

 

 

 

 

2. Get the cylindrical shell out of the volumeric cylinder. 

 

Select the volume removing section on Command Panel 
(Mode — Geometry, Entity — Volume, Action — Delete). 
Enter the number of the created volume – 1 into the field 
Volume ID(s). Put a tick against Keep lower geometry. 

Click Apply.  

 

 

As a result, three plane bodies (Body 1, Body 2, Body 3) are 
obtained. This will be displayed in the Model Tree. 
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3. Delete side surfaces Body 3 and Body 4. 

Select the surface removing section on Command Panel (Mode — Geometry, Entity — Surface, Action — 
Delete). Enter numbers 2 3 in the window Surface ID(s).  

Click Apply. 

As a result, only the lateral cylindrical shell of 2 m radius and 2 m high will remain of the initial volume. 

4.  Leave a quarter of a shell (symmetry of the problem).  

Select volume geometry generation section on Command Panel 
(Mode — Geometry, Entity — Surface, Action — Webcut). Select 
Coordinate Plane in the list of possible webcut types. Set the 
following parameters:  

 Surface ID(s): 2 (the surface to be webcut);  

 Webcut with: YZ Plane;  

 Offset value: 0; 

 Imprint. 

Click Apply. 

 

 

Do the same for the ZX Plane: 

 Volume ID(s): 2 (the volume to be webcut); 

 Webcut with: ZX Plane; 

 Offset value: 0; 

 Imprint. 

Click Apply. 
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As a result, the original volume in the Model Tree is split into three (Body 2, Body 5 and Body 6). 

Delete the bodies 2 and 5. To do this, select these bodies in the Model Tree holding down the Ctrl key and click 
Delete in contextual menu. As a result, a quarter of the original shell is left (Body 6): 
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Meshing 

1. Create a quadrangular mesh.  

Select meshing on plane section on Command Panel (Mode — 
Mesh, Entity — Surface, Action — Intervals). Specify the 
parameters of mesh refinement: 

 Select surfaces: 7;  

 The way of meshing: Approximate Size; 

 Approximate Size: 0.125. 

Click Apply Size. 
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2. Select meshing on plane section on Command Panel 
(Mode — Mesh, Entity — Surface, Action —Mesh). Select 
meshing scheme: 

 Select surfaces: 7; 

 Select meshing scheme: Polyhedron; 

Click Apply Scheme. 

Click  Mesh. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 

Setting boundary conditions 

1. Fix the line AB on the conditions of symmetry.  



 CAE Fidesys — User Guide (version 3.0) 

159 

 

Select Mode — Boundary Conditions, Entity — Displacement, Action — Create on Command Panel. Set the 
following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entities ID(s): 5 (or click on the top line on a quarter of the shell); 

 Degrees of Freedom: Х-Translation Disp, Y-Rotation Disp, Z-Rotation Disp; 

 DOF Value: 0. 

 Click Apply. 

2.  Fix the line CD of the conditions of symmetry. 

Select Mode — Boundary Conditions, Entity — Displacement, Action — Create on Command Panel. Set the 
following parameters: 

 System Assigned ID; 

 Entity List: Curve; 

 Entities ID(s): 16 (or click on the lower line on a quarter of the shell);  

 Degrees of Freedom: Y-Translation Disp, X-Rotation Disp, Z-Rotation Disp; 

 DOF Value: 0.  

 Click Apply. 

 

3. Apply pressure to the entire surface of the shell. 

Select Mode — Boundary Conditions, Entity — Pressure, Action — Create on Command Panel. Set the 
following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entities ID(s): 7 (or click on the surface of the shell); 

 Magnitude Value: 1000. 

 Click Apply. 

 

Setting material and element type 

1. Create the material.  

Select setting the material properties section on Command Panel 
(Mode —Material, Entity — Materials management).  

In the Materials Management window that opens, in the second 
column, click on the caption Enter the name of the material and 
write “Material 1”. Press the ENTER key. 

In the left column, select Elasticity - Hooke Material. Select with 
the mouse the characteristic Young's modulus. Hold down the 
left mouse button and drag the label to Material Properties. 
Double-click in the Value field next to Young’s modulus and enter 
the number 2e11. Similarly, from the Hooke Material section add 
the Poisson Ratio 0.3. 
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Click Apply. 
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2.  Create a block of one type of the material.  

Select setting the material properties section on Command 
Panel (Mode — Blocks, Entity — Block, Action — Add). Set 
the following parameters: 

 Block ID: 1; 

 Entity list: Surface; 

 Entity ID(s): 7 (or by the command all).  

Click Apply. 
  
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

3. Assign the material to the block.  

Select setting the material properties section on 
Command Panel (Mode — Blocks, Entity — Block, Action 
— Set material). Set the following parameters: 

 Block ID(s): 1; 

 Select the previously created material in the 
list: Material 1. 

Click Apply. 
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4. Assign the element type.  

Select setting the material properties section on Command 
Panel (Mode — Blocks, Entity — Block, Action — Element 
Types). Set the following parameters:  

 Block ID(s): 1;  

 Category: Shell; 

 Order: 1. 

Click Apply. 

 

 

 

 

 

 

 
 
 
 

Setting shell thickness 

1. Set the shell thickness.  

Select setting the material properties section on Command 
Panel (Mode — Blocks, Entity — Block, Action – Shell 

properties). Set the 
following 
parameters:  

 Block 
ID: 1; 

 Thick
ness: 
0.02; 

 Eccen
tricity: 
0.5; 

Click Apply. 

 

 
 

 

 

 

Starting calculation 
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1. Set the type of the problem to be solved.  

Select calculation setting section on Command Panel (Mode — Calculation settings, Calculation settings — 
Stability, Stability — General). Select 3 in the field Number of buckling modes. Leave other parameters by  
default. Click Apply. Click Start calculation. 

In a pop-up window select a folder to save the result and enter the file name. 

If the calculation is finished successfully, you will see a message in the Console: “Calculation finished successfully 
at <date> <time>”.  

 

 

 

 

 
 
 
 
 
 
 
 
 
 

Results analysis 

1. Compare the obtained results. 

The first three critical values are displayed in Command Line.  

 

Compare the obtained results with those in the table: 

 

 
№ Theor. value FIDESYS 

1 72.260 72.5865 0.45% 

2 164.835 159.28 3.37% 

3 293.040 292.571 0.16% 
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2. Open the file with the results. You can do this in one of the three ways.  

 Click  Ctrl+E. 

 Select Calculation → Open Results in the Main Menu. Click  Open last result. 

 Select Results on Command Panel (Mode — Results). Click  Open Results.  

 

 

3. In a pop-up Fidesys Viewer window select a filter Warp By Vector. 

 

 

 

4. In a pop-up filter Warp By Vector in the tab Properties, set the following parameters: 

 Vectors: Mode 1 displacement  

 Scale Factor: 0.1 

5. Display Mode 1 displacement 

In Fidesys Viewer window set the following parameters on Toolbar: 

 

Make sure that the first required critical value is displayed in the window Critical value. 

6. View results 

As a result, the deformed body is displayed at the picture. To see the original model, click  near the model in 
the Model Tree. The picture below shows the deformed (solid grey filling) and the original model (with the 
distribution field Displacements for Mode 1). 

 

7. Select the filter Warp By Vector to do this. Set the following field value in the tab Properties: 
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 Vectors: Mode 2 displacement 

 Scale Factor: 0.1 

8. Display Mode 2 displacement. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 

Make sure that the second required critical value is displayed in the window Critical value. 

9. View results  

 

 Display Mode 3 displacement in the same way, make sure that the third required critical value is displayed in the 
window Critical value. 



 CAE Fidesys — User Guide (version 3.0) 

166 

 

 

10. Display the 3D-view of the model (shell with thickness). 

To do this, click on the name of the source file in the Model Tree. After this click 3D-view button in the default 
string. 

 

The file* _3D.pvd with a 3D-image of the shell must be opened and you will be able to apply various filters to it 
and to view its deformed view. 

Choose the new file example_3D.pvd in the Model Tree and display Filters Warp by Vector for it with the 
following fields values: 

 Vectors: Mode 1 displacement 

 Scale Factor: 0.1 

On the Toolbar, set once again the following parameters for the deformed type: 

 

The first buckling mode will be displayed on the screen but the shell will be enveloped with thickness. 
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To apply all of the filters changes automatically, click Apply changes to parameters automatically on 
Command Panel. 

11. Download numerical data. 

Select File → Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. 
Click  OK. In the pop-up window select:  

 Field Association: Field Data  

 The saved file is an ordinary table of numerical data which can be opened in any text editor. 

Using Console Interface 

For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface. 
The following program code allows performing the steps of the above-described guide, you only need to 
manually specify the full path and name of the file to be saved. 
 
reset 
set node constraint on 
create Cylinder height 2 radius 2  
delete volume 1 keep_lower_geometry  
delete Surface 3 2  
webcut body 2 with plane xplane offset 0 imprint preview  
webcut body 2 with plane xplane offset 0 imprint  
webcut body 2 with plane yplane offset 0 imprint preview  
webcut body 2 with plane yplane offset 0 imprint  
delete Surface 5 6  
surface 7 size 0.125 
surface 7 scheme Polyhedron 
mesh surface 7 
create displacement on curve 16 dof 2 dof 4 dof 6 fix 0  
create displacement on curve 5 dof 1 dof 5 dof 6 fix 0  
create pressure on surface 7 magnitude 1000  
create material 1  
modify material 1 name 'Material 1' 
modify material 1 set property 'POISSON' value 0.3 
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modify material 1 set property 'MODULUS' value 2e+11 
set duplicate block elements off 
block 1 surface 7  
block 1 material 'Material 1' 
block 1 element shell order 1 
undo group begin 
block 1 attribute count 2 
block 1 attribute index 1 value 0.02 
block 1 attribute index 2 value 0.5 
undo group end 
analysis type stability elasticity dim3 
calculation start path "D:/Fidesys/example.pvd" 
 

It is also possible to run the file Example_6_Stability_Shell.jou, by selecting Journal Editor on Toolbar. In 
a pop-up window of the main menu select File → Open and open the necessary journal file.  
 

 
 
 
 
 

Modal analysis (3D)  

NAFEMS Selected Benchmarks for Natural Frequency Analysis “Simply Supported "Solid" Square Plate”, Test No 
FV52. 

The problem of modal analysis of a square plate is being solved. 

The picture represents a geometric model of the problem and a mesh: 

The size of the plate is 10 m х 10 m х 1 m. Displacements along z-axis are constrained for the edges of the plate 

bottom side. The material parameters are E = 200 hPa,  = 0.3,  = 8000 kg/m3. 

Eigenmodes from 4 to 10 are to be compared.  

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Geometry creation 

1. Create the plate.  

Select volume geometry generation section on Command 
Panel (Mode — Geometry, Entity —Volume, Action — 
Create). Select Brick in the list of geometric elements. Set the 
brick dimensions:  
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 X (width): 10 

 Y (height): 10 

 Z (depth): 1 

Click Apply. 

 
 
 
 
 
 
 
 

 
 

Meshing 

A mesh of 8*8*3 linear hexahedral elements is to be generated 
(as shown at the picture with the problem setting).  

1. Select meshing on curves section on Command Panel 
(Mode — Mesh, Entity — Curve, Action — Mesh). Specify 
the parameters of mesh refinement:  

 Select Curves: 1 2 3 4 5 6 7 8 (using space after 
each of them); 

 Select the way of meshing: Equal; 

 Select splitting settings: Interval; 

 Interval: 8 (see the figure) 

Click Apply Size. 

 

2. Select meshing on curves section on Command Panel 
(Mode — Mesh, 
Entity — Curve, 
Action — Mesh). 
Specify the 
parameters of 
mesh refinement: 

 Select 
Curves: 9 
10 11 12 

(using space after each of them); 

 Select the way of meshing: Equal; 

 Select splitting settings: Interval; 

 Interval: 3. 

Click Apply Size.  
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Select volume mesh generation section on Command Panel (Mode — Mesh, Entity — Volume, Action — Mesh).  

 Select Volumes: 1 (or by the command all) 

 Select Meshing Scheme: Automatically Calculate 

Click Apply Scheme.  

Click Mesh. 
 
 
 
 
 
 
 
 
 

Setting boundary conditions 

1. Fix the bottom side edges along Z.  

Select Mode — Boundary Conditions, Entity — Displacement, Action — 
Create on Command Panel. Set the following parameters: 

 System Assigned ID 

 Entity List: Curve 

 Entity ID(s):  5 6 7 8 (using space after each of them) 

 Degrees of Freedom: Z-Translation 

 DOF Value: 0 

 Click Apply. 
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Setting material and element type 

1. Create the material. 

Select setting the material properties section on Command Panel 
(Mode —Material, Entity — Materials management).  

In the Materials Management window that opens, in the second 
column, click on the caption Enter the name of the material and write 
“Material 1”. Press the ENTER key. 

In the left column, select Elasticity - Hooke Material. Select with the 
mouse the characteristic Young's modulus. Hold down the left mouse 
button and drag the label to Material Properties. Double-click in the Value field next to Young’s modulus and 
enter the number 2e11. Similarly, from the Hooke Material section add the Poisson Ratio 0.3. Density: 8000 

Click Apply. 
 

 

 

 

 

 

 

 
 

2. Create a block of one type of the material.  
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Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Block, Action — 
Add). Set the following parameters: 

 Block ID: 1; 

 Entity list: Volume; 

 ID: 1 (or by the command all). 

Click Apply. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3. Assign the material to the block.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Block, Action — Set material). Set the 
following parameters: 

 Block ID(s): 1; 

 Select the previously created material in the list: 
Material 1. 

Click Apply. 
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4. Assign the element type.  

Select setting the material properties section on Command Panel (Mode 
— Blocks, Entity — Block, Action — Element Types). Select in the list of 
possible operations. Set the following parameters:  

 Block ID(s): 1; 

 Select: Volumes; 

 Order: 1 

Click Apply.  
 

 

 

 

 

 

 
 

 

Starting calculation 

1. Set the type of the problem to be solved.  

Select calculation setting section on Command Panel (Mode — 
Calculation settings, Calculation settings — Mode frequency 
analysis, ModeFrequency — General). Specify the following 
settings: 

 Interval: 20 – 250.  

Click Apply.  

Click  Start Calculation.   

2. In a pop-up window select a folder to save the result and 
enter the file name. 

3. If the calculation is finished successfully, you will see a 
message in the Console: “Calculation finished successfully at 
<date> <time>” as well as the required eigen values and 
frequencies. 
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Results analysis 

1. Compare the obtained results to those in the given table. 

 
№ NAFEMS FIDESYS 

  Value, Hz Error 

4 51.65 51.68 0.1% 

5 132.73 132.75 0.0% 

6 132.73 132.75 0.0% 

7 194.37 194.38 0.0% 

8 197.18 197.19 0.0% 

9 210.55 210.55 0.0% 

10 210.55 210.55 0.0% 

 

2. Open the file with the results. You can do this in one of the three ways. 

  Click  Ctrl+E. 

 

 Select Calculation → Open Results in the Main Menu. Click  Open last result. 

 Select Results on Command Panel (Mode — Results). Click  Open Results.  

 

3. You can see the way the body is deformed. 

Select a filter Warp By Vector to do this. Set the following parameters in the tab Properties: 

 Vectors: Eigenvalue_# (# stands for the number of the eigenvalue) 

 Scale Factor: 700 

 As a result, the deformed body is displayed at the picture. To see the original model, click  near it in the 
Model Tree. The picture below shows the deformed model at different eigenvalues. 
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4 eigenmode 

 

5 eigenmode 

 

6 eigenmode 

 

7 eigenmode 

 

8 eigenmode 

 

 9 eigenmode 

 

10 eigenmode 
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Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface. 
The following program code allows performing the steps of the above-described guide, you only need to 
manually specify the full path and name of the file to be saved. 
 

reset 
set node constraint on 
brick x 10 y 10 z 1 
curve 1 2 3 4 5 6 7 8 interval 8 
curve 1 2 3 4 5 6 7 8 scheme equal 
curve 9 10 11 12 interval 3 
curve 9 10 11 12 scheme equal 
volume 1 scheme Auto 
volume 1 scheme Auto 
mesh volume 1  
create displacement on curve 5 6 7 8 dof 3 fix 0  
create material 1  
modify material 1 name 'Material 1' 
modify material 1 set property 'POISSON' value 0.3 
modify material 1 set property 'MODULUS' value 2e+11 
modify material 1 set property 'DENSITY' value 8000 
set duplicate block elements off 
block 1 volume 1  
block 1 material 'Material 1' 
block 1 element solid order 1 
analysis type eigenfrequencies elasticity dim3 
eigenvalue find 10 smallest 
calculation start path "D:/Fidesys/example.pvd" 
 
 

 It is also possible to run the file Example_7_EigenValue_3D.jou, by selecting Journal Editor on Toolbar. 
In a pop-up window of the main menu select File → Open and open the necessary journal file . 
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Modal analysis (shell model)  
NAFEMS-Glasgow, BENCHMARK newsletter, Report No. E1261/R002, 
“Free Vibrations of a Simply-supported Thin Square Plate” , February 1989, 
p.21. 

The problem of modal analysis of a square plate is being solved. 

The size of the plate is 10 m х 10 m, the thickness is 0.05 m. X- and Y-
Translation and Z-Rotation are constrained for all nodes of the plate. All 
the edges are constrained in Z-direction. The X-rotation is constrained for 
edges AB and CD. The Y-rotation is constrained for edges BC and AD. 

The material parameters are E = 200 hPa,  = 0.3,  = 8000 kg/m3. 

Eigenmodes from 1 to 8 are to be compared. 

 

Geometry creation 

1. Create the plate.  

Select volume geometry generation section on Command Panel 
(Mode — Geometry, Entity — Surface, Action — Create). Select 
Rectangle in the list of geometric elements. Set the brick 
dimensions:  

 Width: 10; 

 Location: ZPlane. 

Click Apply. 
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Meshing 

A mesh of 32*32 linear quadrilateral elements is to be generated (as 
shown at the picture with the problem setting. 

1. Select meshing on curves section on Command Panel (Mode — 
Mesh, Entity — Curve, Action — Mesh). Specify the parameters of 
mesh refinement: 

 Select Curves: all; 

 Select the way of meshing: Equal; 

 Select splitting settings: Interval; 

 Interval: 32 (see the figure).  

Click Apply Size. 

Click Mesh. 

 

 

 

 

 

 

 

2.  Select surface mesh generation section on Command 
Panel (Mode — Mesh, Entity — Surface, Action — Mesh).  

 Select Surfaces: 1 (or by the command all) 

 Select Meshing Scheme: Automatically Calculate 

Click Apply Scheme.  

Click Mesh. 
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Setting boundary conditions 

1. Fix the plate: X- and Y-Translations and Z-Rotations.  

Select Mode — Boundary Conditions, Entity — 
Displacement, Action — Create on Command Panel. Set 
the following parameters: 

 System Assigned ID; 

 Entity List: Node; 

 Entity ID(s):  all; 

 Degrees of Freedom: X-Translation, Y-
Translation and Z-Rotation; 

 DOF Value: 0. 

 Click Apply.  

2. Fix all the edges at the Z-direction.  

Select Mode — Boundary Conditions, Entity — 
Displacement, Action — Create. Set the following 
parameters: 

 System Assigned ID; 

 Entity List: Curves; 

 Entity ID(s):  all; 

 Degrees of Freedom: Z-Translation; 

 DOF Value: 0. 

Click Apply.  

 

3. Fix the edges AB and CD on X-Rotation.  

Select Mode — Boundary Conditions, Entity — 
Displacement, Action — Create on Command Panel. Set 
the following parameters: 

 System Assigned ID; 

 Entity List: Curves; 

 Entity ID(s):  2 4 (using space after each of 
them); 

 Degrees of Freedom: X-Rotation; 

 DOF Value: 0. 

Click Apply.  

4. Fix the edges BC and AD in Y-rotation.  

Select Mode — Boundary Conditions, Entity — Displacement, Action — Create on Command Panel. Set the 
following parameters: 

 System Assigned ID; 
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 Entity List: Curves; 

 Entity ID(s):  1 3 (using space after each of them); 

 Degrees of Freedom: Y-Rotation; 

 DOF Value: 0. 

 Click Apply. 

Setting material and element type 

1. Create the material. 

Select setting the material properties section on Command Panel (Mode — 
Material, Entity — Materials management).  

In the Materials Management window that opens, in the second column, 
click on the caption Enter the name of the material and write “Material 1”. 
Press the ENTER key. 

In the left column, select Elasticity - Hooke Material. Select with the mouse 
the characteristic Young's modulus. Hold down the left mouse button and 
drag the label to Material Properties. Double-click in the Value field next to Young’s modulus and enter the 
number 200e9.Similarly, from the Hooke Material section add the Poisson Ratio 0.3, Density: 8000. 

Click Apply. 
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2. Create the block of one type of the material 

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Block, Action — Add). Set the following 
parameters: 

 Block ID: 1; 

 Entity list: Surface; 

 ID: 1 (or by the command all). 

Click Apply. 
 
 
 
 
 
 
 
 
 
 
 

3. Assign the material to the block.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Block, Action — Set material). Set the 
following parameters: 

 Block ID(s): 1; 

 Select the previously created material in the list: 
Material 1. 

Click Apply. 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

4. Assign the element type.  
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Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Block, Action — 
Element Types). Set the following parameters:  

 Block ID(s): 1; 

 Select: Surfaces; 

 Order: 1. 

 Click Apply. 

 
 
 
 
 
 
 
 
 
 

Setting shell thickness 

1. Set the shell thickness.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Shell properties). Set the following 
parameters:  

 Block ID: 1; 

 Thickness: 0.05; 

 Eccentricity: 0.5; 

Click Apply. 
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Starting calculation  

1. Set the type of the problem to be solved.  

Select calculation setting section on Command Panel (Mode — 
Calculation settings, Calculation settings — Eigen Frequencies, 
Eigen Frequencies — General). Set the default settings.  

Click Apply.  

Click  Start Calculation. 

2. In a pop-up window select a folder to save the result and 
enter the file name. 

3. If the calculation is finished successfully, you will see a 
message in the Console: “Calculation finished successfully at 
<date> <time>” as well as the required eigenvalues and 
frequencies. 

 

 

 
 
 
 
 
 
 
 

Results analysis 

1. Compare the obtained results to those given in the picture. 

 

  

 

 

 

2. Open the file with the results. You can do this in one of the three ways. 
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 Click  Ctrl+E. 

 Select Calculation → Open Results in the Main Menu. Click  Open last result. 

 Select Results on Command Panel (Mode — Results). Click  Open Results.  
 
 
 
 
 
 
 
 
 
 
 
 

3.  You can see the way the body is deformed under the applied pressure. 

Select a filter Warp By Vector to do this. Set the following parameters in the tab Properties: 

 Vectors: Eigenvalue_# (# stands for the number of the eigenvalue); 

 Scale Factor: 200. 

 

 As a result, the deformed body is displayed at the picture. To see the original model, click  near it in the 
Model Tree. The picture below shows the deformed model at different eigenvalues. 

 

4. Display the 3D-view of the model (shell with thickness). 

To do this, click on the name of the source file in the Model Tree. After this click 3D-view button in the 
default string. 

 

The file *_3D.pvd with a 3D-image of the shell must be opened and you will be able to apply various filters to it 
and to view its deformed view. 
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Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface. 
The following program code allows performing the steps of the above-described guide, you only need to 
manually specify the full path and name of the file to be saved. 
 

reset 
set node constraint on 
create surface rectangle width 10 zplane  
curve all interval 32 
curve all scheme equal 
surface 1 scheme Auto 
surface 1 scheme Auto 
mesh surface 1 
create displacement on node all dof 1 dof 2 dof 6 fix 0  
create displacement on curve all dof 3 fix 0  
create displacement on curve 2 4 dof 4 fix 0  
create displacement on curve 1 3 dof 5 fix 0 
create material 1  
modify material 1 name 'Material1' 
modify material 1 set property 'MODULUS' value 2e+11 
modify material 1 set property 'POISSON' value 0.3 
modify material 1 set property 'DENSITY' value 8000 
set duplicate block elements off 
block 1 add surface 1  
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block 1 material 'Material1' 
block 1 element shell order 1 
block 1 attribute count 2 
block 1 attribute index 1 value 0.05 
block 1 attribute index 2 value 0.5 
analysis type eigenfrequencies dim3 preload off 
eigenvalue find 10 smallest 
calculation start path 'D:/Fidesys/example.pvd' 
 

 It is also possible to run the file Example_8_Eigenvalue_Shell.jou, by selecting Journal Editor on 
Toolbar. In a pop-up window of the main menu select File → Open and open the necessary journal file. 
 

 

Setting heat transfer (3D, working with two blocks) 

 

The 3D problem of a hollow two-material cylinder which inner and outer surfaces 
undergo the convection is being solved.  

The pictures represent a geometric model of the problem: 

The inner radius of the cylinder Ri = 0.30 m, the middle radius of the cylinder (at 
the place of material changing) Rm = 0.35 m, the external radius of the cylinder 
Re = 0.37 m.  

Сonvective heat exchange with internal temperature Ti = 70 ° C and coefficient hi = 
150 W/ m2/°C occurs on the inner surface of the cylinder. Сonvective heat exchange 

with exterior temperature Te = -15 °C and coefficient he = 200 W/ m2/°C occurs on 

the outer surface of the cylinder. 

Materials are isotropic. The material heat transfer 1 is Ѵ1 = 40 W/(m·°C). The 

material heat transfer 2 is Ѵ2 = 20 W/(m·°C). 

Test pass criterion is the following:  

at the point (0.3, 0, 0) heat flux  6687 W/ m2 is within 1%. 

 

 
 
 
 
 
 

 

Geometry creation 

1. Create the first cylinder. 

Select volume geometry generation section on Command 
Panel (Mode – Geometry, Entity – Volume, Action – Create). 
Select Cylinder in the list of geometric elements. Specify the 
cylinder dimensions:  

 Height: 0.01; 

 Circular; 
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 Radius: 0.3. 

Click Apply. 

 

2. Create the second cylinder.  

Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action 
— Create). Select Cylinder in the list of geometric elements. Specify the cylinder dimensions:  

 Height: 0.01; 

 Circular; 

 Radius: 0.35. 

Click Apply. 

 

3. Create the third cylinder.  

Select volume geometry generation section on 
Command Panel (Mode — Geometry, Entity — 
Volume, Action — Create). Select Cylinder in the list 
of geometric elements. Specify the cylinder 
dimensions:  

 Height: 0.01; 

 Circular; 

 Radius: 0.37. 

Click Apply. 

 

As a result, three generated entities are displayed in 
the Model Tree (Volume 1, Volume 2 and Volume 3). 

 

 

 

 

4. Subtract the first cylinder from the second one. 

Select volume geometry generation section on 
Command Panel (Mode — Geometry, Entity — Volume, Action — 
Boolean). Select Subtract in the list of operations. Set the 
following parameters: 

 Body ID: 2 (volumes from which other volumes will be 
subtracted); 

 Substract bodies (ID): 1 (the volumes to be 
subtracted);  

 Keep Originals. 

Click Apply. 
 

5. Subtract the second cylinder from the third one. 
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Select volume geometry generation section on Command Panel (Mode — Geometry, Entity — Volume, Action 
— Boolean). Select Subtract in the list of operations.  Set the following parameters: 

 Body ID: 3 (volumes from which other volumes will be subtracted); 

 Substract bodies (ID): 2 (the volumes to be subtracted);  

 Keep Originals. 

Click Apply. 

 

As a result, five generated entities are displayed in the Model Tree: Volume 1, Volume 2, Volume 3, Volume 4 and 
Volume 5. Delete the thirst three bodies by right-clicking and selecting Delete.  

Two entities: Volume 4 and Volume 5 are left in the Model Tree. 

 

6. Merge obtained entities. 

Select volume geometry generation section on 
Command Panel (Mode — Geometry, Entity — Volume, 
Action — Impirint And Merge). Select Merge Volunes in 
the list of operations. Set the following parameters: 

 Body ID: 4 5 (the volumes to be united).  

Click Apply. 
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Meshing 

1. Select meshing on curves section on Command Panel (Mode — 
Mesh, Entity — Curve, Action — Mesh). Specify the 
parameters of mesh refinement: 

 Select Curves: all (mesh will be creat on all the curves); 

 Select the way of meshing: Equal; 

 Select the meshing parameters: Interval; 

 Interval: 200.  

Click Apply Size. 

 

 

 

 

 

 

 

 

 

2. Select volume mesh 
generation section on Command Panel (Mode — Mesh, Entity — Volume, 
Action — Mesh). 

 Select volumes: all (mesh will be creat on all the volumes); 

 Select meshing scheme: Polyhedron. 

Click  Apply Scheme. 

Click Mesh. 
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Setting material and element type  

1. Create Material 1.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Materials management).  

Specify the name of the material. Material 1. Drag from the left 
column to the section Thermal of the label Thermal isotropic in 
the Material Properties column. 

Set the following parameters:  

 Thermal Expansion coefficient: 40. 

Click Apply. 

 

2. Create Material 2.  

Select setting the material properties section on Command Panel (Mode — Blocks, Entity — Materials 
management).  

Specify the name of the material. Material 1. Drag from the left column to the section Thermal of the label 
Thermal isotropic in the Material Properties column. 

Set the following parameters:  

 Thermal Expansion coefficient: 20. 

Click Apply. 
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3. Create Block 1.  

Select setting the material properties section on 
Command Panel (Mode — Blocks, Entity — Block, Action — 
Add). Set the following parameters: 

 Block ID: 1; 

 Entity list: Volume;  

 ID: 4. 

Click Apply. 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Assign the material to block 1.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Block, Action — Add). Set the following 
parameters: 

 Block ID(s): 1; 

 Select the previously created material in the list: 
Material 1. 

Click Apply. 
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5.  Create Block 2.  

Select setting the material properties section on Command 
Panel (Mode — Blocks, Entity — Block, Action — Add). Set the 
following parameters: 

 Block ID: 2; 

 Entity list: Volume; 

 ID: 5. 

Click Apply. 
 
 
 
 
 
 
 
 
 

 

6. Assign the material to block №2.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Block, Action — Set material). Set the 
following parameters: 

 Block ID(s): 2; 

 Select the previously created material in the list: 
Material 2. 

Click Apply. 
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7. Assign the element type to the both of blocks.  

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Block, Action — Element Types). Set the 
following parameters:  

 Block ID(s): all; 

 Select: Volumes; 

 Order: 1. 

Click Apply. 

 
 
 
 
 
 

 
 
 
 
 

Setting boundary conditions 

1. Set the process of convective heat exchange on the inner 
surface of the cylinder.  

Select Mode — Boundary Conditions, Entity — Convection, 
Action — Create on Command Panel. Set the following 
parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s):  10; 

 Select the way of parameters setting: Surrounding; 

 Temperature: 70; 

 Coefficient: 150. 

 Click Apply. 
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2. Set the process of convective heat exchange on the outer surface 
of the cylinder.  

Select Mode — Boundary Conditions, Entity — Convection, Action 
— Create on Command Panel. Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 15; 

 Select the way of parameters setting: Surrounding; 

 Temperature: -15; 

 Coefficient: 200. 

Click Apply. 
 

 

 

 

 

 

 

 

 

 

 

 

3.  Fix the base of the cylinder. 

Select Mode — Boundary Conditions, Entity — Displacement, Action — 
Create on Command Panel. Set the following parameters: 

 System Assigned ID; 

 Entity List: Surface; 

 Entity ID(s): 12 13 16 17 (using space after each of them); 

 Degrees of Freedom: Z-Translation; 

 DOF Value: 0. 

 Click Apply. 

 



 CAE Fidesys — User Guide (version 3.0) 

196 

 

 

Starting calculation 

1. Set the type of the problem to be solved.  

Select calculation setting section on Command Panel (Mode — 
Calculation settings, Calculation settings — Static, Static — 
General). Select Dimension – 3D. Untick next to the item 
Elasticity. Tick next to the item Heat transfer. 

Click Apply.  

  

2. In a pop-up window select a folder to save the result and enter 
the file name. 

 

3. If the calculation is finished successfully, you will see a message 
in the Console: “Calculation finished successfully at <date> 
<time>”.  

 

 

 

 

 

Results analysis 

1. Open the file with the results. You can do this in one of the 
three ways. 

 Click  Ctrl+E. 

 Select Calculation → Open Results in the Main 
Menu. Click  Open last result. 

 Select Results on Command Panel (Mode — 
Results). Click Open Results.  

 

2. Display the component of the heat flux. 

In Fidesys Viewer window set the following parameters on 
Toolbar: 

 Representation Mode: Surface; 

 Representation Field: HeatFlux. 

 

 To display the color legend scale, click the button Switch the color legend visibility on Command Panel. 

3. Select a point where you need to view the heat flux. 

In the Main Menu, select the filter Probe Location. In the tab Properties set the coordinates of the point A where 
you need to view the stress: 
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 Show Point; 

 Point (coordinates): 0.3 0 0; 

 Number of Points: 1; 

 Radius: 0. 

Click Apply. 

To apply all of the filters changes automatically, click Apply changes to parameters automatically on 
Command Panel. 

As a result, point A is displayed at the picture. 

 

 

4. View a numerical value of the heat flux   at the selected point A. 

See the heat flux values in the line HeatFlux in the tab Information in the field Data Arrays. 

 

The heat flux value is calculated using the following formula:  

 

The difference between the obtained value 6686.41 and the required one 6 687 is 0.01%. 

 

5. Download numerical data. 
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Select File → Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. 
Click ОК. The saved file is an ordinary table of numerical data which can be opened in any text editor. 

Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface. 
The following program code allows performing the steps of the above-described guide, you only need to 
manually specify the full path and name of the file to be saved. 

 
reset 
create Cylinder height 0.01 radius 0.3  
create Cylinder height 0.01 radius 0.35  
create Cylinder height 0.01 radius 0.37  
subtract body 1 from body 2 keep 
subtract body 2 from body 3 keep  
delete body 1 2 3 
merge volume 4 5 
curve all interval 200 
curve all scheme equal 
volume all scheme Polyhedron 
mesh volume all  
create material 1 
modify material 1 name 'Material 1' 
modify material 1 set property ' ISO_CONDUCTIVITY ' value 40 
create material 2 
modify material 2 name 'Material 1' 
modify material 2 set property ' ISO_CONDUCTIVITY ' value 20 
block 1 volume 4 
block 1 material 'Material 1' 
block 2 volume 5 
block 2 material 'Material 2' 
block all element solid order 2 
create convection on surface 10 surrounding 70 coefficient 150 
create convection on surface 15 surrounding -15 coefficient 200 
create displacement on surface 12 13 16 17 dof 3 fix 0 
analysis type static heattrans dim3  
calculation start path " D:/Fidesys/example.pvd" 
 
 

 It is also possible to run the file Example_9_Static_3D_Conduction.jou, by selecting Journal Editor on 
Toolbar. In a pop-up window of the main menu select File → Open and open the necessary journal file. 
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Dynamic load: nonsteady heat transfer (3D, implicit scheme)  

The 3D problem of 1D nonsteady heat transfer inside a beam is being solved.  

The picture below represents a geometric model of the problem: 

 

 

 

 

 

 

 

The beam length is 0.1 m, square cross section is 0.01x0.01 m. The temperature at the point A is TA = 0 °C, the 

temperature at the point B varies harmonically: TB = 100 sin  °C. The material parameters are isotropic, V = 35 

W/(m·°C), C = 440.5 J/(kg ·°C),  = 7 200 kg/m3. 

 

Test pass criterion is the following: temperature T at the point C (0.8;0;0) at time t = 32c is 36.60°C within 2%. 

 

Geometry creation 

1. Create the sliver parallelepiped. 

Select volume geometry generation section on Command Panel 
(Mode — Geometry, Entity — Volume, Action — Create). Select 
Brick in the list of geometric elements. Set the brick dimensions:  

 Width: 0.1; 

 Height: 0.01; 

 Depth: 0.01. 

Click Apply. 
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2. Combine left edge of the beam with the origin of coordinates. 

Set the following parameters: Select volume geometry modification section 
on Command Panel  (Mode — Geometry, Entity — Volume, Action — 
Transform). Select Move in the list of possible webcut types. Set the 
following parameters:  

 

 Volume: 1; 

 Select method: Distance; 

 X Distance: 0.05. 

Click Apply. 
 
 
 
 
 
 
 
 
 
 
 
 

Meshing 

1. Creat the mesh of hexahedrons. 

Select volume mesh generation section on Command Panel (Mode — 
Mesh, Entity — Volume, Action — Mesh): 

 Select Volumes (specify their ID): 1 (or by the command all); 

 The way of meshing: Polyhedron. 

Click  Apply Scheme. 

Click Mesh. 
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Setting material and element type 

1. Create the material. 

Select setting the material properties section on Command Panel 
(Mode — Material, Entity — Materials management).  

 

In the Materials Management window that opens, in the second 
column, click on the caption Enter the name of the material and 
write “Material 1”. Press the ENTER key. 

Select setting the material properties section on Command Panel 
(Mode — Blocks, Entity — Material, Action — Create Material). 
Enter the name for the material. Set the following parameters:  

 Density: 7200; 

 Specific Heat coefficient: 440.5; 

 Thermal conductivity coefficient: 35. 

Click Apply. 
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2. Create a block of one type of the material.  
Select setting the material properties section on Command Panel (Mode — 
Blocks, Entity — Block, Action — Manage). Select Add in the list of possible 
operations. Set the following parameters: 

 Block ID: 1; 

 Entity list: Volume; 

 ID: 1 (or by the command all). 

Click Apply. 
 
 
 
 
 

 
 

3. Assign the material to the block.  

Select setting the material properties section on Command Panel (Mode — 
Blocks, Entity — Block, Action — Set material). Set the following 
parameters: 

 Block ID(s): 1; 

 Available materials: Material 1. 

Click Apply. 

 

 

 

4. Assign the element type.  

Select setting the material properties section on Command 
Panel (Mode — Blocks, Entity — Block, Action — Element 
Types). Set the following parameters:  

 Block ID(s): 1; 

 Select: Volumes; 

 Order: 1. 

Click Apply. 
 
 
 
 
 

Setting boundary conditions 

1. Set the value of temperature applied to the left side of 
the beam.  
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Select Mode — Boundary Conditions, Entity — Temperature, Action — Create on Command Panel. Set the 
following parameters: 

 System Assigned ID; 

 Temperature Entity List: Surface; 

 Entity ID(s):  4; 

 Temperature Value: 0. 

 Click Apply. 

 

2. Set the value of temperature applied to the right side of the beam.  

Select Mode — Boundary Conditions, Entity — Temperature, Action — Create on Command Panel. Set the 
following parameters: 

 System Assigned ID; 

 Temperature Entity List: Surface; 

 Entity ID(s):  6; 

 Temperature Value: 1. 

 Click Apply. 

 

Setting time dependency of boundary conditions  

1. Set time dependency of the temperature applied to the 
right edge of the beam. 

Select Mode — Boundary Conditions. Click on the button Time 
dependency on Command Panel. The pop-up menu with the 
settings will be opened. On the left panel, select BC for which 
the time dependency will be set: Temperature 2. Put a 
checkbox next to the item Formula. Set the following 
parameters: 

 Time dependency type: Manually; 

 Enter formula: 100*sin(0.0785*t). 

 Click Apply. 
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Starting calculation 

1. Set the type of the problem to be solved.  

Select calculation setting section on Command Panel (Mode — 
Calculation settings, Calculation settings — Transient analysis, 
Transient analysis — General). Set the following calculation parameters: 

 Dimension: 3D; 

 Method: Full solution; 

 Scheme: Implicit; 

 Max time: 32; 

 Steps count: 100. 

 Elasticity: untick; 

 Heat transfer: tick; 

Click Apply.  

Click  Start Calculation. 

 

In a pop-up window select a folder to save the result and enter the file 
name. 

If the calculation is finished successfully, you will see a message in the 
Console: “Calculation finished successfully at <date> <time>”.  

Results analysis 

1. Open the file with the results.  

You can do this in one of the three ways: 
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 Click  Ctrl+E. 

 Select Calculation → Open Results in the Main Menu. Click  Open last result.  

 Select Results on Command Panel (Mode —Results). Click  Open last result. 

 

You can see the calculation results in the pop-up Fidesys Viewer window. 

 

2. There is a menu on Toolbar which allows viewing animation. It consists of a cycle of solutions calculated for 
every moment of time. Click “Last Frame” to see the model in time moment t = 32°C. 

 

 

3. Display the component of the temperature. 

In Fidesys Viewer window set the following parameters on Toolbar: 

 Representation Field: Temperature;  

 Representation Mode: Surface With Edges. 

 

The model displays the mesh resulting from application of the spectral element method and the field of 
temperature distribution. 

 

To display the color legend scale, click the button Switch the color legend visibility on Command Panel. 
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4. To graph along one of the beam edges. 

Select the filter Plot Over Line in the Main Menu. Set the 
coordinates of the points defining the line In the tab Properties: 

 Source: High Resolution Line; 

 Show Line; 

 Point 1 (coordinates): 0 -0.005 0.005; 

 Point 2 (coordinates): 0.1 -0.005 0.005; 

 Resolution: 100; 

 PassPartialArrays 

Click Apply. 

 

To apply all of the filters changes automatically, click Apply 
changes to parameters automatically on Command 

Panel. 

Click on the graph window appeared on the right side of the 
screen. 

 

 

5. Display temperature change on the graph. 

Click on the graph window, go to the tab "Display" in the filter control panel. 
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Set the Attribute Mode – Point Data  

Next, in the field “Line Series”, set up labels 
against the parameters that you want to 
display on the graph.  

Untick all the options except Temperature. 

The temperature dependency at points 
belonging to the beam edge and the 
coordinates of these point coordinates are 
displayed on the graph. 

 

 

 

 

 

 

6. Check the numerical temperature value T at the point (0.08;0;0). 

Move the cursor to the required point on the graph. You can see a tool tip with the temperature value. 



 CAE Fidesys — User Guide (version 3.0) 

208 

 

 

The difference between the obtained value 36.6617 and the required one 36.60 is  0.17%.. 

7. Download numerical data. 

Select File → Save Data in the Main Menu or click Ctrl+S. Enter the file name (*.csv format), leave it by default. 
Click OK. The saved file is an ordinary table of numerical data which can be opened in any text editor.
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Using Console Interface 
For geometry generation, meshing, setting boundary conditions and materials you can use Console Interface. 
The following program code allows performing the steps of the above-described guide, you only need to 
manually specify the full path and name of the file to be saved. 
 

reset 
brick x 0.1 y 0.01 z 0.01 
move Volume 1 x 0.05 include_merged  
volume 1 scheme polyhedron  
volume 1 size 0.001 
mesh volume 1 
create material 1 
modify material 1 name 'Material 1' 
modify material 1 set property 'DENSITY' value 7200 
modify material 1 set property 'ISO_CONDUCTIVITY' value 35 
modify material 1 set property 'SPECIFIC_HEAT' value 440.5 
block 1 add volume 1 
block 1 material 1 
block 1 element solid  
create temperature on surface 4 value 1 
create temperature on surface 6 value 1 
bcdep temperature 2 value '100*sin(0.0785*t)' 
analysis type dynamic heattrans dim3 preload on 
dynamic method full_solution scheme implicit maxtime 32 steps 100 newmark_gamma 
0.0050.005calculation start path "D:/Fidesys/test.pvd" 

 
 

 
 It is also possible to run the file Example_14_Dynamic_3D_Conduction_Spectr.jou, by selecting Journal 
Editor on Toolbar. In a pop-up window of the main menu select File → Open and open the necessary 
journal file. 
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Harmonic analysis (beam model) 

An example with a beam construction is considered. Specified structural damping. 

 

 

The model is rigidly fixed at points A, D, C, F. A force dependent on frequency is applied to the middle of the BE 
face. The sides of the structure have the same length: AB = BC = DE = EF = BG = EG = 2.5 m. Material parameters: 

Young's modulus E = 2e11 Pa, Poisson’s ratio  = 0.3, density  = 7800 kg / m3. Specified structural damping 0.1. 

 Geometry creating 

1. Create a structure and beams (lines). 

Since the structure contains edges of the same length, use 
the parameter L = 2.5. To set a parameter, enter in the 
command line # {L = 2.5}. 

  

On the toolbar, select a line creating mode (Mode - 
Geometry, Entity - Curve, Action - Create). From the drop-
down list, select Line. On the Build panel, use select Position 
and Direction. Next, enter the necessary data to create the 
first line: 

 

 Location: 0 0 0 (space separated); 

 Direction: 0 1 0; 

 Length: {L}. 

Click Apply. 

 

 

 

Specify the necessary data to create a second line: 

 Location: 0 {L} 0; 
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 Direction: 0 1 0; 

 Length: {L}. 

 

Click Apply. 

Specify the necessary data to create a third line: 

 Location: 0 {L} 0; 

 Direction: 1 0 0; 

 Length: {L}. 

  

Click Apply. 

 

Specify the necessary data to create the fourth line: 

 Location: {L} {L} 0; 

 Direction: 1 0 0; 

 Length: {L}. 

 

Click Apply. 

Specify the necessary data to create a fifth line: 

 Location: {2 * L} 0 0; 

 Direction: 0 1 0; 

 Length: {L}. 

 

Click Apply. 

Specify the necessary data to create the sixth line: 

 Location: {2 * L} {L} 0; 

 Direction: 0 1 0; 

 Length: {L}. 

 

Click Apply. 
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Splicing tops on received beams. On the toolbar, select the 
vertex creating mode (Mode - Geometry, Entity - Vertex, 
Action - Merge). Specify: 

 Vertex ID: all. 

 

Click Apply. 

 

Beam structures was created 
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 Meshing 

1.  On the command panel, select the volume mesh mode (Mode - 
Mesh, Entity - Curve, Action – Mesh). Specify the following 
parameters: 

 Select curves: all; 

 Settings for curve: Equal; 

 Approximate size: 0.1. 

Click Apply Size. 

Click Mesh. 

 

 
 
 
 
 
 
 
 
 
 
 

Specifying the material and type of element 

1.  Create a material. 

Select setting the material properties section on Command Panel 
(Mode — Material, Entity — Materials management).  

In the Materials Management window that opens, in the second 
column, click on the caption Enter the name of the material and 
write “Material 1”. Press the ENTER key. 

In the left column, select Elasticity - Hooke Material. Select with 
the mouse the characteristic Young's modulus. Hold down the left 
mouse button and drag the label to Material Properties. Double-
click in the Value field next to Young’s modulus and enter the 
number 2e11.Similarly, from the Hooke Material section add the 
Poisson Ratio 0.3, Density: 7800. 

Click Apply.  

Close the window. 
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2.  Create a block of the one type of material. 

On the command panel, select the mode for setting material 
properties (Mode - Blocks, Entity - Block, Action - Add). Set the 
following parameters: 

 Block ID: 1; 

 Entity list: Curve; 

 Entity ID (s): all. 

Click Apply. 
 



 CAE Fidesys — User Guide (version 3.0) 

215 

 

 

3. Assign the material to the block. 

On the command panel, select the mode for setting material properties 
(Mode - Blocks, Entity - Block, Action - Set Material). Set the following 
parameters: 

 Block ID (s): 1; 

 Available materials: Material 1. 

Click Apply.  
 
 

 

 

 

 

 

 

4.  Assign an item type. 

On the command panel, select the mode for setting material properties 
(Mode - Blocks, Entity - Block, Action - Element types). Set the 
following parameters: 

 Block ID (s): 1 or all; 

 Category: Beam; 

 Order: 1. 

Click Apply. 

 
 
 

Beam section setting 

1.  Specify the section of the beams. On the command panel, 
select setting material properties mode (Mode - Blocks, 
Entity - Beam Properties). Set the following parameters: 

 Block ID: 1; 

 CS rotation angle: 0; 

 Calculate relative to: Centroid; 

 Select profile: Ellipse; 

 Minor axis (b): 0.1; 

 Major axis (a): 0.1. 

Click Apply. 

Setting boundary conditions 
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1.  Fix the vertices A, D, C, F through all displacements and rotations. 

On the command panel, select Mode - Boundary Conditions, Entity - Displacement, Action - Create. Set the 
following parameters: 

 System assignment ID; 

 Entity list: Vertex; 

 Entity ID(s): 1 4 9 12 (or select the vertices with the mouse by pressing the Ctrl key); 

 Degrees of freedom: All; 

 DOF Value: 0 (can not fill). 

Click Apply. 
 
 
 
 
 
 
 
 
 
 
 

2. Apply a force dependent on frequency. 

On the command panel, select Mode - Boundary Conditions, Entity - Force, Action - Create. Set the following 
parameters: 

 System assignment ID; 

 Force Entity list: Vertex; 

 Entity ID(s): 6 (or select a vertex with the mouse, as shown in the figure); 

 Force: 1; 

 Direction: 0 0 -1 (negative direction along the z axis). 
Click Apply 
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3. Set the frequency dependence.  

On the command panel, select Mode - BC Dependency. In the 
BC Dependency window that appears, select the boundary 
condition Force 1 in the left column, in the Formula panel 
from the drop-down list, select Harmonic. Enter the following 
data: 

 Amplitude: 1e5; 

 Phase: 0. 

Click Apply 
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Run calculation 

1. Set the type of problem you want to solve. 

On the command panel, select the calculation settings module 
(Mode - Calculation Settings, Calculation Settings - Harmonic - 
General). Set the following calculation parameters: 

 Dimension: 3D; 

 Method: Mod superposition; 

 Maximum frequency number: 10; 

 Frequency Interval: 0-200; 

 Frequency step: 0.5; 

Click Apply. 

 

 

 

 

 

 

 

 

 

 

2. Specify structural damping. 

On the command panel, select the calculation settings 
module (Mode - Calculation Settings, Calculation Settings - 
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Harmonic - Damping). Set the following calculation parameters: 

 Structural damping: 0.1. 

Click Apply. 

Click Start calculation. 

 

 

3. In the window that appears, select the directory in which the result will be stored, and enter the file name. 

4. In the case of a successful calculation, the console displays the message: “Calculation finished successfully at 
<date> <time>”. 

 
 
 

Results analysis 

1.  Compare the results displayed on the command line with the results below: 

 

2. Open the file with the results. 

This can be done in two ways: 

 Press Ctrl + E. 

 From the main menu, select Results. Click Open Last 
Result. 

 
The Fidesys Viewer window will appear, in which you can view the 
calculation results. 
 

3.  In the standard line, select Filters -> Alphabetical > Harmonic 
Analysis. 
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The plot of Displacement (Amplitude) versus frequency must be plotted for node 2 (coincides with vertex B). 
For the Harmonic analysis filter in the Tree, in the Properties tab, specify: 

 Node ID: 2. 

Click Apply. 

            

In the section Row Parameters for the X-axis that appears, select only the Displacement Amplitude Z (Harmonic 
Analysis). 
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On the right side of the screen received the desired graph. 
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Hover over one of the peaks, then the pop-up text will display the amplitude value corresponding to the 
frequency. 

 

Using the console interface 
Geometry generation, mesh generation, setting boundary conditions and materials can be performed using the 
console interface. Below is the program code that allows you to perform the steps of the above manual, you only 
need to specify the full path and name of the saved file. 
 

reset 
#{L=2.5} 
create curve location 0 0 0 direction 0 1 0 length {L} #1 
create curve location 0 {L} 0 direction 0 1 0 length {L} #2 
create curve location 0 {L} 0 direction 1 0 0 length {L} #3 
create curve location {L} {L} 0 direction 1 0 0 length {L} #4 
create curve location {2*L} 0 0 direction 0 1 0 length {L} #5 
create curve location {2*L} {L} 0 direction 0 1 0 length {L} #6 
merge all 
curve all size 0.1 
curve all scheme equal 
mesh curve all 
create material 1  
modify material 1 name "material1" 
modify material 1 set property 'DENSITY' value 7800 
modify material 1 set property 'POISSON' value 0.3 
modify material 1 set property 'MODULUS' value 2e+11 
block 1 add curve all 
block 1 element beam order 1 
block 1 material 'material1' 
block 1 attribute count 7 
block 1 attribute index 1 value 1 name 'Ellipse' 
block 1 attribute index 2 value 0 name 'ey' 
block 1 attribute index 3 value 0 name 'ez' 
block 1 attribute index 4 value 0 name 'angle' 
block 1 attribute index 5 value 1 name 'section_id' 
block 1 attribute index 6 value 0.1 name 'geom_b' 
block 1 attribute index 7 value 0.1 name 'geom_a' 
create displacement on vertex 1 4 9 12 dof all fix 
create force on vertex 6 force value 1 direction nz 
bcdep force 1 value "harmonic(1e5,0.0, f, time)" 
analysis type harmonic elasticity dim3 
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harmonic method mode_superposition interval from 0 to 200 max_freq_num 10 frequency_step 
0.5 
damping structural 0.1 mass_matrix 0 stiffness_matrix 0 
output nodalforce off record3d off log on vtu on0.005 
calculation start path "D:/Fidesys/test.pvd" 
 

 

 
 You can also run the Example_11_Harmonic_3D_Beam.jou file by selecting the journal editor on the 
toolbar. In the appeared window in the main menu, select File → Open and open the required log file. 

 
 
 

Bounded Contact Simulation 

An example of the calculation of a structure consisting of several volumes that are not merged with each other is 
considered. There is a geometric gap between the two volumes, so instead of “gluing” the volumes, the bounded 
contact will be used. The model represents a quarter of the original part. 

 

  

 
The model is fixed on the lateral faces of the symmetry conditions. The inner surface of the hole is fixed in all 
degrees of freedom. A pressure of 1 MPa is applied to the upper face of the part. Material parameters: Young's 

modulus E = 2e11 Pa, Poisson’s ratio  = 0.3. 
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Geometry creation 

1.  Import geometry 

In the standard line select Menu - File - Import. Specify the path to the Geom_example_contact.stp file. In the 
window that appears, click Finish with all the default values of settings. 

 

In the Tree on the left you can see three volumes into which the model is separated. All three volumes have no 
common surfaces. 

 

Meshing 

1. On the command panel, select the volume mesh mode (Mode - Mesh, Entity - Volume, Action - Intervals). 
Specify the following parameters: 

 In the drop-down list, select: Approximate size; 

 Choice of volumes: 1; 

 Approximate size: 0.1. 

Click Apply Size. Click Mesh. 
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2. On the command bar, select the volume mesh building mode (Mode - Mesh, Entity - Volume, Action - 
Intervals). Specify the following parameters: 

 In the drop-down list, select: Approximate size; 

 Select volumes: 2; 

 Approximate size: 0.3. 

Click Apply Size. 

Click Mesh. 

 

 

 

3. On the command panel, select the volume mesh creating mode (Mode - Mesh, Entity - Volume, Action - 
Intervals). Specify the following parameters: 

 In the drop-down list, select: Approximate size; 

 Select volumes: 2; 

 Approximate size: 0.3. 

Click Apply Size. 

Click Mesh. 



 CAE Fidesys — User Guide (version 3.0) 

226 

 

 
 

Thus, a non-conformal finite element mesh was created on the model. 
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Specifying the material and type of element 

1. Create a material. 

Select setting the material properties section on Command 
Panel (Mode — Material, Entity — Materials management).  

In the Materials Management window that opens, in the 
second column, click on the caption Enter the name of the 
material and write “Material 1”. Press the ENTER key. 

In the left column, select Elasticity - Hooke Material. Select 
with the mouse the characteristic Young's modulus. Hold 
down the left mouse button and drag the label to Material 
Properties. Double-click in the Value field next to Young’s 
modulus and enter the number 2e11.Similarly, from the 
Hooke Material section add the Poisson Ratio 0.3 

Click Apply. Close the window. 
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2. Create a block of the one type of material. 

On the command panel, select Mode - Blocks, Entity - 
Block, Action - Add. Set the following parameters: 

 Block ID: 1; 

 Entity list: Volume; 

 Entity ID(s): all. 

Click Apply. 
 

3.  Assign the material to the block. 

On the command bar, select Mode - Blocks, Entity - Block, 
Action - Set Material. Set the following parameters: 

 Block ID (s): 1; 

 Available materials: material1. 
Click Apply. 

 
 

 

 

 

4. Assign an element type. 

On the command panel, select the mode for setting 
material properties (Mode - Blocks, Entity - Block, Action 
- Element types). Set the following parameters: 

 Block ID (s): 1 or all; 

 Category: Solid; 

 Order: 1. 

Click Apply. 
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Setting boundary conditions 

1.  Fix the sides of the part with the condition of symmetry. 

On the command panel, select Mode - Boundary Conditions, 
Entity - Displacement, Action - Create. Set the following 
parameters: 

 System assignment ID; 

 Entity list: Surface; 

 Entity ID(s): 2 27 38 (or select the vertices with the 
mouse while holding down the Ctrl key); 

 Degrees of freedom: X-Translation Disp; 

 DOF Value: 0 (can not fill). 

Click Apply. 

 
  
 

On the command panel, select Mode - Boundary Conditions, 
Entity - Displacement, Action - Create. Set the following 
parameters: 

 System assignment ID; 

 Entity list: Surface; 

 Entity ID(s): 5 22 23 36 (or select the vertices with 
the mouse by pressing the Ctrl key); 

 Degrees of freedom: Z-Translation Disp; 

 DOF Value: 0 (can not fill). 

Click Apply. 

 

  

2. Fix the hole. 

On the command panel, select Mode - Boundary Conditions, 
Entity - Displacement, Action - Create. Set the following 
parameters: 

 System assignment ID; 

 Entity list: surface; 

 Entity ID(s): 30 (or select the vertices with the mouse while 
holding down the Ctrl key); 

 Degrees of freedom: All; 

 DOF Value: 0 (can not fill). 

Click Apply. 
 

3.  Apply pressure to the top face. 
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On the command panel, select Mode - Boundary conditions, Entity - Pressure, Action - Create. Set the 
following parameters: 

 System assignment ID; 

 Entity list: surface; 

 Entity ID(s): 17 37; 

 Magnitude Value: 1e6 (the exponential type of the number is supported using the Latin letter “e”). 

Click Apply. 

 

 

 

4.  Set the contact condition. 

On the command panel, select Mode - Boundary Conditions, 
Entity - Contact, Action - Create. Set the following parameters: 

 Auto selection; 

 Entity List: Global; 

 Friction Value: 0; 

 Offset: 0.055; 

 Type: Tied; 

 Method: Auto. 

Click Apply. 

 

In the Tree on the left, find the Boundary Conditions - 
Constraints - Contacts. Automatically identified two contact 
pairs. 
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Run calculation 

1.  Set the type of problem you want to solve. 

On the command panel, select the calculation settings mode (Mode 
- Calculation Settings - Static - General). Set the following 
calculation parameters: 

 Dimension: 3D; 

 Model: Elasticity. 

Click Apply. 

 

2. In the window that appears, select the directory in which the 
result will be saved, and enter the file name. 

3. In the case of a successful calculation, the console displays the 
message: “Calculation finished successfully at <date> <time>”. 
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Results analysis 

1.  Open the results file. 

This can be done in two ways: 

 Press Ctrl + E. 

 From the main menu, select Results. Click Open 
Last Result. 

The Fidesys Viewer window will appear, in which you can view the 
calculation results. 

2.  Display the Contact Status Node for the model. 

 

 

 

 

 

3. Display displacements for the deformed view of the model. 

Specify the scale of 2000. 
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Using the console interface 

Geometry generation,mesh generation, setting boundary conditions and materials can be performed using the 
console interface. Below is the program code that allows you to perform the steps of the above manual, you only 
need to specify the full path and name of the saved file. 

 
reset 
import step "D:/Fidesys/Geom_example_contact.stp" heal 
volume 1 size 0.1 
mesh volume 1 
volume 2 size 0.3 
mesh volume 2  
volume 3 size 0.2 
mesh volume 3  
create material 1 
modify material 1 name 'material1' 
modify material 1 set property 'MODULUS' value 2e+11 
modify material 1 set property 'POISSON' value 0.3 
block 1 add volume all 
block 1 material 1 
block 1 element solid  
create displacement on surface 2 27 38 dof 1 fix  
create displacement on surface 5 22 23 36 dof 3 fix  
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create displacement on surface 30 dof all fix  
create pressure on surface 17 37 magnitude 1e6  
create contact autoselect friction 0.0 offset 0.055 ignore_overlap off type tied method 
auto 
analysis type static elasticity dim3 
calculation start path "D:/Fidesys/test.pvd" 

 
You can also run the Example_12_Contact_3D.jou file by selecting the journal editor on the toolbar. In 
the appeared window in the main menu, select File → Open and open the required log file. 

 

 

Change of pressure in well  
 
The problem of finding the plastic zone around the well in the 
dynamics, taking into account the pore pressure until 
instability appears in the form of plastic deformation bands, is 
solved. 

A square plate of considerable width and unit thickness with a 
small circular hole of radius a in its center is subjected to all-

round uniform pressures with stresses σ1 in the direction of 
the X1 axis and σ2 in the direction of the X2 axis. On the 
lateral faces of the depending on time pore pressure applied. 
There is pressure on a round hole, also depending on time. 

It is required to calculate plastic zones around the well in 
dynamics. 

 

 Geometry creating 

1.  Create a surface. 

On the command panel, select the mode for constructing volume 
geometry (Mode - Geometry, Entity - Surface, Action - Create). 
From the list of geometric primitives, select Rectangle. Set block 
sizes: 

 Width: 10; 

 Height: 10; 

 Location: ZPlane. 

Click Apply. 
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2.  Moving to the origin of the coordinate system 

It is required to move the surface so that one of the vertices is 
at the origin of the coordinate system. 

On the command panel, select the mode for create volume 
geometry (Mode - Geometry, Entity - Surface, Action - 
Transform). From the list of geometric primitives, select 
Move. Set the movement parameters: 

 Select method: distance; 

 X distance: 5; 

 Y Distance: 5. 

Click Apply. 

 

3.  Selection of geometric entities 

4. In the standard line we find the panel with the choice of 
geometric entities. 

Click Select Vertices. 

 

 

 

 

 

 

 

Click on the left bottom vertex of the created surface and look 
at the obtained coordinates on the Properties Page on the left. Make sure that the vertex has moved to the 
origin. 
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5.  Creating a circular hole 

It is required to make a cut in the plate using an auxiliary circle. 

On the command panel, select the mode for creating volume geometry 
(Mode - Geometry, Entity - Surface, Action - Create). From the list of 
geometric primitives, select Circle. Set block sizes: 

 Radius: 1; 

 Location: Zplane. 

Click Apply. 
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6. On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Surface, 
Action - Boolean). From the list of logical operations, select Subtract. Set the parameters of the logical 
operation: 

 A surface ID(s): 1; 

 B surface ID(s): 2; 

Click Apply. 

 

Meshing 

1.  Changing the mesh settings 

To automatically create a quadrilateral mesh, we will change the default settings. In the standard line, select 
Tools - Settings. In the opened window in the left column select the Mesh Defaults. On the Default Element 
Type panel we select the Hex / Quad. 

Click Save. 
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2. In the command panel, select the mesh generation mode on 
curves (Mode - Mesh, Entity - Curve, Action - Mesh). Specify the 
degree of reducing mesh: 

 Select curves: 7; 

 Select the mesh generation method: Bias; 

 Select the mesh generation method: Intervals & Bias; 

 Interval count: 70; 

 Bias Factor: 1.04; 

 Start vertex ID: 7 (left vertex on the given curve). 

Click Apply Size. 

Click Mesh. 

 

 

 

 

 

 

 

 

 

 

 

 

3.   
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4. On the command panel, select the mesh generation mode on 
curves (Mode - Mesh, Entity - Curve, Action - Mesh). Specify the 
degree of reducing mesh: 

 Select curves: 8; 

 Select the mesh generation method: Bias; 

 Select the mesh generation method: Intervals & Bias; 

 Bias Factor: 70; 

 Bias Factor: 1.04; 

  Start vertex ID: 6 (lower vertex on this curve). 

Click Apply Size. 

Click Mesh. 
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5.  In the command panel, select the mesh generation module on curves 
(Mode - Mesh, Entity - Curve, Action - Mesh). Specify the degree of 
reducing mesh: 

 Curve selection: 6 1 4 (separated by spaces); 

 Select the mesh generation method: Equal; 

 Set the flag: Interval; 

 Indicate the number of intervals: 34. 

Click Apply Size. 

Click Mesh. 

 

 

 

 

 

 

 

 

6.  On the command panel, select the surface mesh generation mode 
(Mode - Mesh, Entity - Surface, Action - Intervals). 

 Automatic size; 

 Surface selection: 3. 

Click Mesh. 
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Specifying the material and type of element 

1.  Create a material. 

On the command panel, select the mode for setting material 
properties (Mode —Material, Entity - 

Materials management). In the Material Management widget 
that opens, in the middle column specify the name of the material 
material. In the properties column, open the Elasticity list and 
drag the name Hooke Material into the Material Properties 
column. 

Set the following parameters: 

 Young's modulus: 1e9; 

 Poisson's ratio: 0.25. 

In the left column, go to the General section and select Density. Drag the mouse into the right column and 
specify the value 2650. 

 Density: 2650. 

In the left column, go to the Plasticity section and select the Drucker-Prager Second Strength Criterion. 

 Cohesion: 2e6; 

 Internal friction angle: 20; 

 Dilatancy angle: 0.001. 

In the left column go to the section Geomechanics - Biot Isotropic model. 

 Porosity: 0.25; 

 Permeability: 1e-12; 

 Fluid’s viscosity: 0.005; 

 Biot alpha: 0.8; 

 Fluid’s bulk modulus: 1e9. 

Click Apply. 
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2. Create a block of the one type of material. 

On the command panel, select the mode for setting material 
properties (Mode - Blocks, Entity - Block, Action - Add). Set the 
following parameters: 

 Block ID: 1; 

 Entity List: Surface; 

 Entity ID(s): 3. 
Click Apply.  
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3.  Assign the material to the block. 

On the command panel, select the mode for setting material 
properties (Mode - Blocks, Entity - Block, Action - Set Material). 
Set the following parameters: 

 B
lock ID (s): 1; 

 Available material: material1. 
 
Click Apply. 
 
 
 
 
 
 
 
 
 
 

 

4.  Assign an element type. 

On the command panel, select the mode for setting material 
properties (Mode - Blocks, Entity - Block, Action - Element types). 
Set the following parameters: 

 Block ID (s): 1; 

 Category: Plane; 

 Order: 2. 

Click Apply. 
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Setting boundary conditions 

1. Apply pressure to the right side curve. 

On the command panel, select Mode - Boundary conditions, Entity - 
Pressure, Action - Create. Set the following parameters: 

 System Assignet ID; 

 Pressure Entity List: Curve; 

 Entity ID(s): 4; 

 Magnitude Value: 28e6 (the exponential type of number 
is supported using the Latin letter “e”). 

Click Apply.  

 
 

2.  Apply pressure to the right side curve. 

On the command panel, select Mode - Boundary conditions, Entity - 
Pressure, Action - Create. Set the following parameters: 

 System Assignet ID; 

 Pressure Entity List: Curve; 

 Entity ID(s): 1; 

 Magnitude Value: 32e6 (the exponential type of number 
is supported using the Latin letter “e”). 

Click Apply. 

 

 

 

3.  Set the time-dependent load on the model's notch. 

On the command panel, select Mode - Boundary conditions, 
Entity - Pressure, Action - Create. Set the following parameters: 

 System Assignet ID; 

 Pressure Entity List: Curve; 

 Entity ID(s): 6; 

 Magnitude Value: 0; 

Click Apply. 

 

 

 

On the command panel, select Mode - Boundary conditions, Entity - Set time and/or coordinate BC 
dependency. 

In the appeared BC Dependencies window set the following parameters: 
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 BC name: Pressure 3; 

 Select the Formula flag: Custom; 

 In the field below enter (25e6) -0.6e6 * t / 3600. 

 

Click Apply. 
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4. Specify symmetric fixing. 

On the command panel, select Mode - Boundary Conditions, Entity - 
Displacement, Action - Create. Set the following parameters: 

 System Assignet ID; 

 Entity List: Curve; 

 Entity ID(s): 7; 

 Degrees of freedom: Y-Translation Disp; 

Click Apply. 

 

Similarly, set the second fixture for the line 8. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

On the command panel, select Mode - Boundary Conditions, Entity - 
Displacement, Action - Create. Set the following parameters: 

 System Assignet ID; 

 Entity List: Curve; 

 Entity ID(s): 8; 

 Degrees of freedom: X-Translation Disp; 

Click Apply. 
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5.  Set the pore pressure. 

On the command panel, select Mode - Boundary conditions, 
Entity - Pore pressure, Action - Create. Set the following 
parameters: 

 System Assignet ID; 

 Entity List: Curve; 

 Entity ID(s): 1 4 (in the ID field, numbers are 
separated by spaces); 

 DOF Value: (25e6) -0.6e6 * t / 3600. 

Click Apply. 
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Run the calculation 

1.  Set the solver parameters. 

On the command panel, select the calculation settings module 
(Mode - Calculation Settings, Calculation Settings - Transient 
analysis, Transient - General). Set the following parameters: 

 Dimension: 2D; 

 Plain state: Plane strain; 

 Max time: 15000; 

 Steps count: 1000; 

Check the Preload model box; 

In the Models section, select the check boxes for Elasticity, 
Plasticity, Pore fluid transfer. 

Select the check box for Set implicit scheme options. 

In the field Newmark algorithm gamma, enter 0.1. 

Click Apply. 

Click Start calculation. 

 

2. In the window that appears, select the directory in which the 
result will be saved, and enter the file name. 

3. In case of a successful calculation, the console will display the 
message: “Calculation finished successfully at <date> <time>”. 
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Results analysis 

1. Open the file with the results. This can be done in three 
ways. 

 Press Ctrl + E. 

 From the main menu, select Calculation → 
Results. Click Open Last Result. 

 

View the calculation results in the Fidesys Viewer window. 

To automatically apply changes to all filters, click the 
corresponding button Apply changes to parameters automatically on the command bar. 

 

Find in the standard line, the Edit color map icon.  

 

On the Color discretization panel, in the Number of table values field, set the value to 6. 

In the top pane, select the calculation result data to display. From the first drop-down list, select Stress, and from 
the second - Mises. 

The results of the Mises Stress are presented below (the default results are for the last step of the calculation at 
the time point of 150000 s)  

 

 
Results - Mises Stress 

Similarly, we will display the remaining results.  
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Complete the model and consider plastic deformations on the full plate. Use the Filter - Alphabetical - Flip. On 
the property page, in the Plane field, indicate X. Then we apply the filter Flip again to this filter, but in the Plane 
field, we specify Y. 

 

On another color scheme, the kind distribution of plastic strains may be more pronounced. 

Results - Plastic strain on a full plate 

Results - Plastic Strain (Mises) 
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Estimate the safety margin 

In the standard line, select Filters → Alphabetical Index → Safety Factor. 

Select the fields to display on the model - Safety Factor and Coulomb-More Theory. 

 

 
The result of the calculation of the safety factor according to the theory of Coulomb-More 

Results - Plastic strain on the full plate (another color scheme) 
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Thus, the calculation of the plastic zone around the well was made in dynamics, taking into account the pore 
pressure until instability appears in the form of plastic deformation bands. 

Using the console interface 
 
Geometry creation, mesh generation, setting boundary conditions and materials can be performed using the 
console interface. Below is the program code that allows performing the steps of the above manual, you need 
only to specify the full path and name of the saved file. 

 
reset 
set node constraint on 
create surface rectangle width 10 height 10 zplane 
move surface 1 x 5 y 5 
create surface circle radius 1 zplane  
subtract body 2 from body 1 
curve 7 interval 70 
curve 7 scheme bias factor 1.04 start vertex 7  
mesh curve 7 
curve 8 interval 70 
curve 8 scheme bias factor 1.04 start vertex 6  
mesh curve 8 
curve 6 interval 34 
curve 1 4 interval 34 
mesh curve 1 4 6  
mesh surface all 
create material 1 
modify material 1 name 'material' 
modify material 1 set property 'MODULUS' value 1e+09 
modify material 1 set property 'POISSON' value 0.25  
modify material 1 set property 'DENSITY' value 2650 
modify material 1 set property 'COHESION' value 2e+06 
modify material 1 set property 'INT_FRICTION_ANGLE' value 20 
modify material 1 set property 'DILATANCY_ANGLE' value 0.0001 

The result of the calculation of the safety factor according to the theory of Mogi- Coulomb 
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modify material 1 set property 'BIOT_ALPHA' value 0.8 
modify material 1 set property 'POROSITY' value 0.25 
modify material 1 set property 'PERMEABILITY' value 1e-12 
modify material 1 set property 'FLUID_VISCOCITY' value 0.005 
modify material 1 set property 'FLUID_BULK_MODULUS' value 1e9  
block 1 add surface all 
block 1 element type quad8 
block 1 material 'material' 
create pressure on curve 4 magnitude 28e6 
create pressure on curve 1 magnitude 32e6 
create pressure on curve 6 magnitude 0 
bcdep pressure 3 value '(25e6)-0.6e6*t/3600' 
create displacement on curve 7 dof 2 fix 0 
create displacement on curve 8 dof 1 fix 0 
create porepressure on curve 1 4 value 25e6 
create formula 1 '(25e6)-0.6e6*t/3600' 
create porepressure on curve 6 formula 1 
analysis type dynamic elasticity plasticity porefluidtrans dim2 planestrain preload on 
dynamic method full_solution scheme implicit maxtime 150000 timestep 1000 newmark_gamma 
0.1 
nonlinearopts maxiters 2000 minloadsteps 1 maxloadsteps 10000000 tolerance 1e-4 targetiter 
5 
calculation start path 'D:\Kirsch_pore.pvd' 

 
 

You can also run the Example_13_Plasticity_2D.jou file by selecting the journal editor on the toolbar. In 
the appeared window in the main menu, select File → Open and open the required log file. 
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The loading history of the elastic-plastic plate 

Hinton E. Fundamental Tests for Two and Three-dimensional, Small Strain, Elastoplastic Finite Element Analysis / 
Emest Hinton, M.H. Ezatt. - NAFEMS, 1987. 

The problem of tension-compression of a square plate is solved. Material parameters: E = 250e3 N / mm2,  = 
0.25, yield strength c = 5 N / mm2. The model is meshed into one finite element. The left and bottom sides are 
fixed perpendicularly. The boundary conditions are presented in the figure below: 

 

Geometry creating 

1. Create a square plate. 

On the command panel, select the mode for creating volume 
geometry (Mode - Geometry, Entity - Surface, Action - Create). 
From the list of geometric primitives, select Rectangle. Set block 
sizes: 

 Width: 1; 

 Location: Zplane. 

Click Apply. 
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2. Move the surface to the origin of CS. 

On the command panel, select the mode for creating volume 
geometry (Mode - Geometry, Entity - Surface, Action - 
Transform). From the list of possible transformations, select 
Move. Set the parameters: 

 Surface ID(s): 1; 

 Including Merged: uncheck; 

 Select method: Distance; 

 X Distance: 0.5; 

 Y Distance: 0.5. 

Click Apply.  

Thus, the lower left corner of the plate has moved to the origin of 
CS. 

 

 

Meshing 

1. On the command panel, select the meshing mode on the 
curves (Mode - Mesh, Entity - Curve, Action - Mesh). 
Specify the degree of refining mesh: 

 Select Curves: all; 

 Select the meshing method: Equal; 

 Select the meshing options: Interval; 

 Interval: 1. 

Click Apply Size. 

Click Mesh. 

 

 

 

 

 

2. On the command panel, select the surface meshing mode 
(Mode - Mesh, Entity - Surface, Action - Mesh): 

 Select the mesh scheme: Automatically Calculate; 

 Select Surfaces: all. 

 

Click Apply Scheme. 

Click Mesh. 
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Specifying the material and element type 

1. Create material 

On the command panel, select the mode for setting material properties (Mode - Material, Entity - Materials 
Management). Specify the name of the material Material 1. Drag the Hooke Material inscription from the left 
column into the Material Properties column. Set the following parameters: 

 Young’s modulus: 250e3; 

 Poisson ratio: 0.25; 

In the window on the left, go to the section Plasticity – Mises Criterion. Drag the Yield strength feature into the 
Material Properties window. Enter value: 

 Yield strength: 5. 

 

Click Apply. 

 

2. Create a block of the one type of material. 

On the command panel, select the mode for setting material 
properties (Mode - Blocks, Entity - Block, Action - Add). Set the 
following parameters: 

 Block ID: 1; 

 Entity list: Surface; 

 Entity ID(s): 1 (or by command all). 

Click Apply.  
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3. Assign Material to Block 

On the command panel, select the mode for setting material 
properties (Mode - Blocks, Entity - Block, Action - Set Material). 
Set the following parameters: 

 Block ID(s): 1; 

 Select a previously created material from the list: Material 
1. 

Click Apply. 

 

4. Assign an element type. 

On the command panel, select the mode for setting material 
properties (Mode - Blocks, Entity - Block, Action - Element 
types). Set the following parameters: 

 Block ID(s): 1; 

 Category: Plane; 

 Order: 2. 

Click Apply. 

 

Setting boundary conditions 

1. Fix curve 3 in the Y direction. 

On the command panel, select Mode - Boundary Conditions, 
Entity - Displacement, Action - Create. Set the following 
parameters: 

 System assigned ID; 

 Entity list: Curve; 

 Entity ID(s): 3; 

 Degrees of freedom: Y-Translation Disp; 

 DOF Value: 0. 

Click Apply. 
 

2. Fix curve 2 in the X direction. 

On the command panel, select Mode - Boundary Conditions, 
Entity - Displacement, Action - Create. Set the following parameters: 

 System assigned ID; 

 Entity list: Curve; 

 Entity ID(s): 2; 

 Degrees of freedom: X-Translation Disp; 

 DOF Value: 0. 

Click Apply. 
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3. Fix curve 4 in the X direction. 

On the command panel, select Mode - Boundary Conditions, Entity - Displacement, Action - Create. Set the 
following parameters: 

 System assigned ID; 

 Entity list: Curve; 

 Entity ID(s): 4; 

 Degrees of freedom: X-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

 

4. Fix curve 1 in the Y direction. 

On the command panel, select Mode - Boundary Conditions, Entity - Displacement, Action - Create. Set the 
following parameters: 

 

 System assigned ID; 

 Entity list: Curve; 

 Entity ID(s): 1; 

 Degrees of freedom: Y-Translation Disp; 

 DOF Value: 0. 

Click Apply. 

 

 

Set the dependence of the BC on the time and / or coordinates 

1. Set the dependence of the BC on the time and / or coordinates. 

On the command panel, select Mode – BC Dependency.  

 

Click Displasement 3 and choose panel Table in the right side. Set the flag: Time and fill in the table as follows: 
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Click Apply. 

 

2. Create table 2 for displacement 4. 

Click Displasement 4 and choose panel Table in the right side. Set the flag: Time and fill in the table as follows: 

 

Click Apply. 

Run calculation 
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1. Set the type of problem  you want to solve. 

On the command panel, select the calculation settings module (Mode - Calculation Settings, Calculation 
Settings - Static, Static - General). 

Dimensions: 2D; 

Plaine state: Plane straine; 

Model: Elasticity, Plasticity; 

Load steps count: 8. 

Click Apply. 

Click Start calculation. 

 

 

2. In the window that appears, select the directory in which the result will be saved, and enter the file name. 

3. In the case of a successful calculation, the console displays the message: “Calculation finished successfully 
at" date time ". 

Results analysis 

1. Open the file with the results. This can be done in three ways. 

Press Ctrl + E. 

In the main menu, select Calculation → Open Results. Click Open Last Result. 

On the command panel, select a Results (Mode - Results). Click Open  last Results. 

To analyze the results, go to the Fidesys Viewer window. 

 To automatically apply changes to all filters, click the corresponding button Apply changes to parameters 
automatically on the command bar. 

2. Connect the filter to Warp by vector (Menu - Filters - Alphabetical Index - Warp by vector). Or use the 
corresponding button on the command bar: 

 

For this filter, on the Properties tab, set: 

 Vector: Displacement; 

 Scale multiplier: 10,000; 

Click Apply (unless Apply changes to parameters automatically is enabled). 

3. In the top pane, select the payroll result data to display. From the first drop-down list, select Displacement, 
from the second - Magnitude. 

  

In the step view panel, set step 1. You should see the plate image in the initial state. Next, click on Play. 

. You should see a consistent stretching, and then compression of the plate in accordance with the 
loading history. 
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Thus, the calculation of the stress-strain state with the loading history of the plate was made. 

Using the console interface 

Geometry creating, meshing, setting boundary conditions and materials can be performed using the console 
interface. Below is the program code that allows you to perform the steps of the above manual, you only need to 
specify the full path and name of the saved file. 

 
reset 
create surface rectangle width 1 zplane 
move surface 1 x 0.5 y 0.5 
curve all interval 1 
curve all scheme equal 
mesh curve all 
mesh surface all 
create material 1 
modify material 1 set property 'MODULUS' value 250e3 
modify material 1 set property 'POISSON' value 0.25 
modify material 1 set property 'MISES_YIELD_STRENGTH' value 5 
block 1 add surface 1 
block 1 material 1 
block 1 element plane order 2 
create displacement on curve 3 dof 2 fix 0 
create displacement on curve 2 dof 1 fix 0 
create table 1 
modify table 1 dependency time 
modify table 1 insert row 1 
modify table 1 cell 1 1 value 0 
modify table 1 cell 1 2 value 0.0 
modify table 1 insert row 2 
modify table 1 cell 2 1 value 1 
modify table 1 cell 2 2 value 2.5e-5 
modify table 1 insert row 3 
modify table 1 cell 3 1 value 2 
modify table 1 cell 3 2 value 5e-5 
modify table 1 insert row 4 
modify table 1 cell 4 1 value 3 
modify table 1 cell 4 2 value 5e-5 
modify table 1 insert row 5 
modify table 1 cell 5 1 value 4 
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modify table 1 cell 5 2 value 5e-5 
modify table 1 insert row 6 
modify table 1 cell 6 1 value 5 
modify table 1 cell 6 2 value 2.5e-5 
modify table 1 insert row 7 
modify table 1 cell 7 1 value 6 
modify table 1 cell 7 2 value 0.0 
modify table 1 insert row 8 
modify table 1 cell 8 1 value 7 
modify table 1 cell 8 2 value 0.0 
modify table 1 insert row 9 
modify table 1 cell 9 1 value 8 
modify table 1 cell 9 2 value 0.0 
create table 2 
modify table 2 dependency time 
modify table 2 insert row 1 
modify table 2 cell 1 1 value 0 
modify table 2 cell 1 2 value 0.0 
modify table 2 insert row 2 
modify table 2 cell 2 1 value 1 
modify table 2 cell 2 2 value 0.0 
modify table 2 insert row 3 
modify table 2 cell 3 1 value 2 
modify table 2 cell 3 2 value 0.0 
modify table 2 insert row 4 
modify table 2 cell 4 1 value 3 
modify table 2 cell 4 2 value 2.5e-5 
modify table 2 insert row 5 
modify table 2 cell 5 1 value 4 
modify table 2 cell 5 2 value 5e-5 
modify table 2 insert row 6 
modify table 2 cell 6 1 value 5 
modify table 2 cell 6 2 value 5e-5 
modify table 2 insert row 7 
modify table 2 cell 7 1 value 6 
modify table 2 cell 7 2 value 5e-5 
modify table 2 insert row 8 
modify table 2 cell 8 1 value 7 
modify table 2 cell 8 2 value 2.5e-5 
modify table 2 insert row 9 
modify table 2 cell 9 1 value 8 
modify table 2 cell 9 2 value 0.0 
create displacement on curve 4 dof 1 fix 0 
create displacement on curve 1 dof 2 fix 0 
bcdep displacement 3 table 1 
bcdep displacement 4 table 2 
analysis type static elasticity plasticity dim2 planestrain 
static steps 8 
calculation start path 'D:\CAE-Fidesys-2.0\example.pvd' 

Sequential addition of volumes in the calculation process 

An example of a multi-step calculation in CAE Fidesys with the addition of volume in the calculation process is 
considered. The problem is solved in two steps of loading. At the first step, the model is a brick, one end of which 
is fixed along the X axis, pressure is applied along the Y axis to the other side (thus, compression occurs). At the 
second calculation step fixed boundary condition along the X axis for the model id deleted, instead of it a new 
brick is added to the same face. At the junction, the volumes merged, the opposite side of the new added volume 
is fixed along the X axis. At the same time, the volumes continue to compress. 
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Geometry creating 

1. Create the first brick. 

On the command panel, select the mode for creating volume 
geometry (Mode - Geometry, Entity - Volume, Action - 
Create). From the list of geometric primitives, select Brick. 
Set block sizes:  

 X (width): 2; 
 Y (height): 1; 
 Z (depth): 0.3. 

Click Apply. 

  

2. Create a second brick. 

On the command panel, select the mode for creating volume 
geometry (Mode - Geometry, Entity - Volume, Action - 
Create). From the list of geometric primitives, select Brick. 
Set block sizes: 

 X (width): 1; 
 Y (height): 1; 
 Z (depth): 0.3. 

Click Apply. 
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3. Move the first brick to the origin of CS. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Volume, 
Action - Transform). From the list of possible transformations, select Move. Set the parameters: 

 Volume ID(s): 1; 
 Including Merged: uncheck; 
 Select Method: Distance; 
 X Distance: 1; 
 Y Distance: 0.5; 
 Z Distance: 0.15. 

Click Apply.  

4. Move the second brick to the origin of CS. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Volume, 
Action - Transform). From the list of possible transformations, select Move. Set the parameters: 

 Volume ID(s): 1; 
 Including Merged: uncheck; 
 Select Method: Distance; 
 X Distance: 2.5; 
 Y Distance: 0.5; 
 Z Distance: 0.15. 

Click Apply. 

 

5. Merge two volumes. 

On the command panel, select the mode for creating volume 
geometry (Mode - Geometry, Entity - Volume, Action – 
Imprint and Merge). From the list of possible transformations, 
select Merge. In the Volume ID(s) field, enter: all. 

Click Apply. 
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Meshing  

1. On the command panel, select the volume meshing mode (Mode - 
Mesh, Entity - Volume, Action - Intervals). Specify the degree of 
refining mesh: 

 Select Volumes: all; 
 Approximate Size: 0.1. 

Click Apply Size. 

Click Mesh. 

Specifying the material and type of element 

1. On the command panel, select the mode for setting material properties (Mode - Material, Entity - Materials 
Management). Specify the name of the material Material 1. Drag the Hooke Material inscription from the 
left column into the Material Properties column. Set the following parameters: 

 Young's modulus: 2.1e4; 
 Poisson's ratio: 0.3. 

In the left window, go to Plasticity - Mises Criterion and drag the Yield Strength feature into the Material 
Properties window. Set: 

 Yield Strength: 24. 

 

Click Apply. 

2. Create a block. 
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On the command panel, select the mode for setting material 
properties (Mode - Blocks, Entity - Block, Action - Add). Set 
the following parameters: 

 

 Block ID: 1; 
 Entity List: Volume; 
 Entity ID(s): 1 2 (or the all command). 

Click Apply. 

 

3. Assign the material to the block. 

On the command panel, select the mode for setting material 
properties (Mode - Blocks, Entity - Block, Action - Set 
Material). Set the following parameters: 

 Block ID (s): 1; 
 Select from the list the previously created material: 

Material 1. 

Click Apply. 

4. Assign element type and order. 

On the command panel, select the mode for setting material 
properties (Mode - Blocks, Entity - Block, Action - Element 
type). Set the following parameters: 

 Block ID(s): 1; 
 Category: Solid; 
 Order: 2. 

Click Apply. 
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Setting boundary conditions 

1. Fix the model along the Y axis. 

On the command panel, select Mode - Boundary Conditions, 
Entity - Displacement, Action - Create. Set the following 
parameters: 

 System Assigned ID; 
 Entity List: Surface; 
 Entity ID(s): 3 5 9 11; 
 Degrees of Freedom: Y-Translation Disp; 
 DOF Value: 0. 

Click Apply. 

 

2. Fix the model along the X axis. 

On the command panel, select Mode - Boundary Conditions, Entity - Displacement, Action - Create. Set the 
following parameters: 

 System Assigned ID; 
 Entity List: Surface; 
 Entity ID(s): 6; 
 Degrees of Freedom: X-Translation Disp; 
 DOF Value: 0. 

Click Apply. 

3. Fix the model along the X axis. 

On the command panel, select Mode - Boundary Conditions, Entity - Displacement, Action - Create. Set the 
following parameters: 

 System Assigned ID; 
 Entity List: Surface; 
 Entity ID(s): 12; 
 Degrees of Freedom: X-Translation Disp; 
 DOF Value: 0. 

Click Apply. 

4. Fix the model along the Z axis. 

On the command panel, select Mode - Boundary Conditions, Entity - Displacement, Action - Create. Set the 
following parameters: 

 System Assigned ID; 
 Entity List: Surface; 
 Entity ID(s): 1 2 7 8; 
 Degrees of Freedom: Z-Translation Disp; 
 DOF Value: 0. 
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Click Apply. 

5. Apply pressure 100 MPa to the left side. 

On the command panel, select Mode - Boundary conditions, Entity - 
Pressure, Action - Create. Set the following parameters: 

 System Assigned ID; 
 Pressure Entity List: Surface; 
 Entity ID(s): 4; 
 Magnitude Value: 100. 

Click Apply. 

 
 
 

 

Run calculation 

1. Set the type of problem you want to solve. 

On the command panel, select the calculation settings mode 
(Mode - Calculation Settings, Calculation Settings - Static, Static - 
General). 

 Dimension: 3D; 
 Model: Elasticity, Plasticity; 
 Load steps count: 2. 

Click Apply. 

 

2. Go to the Settings window load steps. 

 

 

Set step calculation – 1 for displacement 2. Boundary condition will be active in this step. 
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Click Apply. 

3. In the setting load steps window, select block 2 and set at which calculation step this block will be active. 

 

Click Apply. 

Click Start calculation. 

4. In the window that appears, select the directory in which the result will be saved, and enter the file name. 

5. In the case of a successful calculation, the console displays the message: Calculation finished successfully at 
"date time". 
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Result Analysis 

1. Open the file with the results. This can be done in three ways. 

 Press Ctrl + E. 
 From the main menu, select Calculation → Results. Click Open Last Result. 

For postprocessor analysis, go to the Fidesys Viewer window. 

 

2. Connect the filter Warp by Vector (Menu - Filters – Alphabetical - Warp by Vector). Or use the corresponding 
button on the command bar: 

 

For this filter, on the Properties tab, set: 

 Vector: Displacement; 
 Scale factor: 100; 
 Click Apply. 

 

3. On the top bar, select the required result data to display. From the first drop-down list, select Displacement, 
from the second - Magnitude, from the third - Surface with edges. 

 

4. In the step view panel, set step 1. You should see the image in the initial state. Next, click on Play . You 
should see the sequential compression of the model in accordance with the loading history. 
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Using the console interface 

Geometry creating, meshing, setting boundary conditions and materials can be performed using the console 
interface. Below is the program code that allows you to perform the steps of the above manual. You need only to 
specify the full path and name of the saved file. 

reset 
#{width1 = 2} 
#{width2 = 1} 
#{heightY = 1} 
#{heigthZ = 0.3} 
create brick x {width1} y {heightY} z {heigthZ} 
create brick x {width2} y {heightY} z {heigthZ} 
move volume 1 x {width1/2} y {heightY/2} z {heigthZ/2} 
move volume 2 x {width1 + width2/2} y {heightY/2} z {heigthZ/2} 
merge all 
create material 1 
modify material 1 set property 'POISSON' value 0.3 
modify material 1 set property 'MODULUS' value 2.1e+04 
modify material 1 set property 'MISES_YIELD_STRENGTH' value 24 
block 1 volume 1 
block 2 volume 2 
block all material 1#присвойте материал блоку 
block all element solid order 2 
surface all size {heightY/10} 
mesh volume all 
create displacement 1 on surface 3 5 9 11 dof 2 fix 
create displacement 2 on surface 6 dof 1 fix 
create displacement 3 on surface 12 dof 1 fix 
create displacement 4 on surface 1 2 7 8 dof 3 fix 
create pressure on surface 4 magnitude 100 
analysis type static elasticity plasticity dim3 
static steps 2 
bcdep displacement 2 step 1 
block 2 step 2 
calculation start path "d:\Fidesys\result.pvd" 

Sequential deletion of volumes in the calculation 
process 
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The model is a cylindrical tube consisting of three layers. Material parameters for all three layers: E = 2.1e4 N / 

mm2,  = 0.3, yield strength c = 24 N / m2. A uniform pressure of 14 N / mm2 is applied to the inner surface of the 
pipe. Fixation according with the symmetry condition. Three loading steps are specified: in the second step, the 
outer layer of the pipe is removed, in the third step, the next outer layer of the pipe is removed. In the process of 
solution, stresses are analyzed with the plastic flow and pipe thinning. 

 

 Geometry creating 

1. Create a circular surface with a radius of 100. 

On the command panel, select the mode for creating volume 
geometry (Mode - Geometry, Entity - Surface, Action - 
Create). From the list of geometric primitives, select Circle. Set 
the dimensions: 

 Radius: 100; 
 Location: Z-plane. 

Click Apply. 

2. Create a circular surface with a radius of 170. 

Set the dimensions: 

 Radius: 170; 
 Location: Z-plane. 

Click Apply. 
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3. Create a circular surface with a radius of 190. 

Set the dimensions: 

 Radius: 190; 
 Location: Z-plane. 

Click Apply. 

4. Create a circular surface with a radius of 200. 

Set the dimensions: 

 • Radius: 190; 
 • Location: Z-plane. 

Click Apply. 

5. Subtract surface 1 from the remaining surfaces 
2 3 4. 

On the command panel, select the mode for 
creating volume geometry (Mode - Geometry, 
Entity - Surface, Action - Boolean). From the list of 
operations, select Subtract. Set the following 
parameters: 

 Surface ID (s): 2 3 4 (surfaces from which 
other surface will be subtracted); 

 Surface ID (s): 1 (surfaces to be subtracted). 

Click Apply. 

 

6. Subtract surface 5 from surface 6. 

On the command panel, select the mode for creating volume geometry (Mode - Geometry, Entity - Surface, 
Action - Boolean). From the list of operations, select Subtract. Set the following parameters: 

 Surface ID (s): 6 (surfaces from which other surface will be subtracted); 
 Surface ID (s): 5 (amounts to be deducted); 
 Check the Keep Originals box and select Keep both (A and B). 

Click Apply. 
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7. Subtract surface 6 from surface 7. 

On the command panel, select the mode for creating volumetric geometry (Mode - Geometry, Entity - Surface, 
Action - Boolean). From the list of operations, select Subtract. Set the following parameters: 

 Surface ID (s): 6 (surfaces from which other surface will be subtracted); 
 Surface ID (s): 7 (surfaces to be subtracted). 

Click Apply. 

8. Cut the body. 

On the command panel, select the mode for 
creating volumetric geometry (Mode - Geometry, 
Entity - Surface, Action - Webcut). From the list of 
possible types of cuts, select Coordinate Plane. Set 
the following parameters: 

 Body ID(s): all (the surfaces to be cut); 
 Cut: Plane YZ; 
 Offcet value: 0. 

Click Apply. 

Do the same, but in the ZX plane: 

On the command panel, select the mode for creating volumetric geometry (Mode - Geometry, Entity - Surface, 
Action - Webcut). From the list of possible types of cuts, select Coordinate Plane. Set the following parameters: 

 Body ID(s): all (the surfaces to be cut); 
 Cut: Plane ZX; 
 Offcet value: 0. 

Click Apply.  

9. Delete the surface. 

On the command panel, select the mode for 
constructing volumetric geometry (Mode - 
Geometry, Entity - Surface, Action - Delete). In the 
Volume ID field, enter the numbers - 16 20 24 17 21 25 
19 23 27. 

 



 CAE Fidesys — User Guide (version 3.0) 

277 

 

 

10. Draw a surface to create volume: 

On the command panel (Mode - Geometry, Entity - 
Volume, Action - Create). From the list of geometric 
primitives, select Sweep. Set the following parameters: 

 Surface ID (s): all; 
 Perpendicular; 
 Distance: 10. 

Click Apply. 

 

 

 

 

 

Meshing 

1. On the command panel, select the mesh 
generation mode on curves (Mode - Mesh, Entity 
- Curve, Action - Mesh). Specify the degree of 
refining mesh: 

 Curve selection: 71 76 79 87 (through spaces); 
 Select the mesh generation method: Equal; 
 Select the partitioning options: Interval; 
 Interval: 50 (see picture). 

Click Apply. 
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2. On the command panel, select the mesh 
generation module on curves (Mode - Mesh, 
Entity - Curve, Action - Mesh). Specify the degree 
of refining mesh: 

 Select Curves: 74 82 90 78 86 94 (through 
spaces); 

 Select the meshing method: Equal; 
 Select the partitioning options: Approximate 

size; 
 Approximate size: 2. 

Click Apply. 

 

3. On the command panel, select the mesh generation module on curves (Mode - Mesh, Entity - Curve, Action - 
Mesh). Specify the degree of refining mesh: 

 Select Curves: 75 72 80 88 77 73 81 89 (through spaces); 
 Select the meshing method: Evenly; 
 Select the partitioning options: Interval; 
 Interval: 1 (see picture). 

Click Apply. 

 

4. On the command panel, select the mesh 
generation module on the planes (Mode - Mesh, 
Entity - Volume, Action - Intervals). Specify the 
mesh spacing: 

 Select Volumes: all; 
 Select the meshing mode: Automatic Sizing. 

Click Apply Size. 

Click Mesh. 
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Set the Material 

1. On the command panel, select the module for setting material properties (Mode - Material, Entity - 
Materials Management). Specify the name of the material material 1. 

  

2. Drag the Hooke Material inscription from the left column, as well as, under the Mises inscription, in the 
Plasticity section, in the Material Properties column. Set the following parameters: 

 Young's modulus: 2.1e + 04; 
 Poisson's ratio: 0.3. 

In the left window, go to Plasticity - According to Mises and drag the Yield Strength feature into the Material 
Properties window. Set: 

 Yield strength: 24. 

 

Click Apply. 
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Setting boundary conditions  

1. On the command panel, select Mode - Boundary Conditions, Entity 
- Displacemet, Action - Create. Set the following parameters: 

  System Assigned ID; 
 Entity List: Surface; 
 Entity ID(s): 29 34 39; 
 Degrees of Freedom: Y-Translation Disp; 
 DOF Value: 0. 

Click Apply. 

 

2. On the command panel, select Mode - Boundary Conditions, Entity 
- Displacemet, Action - Create. Set the following parameters: 

 System Assigned ID; 
 Entity List: Surface; 
 Entity ID(s): 31 26 41; 
 Degrees of Freedom: X-Translation Disp; 
 DOF Value: 0. 

Click Apply. 

 

3. On the command panel, select Mode - Boundary Conditions, Entity - Displacemet, Action - Create. Set the 
following parameters: 

 System Assigned ID; 
 Entity List: Surface; 
 Entity ID(s): 32 37 42 18 22 26; 
 Degrees of Freedom: Z-Translation Disp; 
 DOF Value: 0. 

Click Apply. 
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4. Apply uniform pressure to the surface. 

On the command panel, select Mode - Boundary 
Conditions, Entity - Pressure, Action - Create. Set the 
following parameters: 

 System Assigned ID; 
 Pressure Entity List: Surface; 
 Entity ID(s): 30; 
 Magnitude Value: 14. 

Click Apply. 

 

 

 

Set the material and element type  

1. Create block of one type of material. 

On the command panel, select the module for 
setting material properties (Mode - Blocks, Entity - 
Block, Action – Add). Set the following 
parameters: 

 Block ID: 1; 
 Entity List: Volume; 
 Entity ID(s): 6. 

Click Apply. 

 

2. Create a second block. 

On the command panel, select the module for setting material properties (Mode - Blocks, Entity - Block, Action 
– Add). Set the following parameters: 

 Block ID: 2; 
 Entity List: Surface; 
 Entity ID (s): 7. 

Click Apply. 
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3. Create the third block. 

On the command panel, select the module for setting material properties (Mode - Blocks, Entity - Block, Action 
– Add). Set the following parameters: 

 Block ID: 3; 
 Entity List: Surface; 
 Entity ID (s): 8. 

Click Apply. 

4. Assign the material to the blocks. 

On the command panel, select the module for setting 
material properties (Mode - Blocks, Entity - Block, 
Action - Set Material). Set the following parameters: 

 Block ID (s): all; 
 Select from the list the previously created 

material: Material 1. 

Click Apply. 

 

5. Assign an element type. 

On the command panel, select the module for setting 
material properties (Mode - Blocks, Entity - Block, 
Action - Element type). Set the following parameters: 

 Block ID(s): all; 
 Category: Solid; 
 Order: 2. 

Click Apply. 
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Run calculation 

1. Set the type of problem you want to solve. 

On the command panel, select the calculation settings 
module (Mode - Calculation Settings, Calculation 
Settings - Static, Static - General). 

 Dimensions: 2D; 
 Plane state: Plane strain; 
 Model: Elasticity, Plasticity; 
 Load steps count: 3. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on the three dot icon  in order to configure the 
active calculation steps for block 2 - 1 2 (separated by 
spaces), and for block 3 - 1. 
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Click on the Apply, Start Calculation command bar. 

2. In the window that appears, select the directory in which the result will be saved, and enter the file name. 

3. In the case of a successful calculation, the console displays the message: Calculation finished successfully at 
"date time". 

Result Analysis 

1. Open the file with the results. This can be done in three ways. 

 Press Ctrl + E. 
 From the main menu, select Calculation → Results. Click Open Last Result. 

For postprocessor analysis, go to the Fidesys Viewer window. 

2. In the top pane, select the reqired result data to display. From the first drop-down list, select Stress, from the 
second - Mises, from the third - Surface. 

 

3. In the step view panel, set step 1. You should see the image in the initial state. Next, click on Play . 

You should see the sequential removal of layers on the model according to the loading history. 
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Using the console interface 

Geometry generation, meshing, setting boundary conditions and materials can be performed using the console 
interface. Below is the program code that allows you to perform the steps of the above manual, you only need to 
specify the full path and name of the saved file. 

#delete layers 
#сравнение с Abaqus 
#{rInner = 100} 
#{rOuter1 = 170} 
#{rOuter2 = 190} 
#{rOuter3 = 200} 
reset 
create surface circle radius {rInner} zplane 
create surface circle radius {rOuter1} zplane 
create surface circle radius {rOuter2} zplane 
create surface circle radius {rOuter3} zplane 
subtract surface 1 from surface 2 3 4 
subtract surface 5 from surface 6 keep 
subtract surface 6 from surface 7 
webcut surface all with plane yplane offset 0  
webcut surface all with plane xplane offset 0 
delete surface 16 20 24 17 21 25 19 23 27 
sweep surface all perpendicular distance 10 merge 
create material 1 
modify material 1 set property 'POISSON' value 0.3 
modify material 1 set property 'MODULUS' value 2.1e+04 
modify material 1 set property 'MISES_YIELD_STRENGTH' value 24 
create displacement on surface 29 34 39 dof 2 fix 
create displacement on surface 31 36 41 dof 1 fix 
create displacement on surface 32 37 42 18 22 26 dof 3 fix 
create pressure on surface 30 magnitude 14 #10, 12, 14 
block 1 volume 6 #inner - all steps 
block 2 volume 7 #medium - steps 1,2 
block 3 volume 8 #outer - step 1 
block all material 1 
block all element solid order 2 
curve 71 76 79 87 interval 50 
curve 74 82 90 78 86 94 size 2 
curve 75 72 80 88 77 73 81 89 interval 1 
mesh volume all 
analysis type static elasticity plasticity dim3 
nonlinearopts maxiters 100 minloadsteps 10 maxloadsteps 30 tolerance 1e-5 
static steps 3 
block 2 step 1, 2 
block 3 step 1 
#output iterresults on 
calculation start path "d:\Fidesys\result.pvd" 
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Seismic wave propagation (SEG-Y results) 

CAE Fidesys allows you to upload solution results in SEG-Y format. This example considers the propagation of 
seismic waves in the ground based on the Boussinesq problem for a 2D case. The procedures for setting 
receivers, saving and subsequent analysis of data in the SEG-Y format are demonstrated. 

The model is a part of the plane (xy), a point force is applied to vertex. Non-reflective boundary conditions are 
applied. 

Geometry creating 

1. Create a square plate. 

On the command panel, select the mode for creating 
volume geometry (Mode - Geometry, Entity - 
Surface, Action - Create). From the list of geometric 
primitives, select Rectangle. Set block sizes: 

• Width: 10000; 

• Location: ZPlane. 

Click Apply. 

 

2. Due to symmetry, we consider half of the model. 

On the command panel, select the mode for creating 
volume geometry (Mode - Geometry, Entity - Surface, 
Action - Webcut). From the list of possible kind of 
webcuts, select Coordinate Plane. Set the following 
parameters: 

 Body ID(s): 1 (the body to be cut); 
 Cut: YZ; 
 Offset Value: 0. 

Click Apply. 

 

Do the same, but in the ZX plane. 

 Body ID(s): 1 (the body to be cut); 
 Cut: ZX; 
 Offset value: 0. 

Click Apply. 
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As a result, the original Body 1 in the Model Tree will be divided into three bodies (Body 1, Body 2 and Body 3). 

 

3. Delete Surface 3. 

On the command panel, select the mode for creating 
volume geometry (Mode - Geometry, Entity - 
Surface, Action - Delete). Set the parameters: 

• Surface ID (s): 3. 

Click Apply. 
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4. Print and splice the surface. 

On the command panel, select the module for 
constructing volumetric geometry (Mode - 
Geometry, Entity - Surface, Action - Imprint / 
Merge). Set the following parameters: 

• Surface ID(s): all.  

Click Apply. 
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5. Break curve 11 into two parts. 

On the command panel, select the module for constructing 
volumetric geometry (Mode - Geometry, Entity - Curve, Action 
- Modify). Set the following parameters: 

•Split; 
• Curve ID: 11; 
• Split Method/Location: Distance; 
• Value: 1000; 
• Starting From: 10. 

Click Apply. 

 

6. Write the following commands on the command line: 

 
• imprint all; 
• merge all. 
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Meshing 

1. On the command panel, select the curve 
meshing mode (Mode - Mesh, Entity - Surface, 
Action - Intervals). Specify the degree of refining 
mesh: 

• Approximate Size; 

• Select Surfaces: all; 

• Approximate size: 250. 

Click Apply Size. 

Click Mesh. 

 

Specifying the material and type of item 

1. On the command panel, select the mode for setting material properties (Mode - Material, Entity - Materials 
Management). From the Imported Material list, drag the Soil to the Material ID window. 

 

Click Apply. 

2. Create a block of the one type of material. 
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On the command panel, select the mode for setting material properties (Mode - Blocks, Entity - Block, Action - 
Add). Set the following parameters: 

• Block ID: all; 
• Entity List: Surface; 
• Entity ID(s): all. 

Click Apply. 

3. Assign the material to the block. 

On the command panel, select the module for setting 
material properties (Mode - Blocks, Entity - Block, 
Action - Set Material). Set the following parameters: 

• Block ID(s): 1;  
• Select the previously created material from the 

list: Soil. 

Click Apply. 

 

4. Assign an item type. 

On the command panel, select the module for setting 
material properties (Mode - Blocks, Entity - Block, 
Action - Element types). Set the follow  ing 
parameters: 

• Block ID (s): 1; 
• Category: Plane; 
• Order: 4. 

Click Apply. 
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Setting boundary conditions 

1. Fix curves 16 and 12 in the X direction. 

On the command panel, select Mode - Boundary Conditions, Entity - 
Displacement, Action - Create. Set the following parameters: 

• System Assigned ID; 
• Entity List: Curve; 
• Entity ID(s): 16 12 (separated by spaces); 
• Degrees of Freedom: X-Translation Disp; 
• DOF Value: 0. 

Click Apply. 

 

 

2. Set non-reflective boundary conditions. 

On the command panel, select Mode - Boundary conditions, Entity – 
Absorbing BC, Action - Create. Set the following parameters: 

• System Assigned ID; 

• Entity List: Curve; 

• Entity ID(s): 7 15 13 6 (separated by spaces). 

Click Apply.  

 

 

3. Set the force. 

On the command panel, select Mode - Boundary Conditions, Entity - Force, 
Action - Create. Set the following parameters: 

• System Assigned ID; 
• Force Entity List: Vertex; 
• Entity ID(s): 10; 
• Direction: 0 -1 0 (space separated). 

Click Apply. 
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Set the BC dependency on time and / or coordinates 

1. Create a formula 1 for strength 1. 

On the command panel, select Mode – BC Dependency. 

Click Forse 1 and choose Formula panel in the right. Then choose Berlage and set the following parameters: 

• Select the flag Formula: Berlage; 
• Amplitude: 2e8; 
• Frequency: 10. 

  

Click Apply. 
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Receivers 

1. Create receivers on curve 17 along all directions. 

On the command panel, select Mode - Receivers, Operation - 
Create. From the drop-down list, select the fields whose data 
you want to save in SEG-Y format. Set the following 
parameters: 

• System assigned ID; 

• Entity List: Curve; 

• Entity ID(s): 17; 

• Velocity; 

• Variables: All. 

Click Apply. 

 

 

 
The receiver lines are highlighted on the model in yellow 
when clicked in the corresponding section of the Model Tree. 

 

Run calculation  
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1. Set the type of task you want to solve. On the command panel, select the calculation settings mode (Mode - 
Calculation Settings, Calculation Settings - Transient analysis, Transient - General). 

Set the following calculation parameters: 

• Dimension: 2D; 

• Method: Complete solution; 

• Scheme: Explicit; 

• Max time: 10; 

• Max steps count: 10000; 

• Preloaded model: uncheck;  

Click Apply. 

 

 

 

 

Go to the settings section for Output Fields. Specify: 

• Save Results: Every 100 Steps  

 Click Apply. Click Start Calculation. 

 

 

 

 

In the window that appears, select the directory in which the 
result will be saved, and enter the file name. 

In case of a successful calculation, a message will be displayed in the console: “Calculation finished successfully 
at" date "" time "”. 
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Results analysis 

1. Open the file with the results. This can be done in three ways. 

• Press Ctrl + E. 

• From the main menu, select Calculation → Results. Click Open Last Result. 

2. To analyze the results, go to the Fidesys Viewer window. 

3. On the top bar, select the required result data to display. From the first drop-down list, select Stress, from 
the second - Mises. 

 

4. Set the step 1 in the step viewer panel. You should see the plate image in the initial state. Next, click on 

Play . You should see the propagation of stress over time. 

 

5. Open the saved data in SEG-Y format. 

To do this, go to Menu - File - Open. In the drop-down list of file types, select SEG-Y Files (* .sgy, * .segy). 
Specify the file to view test_Vy.sgs 
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Set the viewing direction along the Y axis 

 

The calculation results for speeds Vy in the SEG-Y format are visualized in the field of visualization. 
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Using the console interface 

Geometry creating, meshing, setting boundary conditions and materials can be performed using the console 
interface. Below is the program code that allows you to perform the steps of the above manual, you only need to 
specify the full path and name of the saved file. 

reset 
create surface rectangle width 10000 zplane  
webcut body 1  with plane xplane offset 0  
webcut body 1  with plane yplane offset 0  
delete Surface 3   
imprint all 
merge all 
split curve 11  distance 1000 from vertex 10 
imprint all 
merge all 
surface all  size 250 
mesh surface all 
create material 1 from 'Soil' 
block all add surface all 
block 1 add surface all 
block 1  material 1 
block 1  element plane order 4 
create displacement  on curve 16 12  dof 1 fix   
create absorption on curve 7 15 13 6  
create force  on vertex 10  force value 1 direction 0 -1 0 
bcdep force 1 value 'berlage(2e+8, 10, time)' 
create receiver on curve 17  displacement 1 1 1 
create receiver on curve 17  velocity 1 1 1 
create receiver on curve 17  principalstress 1 1 1 
create receiver on curve 17  pressure 
output nodalforce off energy off record3d on log on vtu on material off results everystep 
100 
analysis type dynamic elasticity dim2 planestrain preload off 
dynamic method full_solution scheme explicit maxtime 10 maxsteps 10000 
calculation start path 'D:\Fidesys\test.pvd' 
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Спектральный анализ балки при помощи спектра реакции 

In this problem, the support (point A) of a massless beam is affected by an 

accelerogram presented as a response spectrum of absolute acceleration. 

The beam is rigidly fixed at point A. Along the entire beam, linear movement along 

the Z axis is prohibited. Length AB = BC = 2. At points B, C, an inertial element with 

one node of mass 100. 

Beam material parameters: Young's modulus E = 2e11; Poisson's ratio ν = 0.3; 

Density ρ = 1e-07. Relative damping coefficient of 2% on each mode. 

The response spectrum of absolute acceleration is shown in the table below. 

Собственная частота Значение спектра ускорения 

3.28 2.98 

21.82 1.38 

This table is created as a CSV file and then imported into the Fidesys Viewer (the 

image shows a sample table in Excel).  

 
 

Построение модели 

1.Создайте конструкцию из двух балок (AB и BC) 

На панели инструментов выберите модуль построения 

линий (Режим — Геометрия, Объект — Кривая, Действие —

 Создать). 

 

Из выпадающего списка выберите Линия 

На панели Построить, используя выберете Положение и 

направление. 

Далее, укажите необходимые данные для создания первой 

линии: 

 Расположение: 0 0 0 (через пробел); 

 Направление: 0 1 0; 

 Длина: 2. 

Нажмите Применить 

Укажите необходимые данные для создания второй линии: 

 Расположение: 0 2 0 (через пробел); 

 Направление: 0 1 0; 
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 Длина: 2. 

Нажмите Применить 

 
 

2.Срастите вершины на полученных балках. На панели 

инструментов выберите модуль построения вершин (Режим 

— Геометрия, Объект — Вершина, Действие — Срастить). 

 

Укажите 

 ID вершин(ы): all. 

Нажмите Применить 

Получилась балочная конструкция 

 

Построение сетки 

1.На панели команд выберите модуль построения сетки на 

кривых (Режим — Сетка, Объект — На Кривых, Действие —

 Построение сетки). 

 

Укажите следующие параметры 

 Выбор кривых: all; 

 Из выпадающего списка 

выберите равномерно; 

 Выберите радиокнопку Интервал; 

 В графе Интервал поставьте 1. 

Нажмите Применить 
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Нажмите Построить сетку 
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Задание материала и типа элемента 

1.Создайте материал. 

На панели команд выберите модуль задания свойств 

материала (Режим — Материал, Объект — Управление 

материалами). 

В открывшемся виджете Управление материалами в 

средней колонке укажите имя материала material1. 

В колонке свойств откройте список Упругость и перетащите 

название Материал Гука в колонку Свойства материала. 

В колонке свойств откройте список Общие и перетащите название Плотность в колонку Свойства 

материала. 

Заполните свойства следующим образом: 

 Модуль Юнга: 2e11; 

 Коэффициент Пуассона: 0.33; 

 Плотность: 1e-07. 

 

Нажмите Применить 

Закройте окно 
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2.Создайте блок для каждого вида конечного элемента. 

На панели команд выберите Режим — Блоки, Объект — Блок, 

Действие — Добавить сущность в блок. 

 

Задайте следующие параметры: 

 ID блока: 1; 

 В выпадающем списке список сущностей 

выберите Кривая; 

 ID объекта(ов): all. 

Нажмите Применить 

Для создания блоков вершин: 

 ID блока: 2; 

 В выпадающем списке список сущностей выберите Вершина; 

 ID объекта(ов): 2. 

Нажмите Применить 

Для создания второго блока вершин проделайте аналогичные действия, 

только в ID блока поставьте 3, в ID объекта(ов) поставьте 4. 

3.Присвойте материал блоку балки 

На панели команд выберите Режим — Блоки, Объект — Блок, Действие —

 Задать материал). 

Задайте следующие параметры: 

 ID блока(ов): 1; 

 Выберите из списка ранее созданный материал: Material 1. 

Нажмите Применить 

4.Присвойте тип элемента 

На панели команд выберите Режим — Блоки, Объект — Блок, Действие — Тип элемента). 

Задайте следущие параметры: 

 ID блока(ов): 1; 

 Категория: Балка; 

 Порядок: 2. 

Нажмите Применить 

Для блоков вершин: 

 ID блока(ов): 2 3; 

 Категория: Точечная масса. 

Нажмите Применить 
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Задание сечения балок 

1.Задайте сечение балки 

На панели команд выберите Режим — Блоки, Объект —

 Параметры балок. 

Задайте следующие параметры: 

 ID блока: 1; 

 Угол поворота системы координат: 0; 

 Рассчитать относительно: Центр масс; 

 Профиль сечения: Установить параметры вручную; 

 Эксцентриситет по Y: 0; 

 Эксцентриситет по Z: 0; 

 Момент инерции Iy: 0.5e-5; 

 Момент инерции Iz: 0.5e-5; 

 Момент инерции Ix: 0; 

 Момент инерции Iyz: 0; 

 Момент инерции на кручение: 0; 

 Площадь: 0.00785; 

 Максимальная координата по Y: 0; 

 Максимальная координата по Z: 0; 

 Коэффициент сдвига YY: 1; 

 Коэффициент сдвига ZZ: 1; 

 Коэффициент сдвига ZY: 0; 

 Координата центра изгиба Y: 0; 

 Координата центра изгиба Z: 0; 

 Секториальный момент инерции Iω: 0. 

Нажмите Применить 

Задание массы инерционного элемента 

1.На панели команд выберите Режим — Блоки, Объект —

 Задание свойств точечной массы). 

 

Задаем следующие параметры: 

 ID блока(ов): 2; 

 Масса: 100; 

 Момент инерции: 0. 

Нажмите Применить 

Для другого блока точечной массы делаем тоже самое, только ставим в ID блока(ов): 3. 
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Задание граничных условий 

1.Закрепите вершину A по всем линейным перемещениям и 

поворотам. 

На панели команд выберите Режим — Граничные условия, 

Объект — Перемещение, Действие — Создать. 

 

Задаем следующие параметры: 

 Автоматическое присвоение ID; 

 Список объектов: Вершина; 

 ID объектов: 1; 

 Степени свободы: Все. 

Нажмите Применить 

 

2.Закрепите всю балку по линейному перемещению вдоль 

оси Z. 

Задаем следующие параметры: 

 Автоматическое присвоение ID; 

 Список объектов: Кривая; 

 ID объектов: all; 

 Степени свободы: По Z. 

Нажмите Применить 

 

Запуск расчета 

1.Задайте общие настройки для модального анализа. 

На панели команд выберите модуль настройки расчёта 

(Режим — Настройки расчёта, Настройки расчёта —

 Модальный анализ, Модальный анализ — Общие) 

 

Задайте следующие параметры: 

 Число собственных частот: 2; 

 Все остальные параметры принимаются по 

умолчанию. 

Нажмите Применить 

 
 

 

2.Задайте настройки полей вывода модального анализа 
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На панели команд выберите модуль настройки расчёта (Режим — Настройки расчёта, Настройки расчёта —

 Модальный анализ, Модальный анализ — Поля вывода) 

 

Задайте следующие параметры: 

 Ставим галочку напротив Вычислять Эффективные массы; 

 Ставим галочку напротив 3D запись. 

Нажмите Применить 

Нажмите Запуск расчета 

Получили результаты 

 

Анализ результатов 

1. Откройте файл с результатами. 

Это можно сделать тремя способами: 

 Нажмите Ctrl+E. 

 В главном меню выберите Расчёт → Результаты. Нажмите Открыть последний результат. 

 На панели команд выберите менеджер расчетов (Режим - Менеджер расчетов, Менеджер 

расчетов - Результаты). Нажмите Открыть последний результат. 
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Появится окно Fidesys Viewer, в котором вы сможете ознакомиться с результатами расчёта. 

В главном меню перейдите по вкладке Фильтры - Алфавитный указатель – Комбинация мод. 

В дереве проекта включите видимость Комбинация мод и во вкладке Свойства Установите следующие 

параметры: 

 Установите галочку напротив метода комбинации мод Абсолютная сумма; 

 Установите галочку напротив метода комбинации мод Корень квадратный из суммы мод; 

 Установите галочку напротив метода комбинации мод Полная квадратичная комбинация; 

 Режим коэффициента демпфирования: 0.02; 

 Тип зависимости: CSV-файл; 

 Укажите путь CSV-файла на своем компьютере; 

 Укажите спектральную кривую Поле, которую будете прикладывать: Ускорения; 

 Укажите направление спектральной кривой вдоль оси X в графе Направление: 1 0 0. 

 

Нажмите Применить 

Вывод результатов 

1.Выведите результаты перемещений вдоль оси X, полученные разными методами комбинации мод. 
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 В выпадающем списке результатов выберите 

результаты Перемещение_АбсСумма, Перемещение_ПКК, Перемещение_ККСК; 

 В выпадающем списке осей координат выберите X. 
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Использование консольного интерфейса 

Построение геометрии, генерацию сетки, задание граничных условий и материалов можно выполнить с 

использованием консольного интерфейса. Ниже приведён код программы, позволяющий выполнить шаги 

описанного выше руководства,необходимо только самостоятельно указать полный путь и название 

сохраняемого файла. 

reset 

create curve location 0 0 0 direction 0 1 0 length 2 

create curve location 0 2 0 direction 0 1 0 length 2 

merge vertex all 

curve all interval 1 

curve all scheme equal 

curve all interval 1 

curve all scheme equal 

mesh curve all 

create material 1 

modify material 1 name 'material 1' 

modify material 1 set property 'MODULUS' value 2e+11 

modify material 1 set property 'POISSON' value 0.33 

modify material 1 set property 'DENSITY' value 1e-07 

set duplicate block elements off 

block 1 add curve all 

block 1 material 1 

set duplicate block elements off 

block 2 add vertex 2 

set duplicate block elements off 

block 3 add vertex 4 

set duplicate block elements off 

block 1 element beam order 2 

block 2 3 element lumpmass 

create beam properties 1 

modify beam properties 1 type 'Custom' 

modify beam properties 1 ey 0.0 

modify beam properties 1 ez 0.0 

modify beam properties 1 angle 0.0 

modify beam properties 1 Iy 0.5e-05 

modify beam properties 1 Iz 0.5e-05 

modify beam properties 1 Ix 0 

modify beam properties 1 Iyz 0 
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modify beam properties 1 It 0 

modify beam properties 1 area 0.00785 

modify beam properties 1 max_y 0 

modify beam properties 1 max_z 0 

modify beam properties 1 shear_coefficient_yy 1 

modify beam properties 1 shear_coefficient_zz 1 

modify beam properties 1 shear_coefficient_zy 0 

modify beam properties 1 shear_center_y 0 

modify beam properties 1 shear_center_z 0 

modify beam properties 1 Iw 0 

modify beam properties 1 warping_dof on 

block 1 beam properties 1 

create lumpmass properties 2 

modify lumpmass properties 2 mass 100 

modify lumpmass properties 2 mass_inertia 0 

block 2 lumpmass properties 2 

create lumpmass properties 3 

modify lumpmass properties 3 mass 100 

modify lumpmass properties 3 mass_inertia 0 

block 3 lumpmass properties 3 

create displacement on vertex 1 dof all fix 0 

create displacement on curve all dof 3 fix 0 

analysis type eigenfrequencies dim3 preload off 

eigenvalue find 2 smallest 

output nodalforce off energy off record3d on log on vtu on material off 

effective_mass on rotation_center 0 0 0 

calculation start path "d:\Fidesys\result.pvd" 
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Contacts  

http://www.cae-fidesys.com 

support@cae-fidesys.com 

+7 (495) 177-36-18 

 

http://www.cae-fidesys.com/
mailto:support@cae-fidesys.com

